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Part 1 BackOffice Introduction

SoftTouch BackOffice is a powerful, easy-to-use tool that employs intuitive controls to customize
your environment. This is where you set up all of your preferences for your SoftTouch Hospitality
System.
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Part 2 Login to BackOffice

1. When you first log into the SoftTouch BackOffice on a new installation you will be required

to type in this username and password:

username: softtouchadmin
password: itsprivate2

2. On the new screen (as shown below) you must put in your old password (itsprivate2) and then

enter a new password. 

The new password must be at least eight characters in length and must contain both numeric and
alphabetic characters. 

*Note: Your username will continue to be softtouchadmin.

3. Make sure you remember what you type in for your new password. Upon signing into

BackOffice, if you mistype your password more than three times you will be locked out of 
BackOffice for half an hour.
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Part 3 BackOffice Manual Guidelines

MENU GUIDE

1. A path you need to follow in order to get to certain function settings is marked with the info

bubble  image at the top of the page.

2. Function names are grouped by sections on the left. See image:
 

 

3. Function settings are sometimes divided into two or more parts of the screen. There will
always be a header name for every part of the screen. 
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There are two headers on the main page in the Employees applet.  At top of the screen, the
header reads Employee list.  In this section you can expect to view a listing of all employees
that have been added to and saved into the system.  
At the bottom of the screen, the header reads Employee.  This is where you will enter
information about the Employee you have highlighted at the top section of the screen.  Notice
that above the header Employee, there are tabs labeled Employee, Security, Finger Print, Jobs &
Wages, etc.  These are screens where you can add information about an employee, although not
all fields are mandatory.  Each field of each screen will be explained in detail as we get to each
screen.

*Note: Always pay attention to the header names as we will refer to them often.
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Part 4 General Section

The General section.

The General section contains the following:

1. Company/Registration

2. System

3. Order Functions

4. Employees

5. Time Editor

6. Customers

7. Scheduling

8. Item Builder

9. Stock/Barcodes

10. Seating/Zones

11. Loyalty

12. Hostess

13. SoftTouch Messages
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Part 5 Company/Registration

Under the General section click on Company/Regist. applet.

Company/Registration

Enter your company information in the Company information part of the screen.

If you make a mistake you can undo it by pressing the  button.

Press the  button when you are done.
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Part 6 System

Under the General section click on System.

System

System Setup contains the following tabs:

1. General

2. Rounding

3. Tips

4. Gratuity

5. Future Orders

6. Hours & Wages

7. Intranet

8. Custom Programs

9. Function Buttons

10. Customer Search

11. Z

12. Z Results

13. Services
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6.1 General Tab

Under the General section click on System. Select the General tab.

General

- General Settings -

Operation Date This will display your current operation date.  All
transactions  will be recorded as sales on current
operation date.

Swipe card reader
begin

Pertains to Employee Swipe Cards which are used for
logging into the front end.  Enter the symbol that
appears before the actual card number.  (Example: if
the data on the card looks like this: %12345? then the
% is the begin symbol, 12345 is the card number, and
the ? is the end symbol.)

Swipe card reader
end

Pertains to Employee Swipe Cards which are used for
logging into the front end.  Enter the symbol that
appears after the actual card number.  (Example: if the
data on the card looks like this: %12345? then the % is
the begin symbol, 12345 is the card number, and the ?
is the end symbol.)
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Web Home Page The default address of a web page that is displayed in
the Internet Browser when you go to System >
Web/Internet in SoftTouch.

Layout Theme You can choose to have your Mode buttons on the left or
the right side of the screen.

Backoffice inactivity
timeout

This field will determine how long Backoffice will stay
open when there is no activity before you must enter
your User ID and Password.  You can set this for 1 to 15
minutes.  15 minutes is the maximum amount of time
Backoffice can be inactive before you will be logged out.

Check Generator Sequential: generates check numbers in order, so
checks would start say at 100 and the next check would
be 101

Random: generates check numbers at random, so first
check could be 201102 and the next check could be
526611

*NOTE: When using random check numbers, you will
get a six digit order # (check #).

Manager history
check count

This is where you can set the number of checks previously rung up
that will display and become accessible when a manager hits the
History button.

Employee history
check count

This is where you can set the number of checks previously rung up
that will display and become accessible when an employee hits the
History button.

Display ___
previous orders
on NEW Takeout
and Delivery
orders

Use the arrows to specify the number of previous orders you would
like shown on new takeout and delivery orders. Entering 0 disables
this feature.

Employee
acceptance for
check transfers

This will require the employee that a check is being transferred to
accept the transferred check before they become responsible for it. 
If a server transfers a check to another server, the second server
has to accept it or the first server will remain responsible for that
check.
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Allow negative
cash sales

This dictates whether the site will allow a negative cash sale.
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6.2 Rounding Tab

Under the General section click on System. Select the Rounding Tab.

Rounding

Enable
Rounding

Turns on the Rounding feature.

Round
Checks

Bar Only: will only use rounding for the bar mode.

Bar and Dining:will only use rounding for the dining and
bar modes.

All Modes: Will use rounding in all modes you have
enabled, including delivery, drive-thru, and counter
mode.

Round to
nearest

The number for rounding that you can set. This is
measured in increments of $.05 cents and you can round
up to $1.00.

Round
Calculation

Round to the nearest +/- : a check is adjusted in
increments depending on what the penny is closer to. 

Example: if the check was $5.46 and you had the rounding
set to five cents it would then adjust to $5.45. If the check
was $5.48 the check would adjust to $5.50.

Round UP only: the check will always be adjusted to an
additive increment. 

Example:  If the check was $5.41 it would be rounded to
$5.45 if you had the rounding set to $0.05.
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Disable
when food
items are
present

When you have a check open that only has liquor items
on it, the rounding will be enabled. If this option is
checked on, once a food item is placed on the check, the
rounding will be disabled.

- Bar Rounding Setup for VAT (Value Added Tax) - 

If you are using Value Added Tax for your Bar, you will need to setup Bar Rounding so that you
will not have to deal with pennies or change altogether.  Rounding is needed to work in
conjunction with VAT because there are certain situations where the tax has to be rounded and it
may cause a bill that you would like to be $12.00 even end up being $12.01.

If you have VAT only for liquor and the VAT only applies to the Bar, choose Bar Only in the
Round checks drop down box.  If you have VAT available for all types of checks, choose All
Checks.

For the Round to nearest option, what you put here depends on what type of change you may
or may not want to deal with.  If you  have some items with VAT that are priced at $3.50 (not an
even dollar amount) then you should put $0.50 in the Round to nearest box.  If all of your
items are supposed to be an even dollar amount (ex. $4.00 or $5.00), then you can put $1.00 in
the Round to nearest box.

*Note: You should not round by large amounts if you are NOT using VAT.



Version 6.1.16

21

6.3 Tips Tab

Under the General section click on System. Select the Tips Tab.

Tips

Reprint receipt on
tip entry

This option box will allow you to print a receipt after a
tip is entered.  Usually tips are added at the end of a
shift so a site may not want to waste the paper.  If
management feels it is best practice for them to verify
the amount of tip entered into the system verses what
the guest wrote on the check, this option will allow the
reprint of the check with tip entered into the system
printed on it.

Calculate employee
tip distribution

If you select "by check sales %" from the drop down list, in
the scenario where more than one employee rings sales on a
check, the portion of the tip each employee gets will be in direct
relation to the portion of total sales that employee rung onto the
check.  For example, if a bartender rings $20 in liquor and a
server rings $80 in food on the same check, where a $20 tip
was left, the bartender would get $4 (20% of the tip amount)
while the server would get $16 (80% of the tip amount).

If you select "by check owner" the person who started the
check (in the case where 2 bartenders are ringing on the same
check) or the person who the check was transferred to (in the
case where a server takes over a check for a bartender) will
receive 100% of the tip.
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Net minimum tip
sale percentage

The government requires that a tipped employee declare a
certain percentage of their sales as tips.  This is simply a
calculation that will print on the server report showing the
percent they should be declaring and whether or not the tips
declared by this employee are more or less than what they are
required to declare.

For example, if an employee rang $1,000.00 in sales and they
only had $90.00 in credit card tips, if 10% were filling in this
field, the report would reflect that they should declare a
minimum of $10.00 as their cash tips.

Keep in mind, the government requires all employees to
enter in 100% of all cash tips.  

Require a manager
override when
declaring tips over

This field allows you to enter the percentage of the sale,
where when an employee enters a tip on a check and
the tip is greater than the percentage set in this field, it
will require a manager override. 

For example, if an employee has a $100 check and
enters a tip of $50.00 or more, a manager will need to
approve the action.
This cuts down on employees mistakenly entering the
wrong amount (the tip was $20.00, not $50.00 and they
entered the wrong amount by accident).  The employee
can then correct the error before it is finalized and
requires manager intervention.

Convenience tip
guest count

If the number of guests meets or exceeds the number
you enter here convenience tip amounts will be shown
on the receipt. For this to show up or not show up on
the receipt, you must add or remove the corresponding
tags from the receipt template (see below and/or 
Administration->Template Screen).

Convenience tip
percentage 1

Enter the first suggested tip amount you want to display
on customer receipts. For this to show up or not show
up on the receipt, you must add or remove the
corresponding tags from the receipt template (see below
and/or Administration->Template Screen).

Convenience tip
percentage 2

Enter the second suggested tip amount you want to
display on customer receipts. For this to show up or not
show up on the receipt, you must add or remove the
corresponding tags from the receipt template (see below
and/or Administration->Template Screen).
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Convenience tip
percentage 3

Enter the third suggested tip amount you want to
display on customer receipts. For this to show up or not
show up on the receipt, you must add or remove the
corresponding tags from the receipt template (see below
and/or Administration->Template Screen).

- Convenience Tipping Receipt Template -

In order for convenience tip percents and amounts to display on the receipt, you must change the
receipt template. Refer to Administration->Template Screen at any time to for more details.

Step 1. Go to Administration->Template Screen (from the gray toolbar at the top of
BackOffice).

Step 2. Select the "Receipt" template from the list.

Step 3. Insert the following tagging where you want it to appear.

<c>
<ifconveniencetipguestcount+>
Convenience Tipping<cr>
<conveniencetippercent1>%=<conveniencetipamount1> 
<conveniencetippercent2>%=<conveniencetipamount2> 
<conveniencetippercent3>%=<conveniencetipamount3><cr>
<endif>
<cr>
</c>

Step 4. If you want convenience tipping to show on all receipts (and not just checks that meet
the Convenience tip guest count), remove <ifconveniencetipguestcount+> and <endif>.

Step 5. There are also tags that allow you to show the totals with the convenience tips added.
Refer to Administration->Template Screen.
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6.4 Gratuity Tab

Under the General section click on System. Select the Gratuity Tab.

Gratuity

Enable gratuity in
SoftTouch

When enabled there will be a button in cashout mode in 
SoftTouch that allows gratuity to be added to the check.

If operating in the United States, this should be left disabled.

Apply an automatic
gratuity using the
"Conditional tip 1"
on dining/bar
orders for parties of
___ or greater

If enabled, gratuity can automatically be applied to
tables with the number of guests (or more) you specify
here.

The amount charged for gratuity is taken from the value
you entered under the Tips tab for Convenience tip
percentage 1 (see System->Tips).

Enable tax on
gratuity using this
tax definition

If enabled, gratuity set up to automatically be applied to
a check can also be taxed. Use the drop-down to select
the appropriate tax. For taxes to show up here, you
must create them under Tax Table.
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Charge gratuity on
bar orders when
tendered with a
"single" credit card

Enabling this option will add gratuity on the check for
bar orders.

If operating in the United States, this should be left disabled.

Minimum amount
required

If enabled, you can set checks over a certain dollar
amount to have gratuity applied. If you wish to add it to
all checks, put .01 in this field.

Charge If enabled, specify the percent that will be charged as
gratuity.
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6.5 Future Orders Tab

Under the General section click on System. Select the Future Orders tab.

Future Orders

Fire future order (s) Enables you to fire a future order at a set time before
the order is due automatically (without the manager
having to manually fire it in the morning). 

*Note: Keep in mind that if you enter 0 (zero) it will
disable this feature.

Example: If you have entered 60 minutes in this field,
and someone calls and says they want an order for the
next day at 6:00 pm, the system will fire the order to
the kitchen automatically for you at 5:00 pm that day
(which is 60 minutes before it's due).

*Note: You can change the send time on the fly as
you're placing a future order if desired.

*Note: You must restart the server computer for
changes made here to take effect.

**ANY CHANGES MADE WILL REQUIRE A REBOOT OF THE SERVER FOR THE
CHANGES TO TAKE EFFECT.
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6.6 Hours & Wages Tab

Under the General section click on System. Select the Hours & Wages
tab.

Hours & Wages

**Warning**: This section is still to be filled out by the accountant. This is just
an explanation of what each section is for.

Wage
Calculation

You can choose between Regular and 8 Hour.

Minimum
Hourly
Wage

Enter the minimum wage for your state here.

Work Week Enter the number of hours in a standard work week. 
Employees who surpass this amount of hours in a work week
will receive overtime pay.
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Time
Format

Choose minutes or decimals from the drop-down box.  This
changes how the hours are displayed on the Hours and Wages
report. 

If an employee has worked 7 hours and 45 minutes and you
select the minutes option, their time will show as 7:45.  
If an employee has worked 7 hours and 45 minutes and you
select the decimal option, their time will show as 7.75.  

NOTE:  When running the Employee Attendance Report
from BackOffice, you will get the option to run this report in
minutes or decimals.  The restaurant owner should be made
aware of this.  In the event they select a different option than
the one set here, the system will appear to produce different
numbers when the numbers are actually accurate.

Tip Credit This field is for tipped employees whose regular salary is below
minimum wage.  This value is used in calculating overtime
wages for tipped employees.  

Speak with your state labor department or visit the Department
of Labor’s website for information regarding the proper figure to
enter in this field:

http://www.dol.gov/whd/state/tipped.htm.  

*Note: You must also put a check mark in the “Apply Tip Credit” box
that is found in the Employee area of BackOffice when setting up the
job and wage information for a specific employee.  Do this for every
employee who is paid below minimum wage for their regular salary.

Tip credit
allowance
differential

Tip Credit Allowance Differential:  Some states do not permit a
tip credit unless the average wage of the employee (including
the employee wage and tips received) exceed the applicable
minimum wage by a fixed amount.  Enter the fixed amount
here. 

Example: If the state requires that the employee average wage must
exceed the applicable minimum wage by $0.50 in order to qualify for
tip deduction, then enter $0.50 in this field.

 
*Note: If a tipped employee’s direct wage plus tips does not equal the
minimum wage for the time worked, then the employer is typically
required to make up the difference.  A warning will be displayed on the
Hours & Wages report for employees who are making below the
minimum wage.

Work week
overtime
factor

Enter the overtime factor here.

Example: If employees get time and a half for overtime pay, then
enter 1.5.  If they get double time, enter 2.0.

http://www.dol.gov/whd/state/tipped.htm
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Pay period
start day

Select the day of the week that starts your pay period. 

Example: If you select Monday, regular hours and overtime
wages are calculated from Monday through Sunday and start
again on Monday.

8 Hr Rule
Overtime

Use this section if an employee should be paid overtime for
working more than a certain number of hours in a day.

For "___ over ___ hrs," the first blank field should contain the
overtime factor/multiplier and the second blank field should
contain the number of hours after which that multiplier begins
to take effect.

Overtime factor #1 and Overtime factor #2 allow two sets to be
entered.

Example: If employees get time and a half for working over 8
hours and double time for working over 12 hours, enter "1.5
over 8 hrs" for Overtime factor #1 and "2 over 12 hours" for
Overtime factor #2.

*Warning: The above is an example; you must check your state's
requirements.

7th
consecutive
day

Use this section if an employee should be paid overtime for
working seven consecutive days.

For "___ for the first ___ hrs," the first blank field should
contain the overtime factor/multiplier and the second blank
should contain the number of hours (after the seventh day) for
which the employee should receive that multiplied rate.

For "___ over," the blank field should contain a second
overtime factor/multiplier that goes into effect after the number
of hours you entered previously has already passed.

Example: If employees get time and a half for the first 8 hours
after seven consecutive days and double time for anything past
that first 8 hours, enter "1.5 for the first 8 hours" and "2 over."

*Warning: The above is an example; you must check your state's
requirements.
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6.7 Intranet Tab

Under the General section click on System. Select the Intranet tab.

Intranet Settings

The Intranet is used in conjunction with the Paging/Alert system.  It has the ability to send
custom messages to servers' pagers. It can also show you any active or past alerts. The options
you see here are for customizing the way the intranet page is formatted.

Button Columns Choose the number of columns you want to appear.

*Note: Each button on the intranet page will correspond to an
employee’s name, so if you have a large number of employees,
then you may want more columns so that they can all fit on
screen.

Button Height
 
Enter a number to define the height of the buttons.

Custom Message Enter a message that will be pre-filled by default.  This should
be the most common message you would need to page
someone for.  (Ex: See me in the office!)
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Show With this drop down box you can choose whether you want all
server’s who are clocked in to show up, or to show everyone
who’s clocked in. 

*Note: employees must have a pager assigned to show up.

Build address with
query string button 

Make all of your settings choices and then click this button to
create the Web Address.

*Note: You can copy and paste this address into a web browser.
This creates a web page with a field where you can type a
message and a list of employees currently clocked in. 

 

Web
Address/Bookmark

If you filled in the above fields and pushed the Build address
with query string button, the Web Address will appear here.

Intranet Web
Addresses

You can use the URLs in this section to display different
aspects of the Intranet pages. Be sure to change where it says
“ServerIPAddress” to your server’s IP address. 

Example: If you server’s IP address is 192.168.68.101, then the
web address for the Manager Login Screen would be:
http://192.168.68.101/sweb.exe/login.

Example of what it would look like:

Manager Login Screen: Main Intranet Login URL.  Replace
“ServerIPAddress” with your IP.
==================
http://ServerIPAddress/sweb.exe/login

Paging: Main paging screen. Replace “ServerIPAddress” with
your IP.
==================
http://ServerIPAddress/sweb.exe/pageweb

HTTP Manual Paging: Used for paging someone directly by
typing this URL into a browser.  Replace “ServerIPAddress”
with your IP; replace “PagerNumber” with the pager number
of the employee you want to page; and replace
“YourMessage” with the text you want to appear on the
server’s pager.
==================
http://ServerIPAddress/sweb.exe/page?pager=PagerNumbe
r&msg=YourMessage

*Note: Instructions on using the Intranet Page in the web browser:
 
If you type a message into the field at the top, you can then click on a server's name to send a
custom message to their pager.  A pager system must be installed and enabled and the server
must be assigned a pager for this to work properly.
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For Instructions on setting up a pager system go to Hardware Section->Pager
Alerts->Activations.
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6.8 Custom Programs

Under the General section click on System. Select the Custom Programs
tab.

Custom Programs

The Custom Programs feature allows you to add up to 4 buttons in SoftTouch, which can be
accessed by going into the Employee section and pressing the Custom Programs icon.  

For example, if you want a button that will pull up Notepad, you would put Notepad (or any
desired descriptor) in the Button 1 Name field.  You would put C:\Windows\notepad.exe in the
Button 1 Filename, where C:\Windows is the path that the notepad.exe file resides.  Be aware
that you will need to give the permission "custombname1" to any security group that wishes to
use this button (see Miscellaneous->Security).
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6.9 Function Buttons Tab

Under the General section click on System. Select the Function Buttons
tab.

Function Buttons

In this section you can disable any buttons from the POS system that will not be used in the
restaurant. By adding them here and checking the Disable option, the button will not be visible
inside of SoftTouch.  Make sure the name is typed in exactly the same as it is in the POS system
and the Disable box is checked for this to work. 

Example:  

Let's say you have no need of the Switch View button in the POS system. 

In BackOffice, from the System applet, under the Function Buttons tab, type in the name
Switch View and check on the Disable option box:
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Now when you log into the POS system the Switch View button is no longer visible within the POS
system:

If you have the Switch View button in the list and you would like to be able to see it again,

uncheck the Disable option or delete the whole entry with the  option. If you would like

to add another button to be disabled click the  option.
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6.10 Customer Search Tab

Under the General section click on System. Select the Customer  Search
tab.

Customer Search
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New customer order
search options

When you do a delivery or takeout order, the first thing the
system does is search for an existing customer by the phone
number. When the phone number is not found in the list you
then search for the customer by the last name. The following
options let you choose in which manner the last name will be
handled:

Search Last Name, Confirmation: Searches by phone
number first; if the phone number is not found in the system,
you will be prompted to search by last name. If the last name
is not found, a confirmation dialog box will come up asking if
you are sure you would like to add a new customer with that
last name.

Search Last Name, No Confirmation: Searches by phone
number first; if the phone number is not found in the system,
you will be prompted to search by last name. If the last name
is not found, the system will immediately begin creating a
new customer record with that last name.

No Last Name, Confirmation: Searches by phone number
first; if the phone number is not found in the system, you will
not be prompted to search for a last name.  You will be given
a confirmation dialog box asking if you would like to add a
new customer to the database.

Example: A person calls and their number does not show up in the
system. The system will ask you if you would like to add the person
without searching for the last name first.

No Last Name, No Confirmation: Searches by phone
number; if the phone number is not found in the database,
the system will immediately begin creating a new customer
record.

Phone number area code
quick entry buttons (6
max)

You can put up to six area codes that are common to your
region in this section. These will then appear as buttons on
the phone number entry dialog in SoftTouch that you can
touch for faster phone number entry into the system. 
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6.11 Z Tab

Under the General section click on System. Select the Z tab.

Z Settings

Here you specify your Z settings and preferences. 

Reset check # on Z If this option is checked, the check numbers will get reset
back to the starting check number. (default is 100).

Clear drawers that were
assigned on Z

If this option is checked, during the Z operation all the
employee assignable drawers will be unassigned.

*Note: Only the self-assignable drawers will be cleared.
The drawers that are in the "assigned" section on the
employee will not be unassigned.  This will be explained in
further detail in the employee section of this manual.

Shut Down/Power Off
client machines on Z

If this option is checked, the client machines will be shut
down during the Z process.  The server computer will not
be shut down.

**Warning**:  Do not use this option if you have
NetEpay or DialEpay software installed on one of the client
machines, because that machine may be shut down before
it has a chance to send out the batch.
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Print Z status report If this option is checked, the Z status report will print after
the Z procedure.  The Z status report will give you
information informing you if your back up completed
successfully, if the credit cards batched, etc.

Print Z report If this option is checked, the Z report will print after the Z
procedure.

24 Hour Operation Check this option if your establishment never shuts down
and runs 24 hours.

If the 24 hour operation is checked, the checks do not get
reset, drawers do not get cleared and employees do not get
automatically clocked out at Z time.

*Note:  If Z is set to 24 hour operation server's open tips do not
get cleared on Z, employees do not get clocked out and drawers
as well as the checks numbers do not get reset.

If the establishment is not set to 24 hour operation, clocked in
employees are automatically clocked out on Z (if they have not
been scheduled to work past the time of Z), server's open tips get
cleared, drawers, and check numbers are reset.

**Warning**:  You should not enable Auto Z if you are
going to have 24hr operation on.

Keep employees clocked
in at Z

Unless this boxed is checked, any employees still clocked in
when you Z out will automatically be clocked out. Check
this box if you want to keep them clocked in.

Z Report Width Select the appropriate report width.  If you are printing
reports on the local receipt printer, select 40.  If you are
printing reports on a regular office printer, select 80.

Stop Z future from and
Stop Z future to

This feature is designed to help prevent an accidental Z.

If you enter, for example, 10:00 AM for "Stop Z future
from" and 5:00 PM for "Stop Z future to" then you will not
be able to run the Z between 10 AM and 5 PM if the
Operation date will be set into the future.  

For example, if the Op date is 1-5-10 and the system date
on the computer is also 1-5-10, then you will not be able to
run the Z between 10 AM and 5 PM because the Op date
will be set to 1-6-10, which is in the future.
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Start Check at # You can select the starting check number.  The default is
100.

Enable Auto Z If checked, the system will Z automatically at the specified
days and times.

**Warning**: Do not have this checked on if you are
going to use the 24hr operation option.

Time Fields listing
Monday-Sunday

Enter the times at which you would like the system to Z out
in the blank fields next to the days of the week. In the
picture above's example the restaurant chose to have the
Auto Z run every night at 4 AM. This is a good time because
if the restaurant closes say at 2 AM, it gives the Managers
time to input data into the system before a Z occurs.

- Z Report Batch -

The Z report batch allows you to tie some additional reports that will get printed along with your
Z report.

Step 1.  Click the Add button.

Step 2.  Under Report Name column, from the drop-down menu select the report you wish to tie
to the Z.

Step 3.  Under the Width column, specify the report width.  If you select 80, the report will print
on your 80 column printer.

Step 4.  Repeat the above steps if you wish to automatically print more reports when the system
performs a Z.
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6.12 Z Results Tab

Under the General section click on System. Select the Z Results tab.

Auto Z Results

Allows you to view the last Z results. It is the same as what gets printed during the Z.
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6.13 Services Tab

Under the General section click on System. Select the Services tab.

SoftTouch Services

Allows you to stop or start any SoftTouch services.

If you need to restart a particular service, say your reports seem to be freezing, you would just
highlight the SoftTouch Report Server and click stop.  As long as the Guardian Server is running, the
report server will restart on its own.

*Note: If you want to stop any of these services without having them restart, you will need to stop the
SoftTouch Guardian Server service first and then work on the other services. When finished, restart the
SoftTouch Guardian Server service.  Starting the SoftTouch Guardian Server service will automatically start
the rest of your services as well.
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Part 7 Order Functions

Under the General section click on Order Functions.

Order Functions

 

Order Functions contains the following tabs:

1. Counter

2. Bar/Dining

3. Delivery

4. Online
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7.1 Counter

Under the General section click on Order Functions. Select the Counter
tab.

Counter

- Counter Settings -

Eat-In Eat-Out You have the option to ask whether the order will be an
eat in or to go order at the Start of check or End of
check.  You can make your selection from the drop
down.

Custom Label You can have a custom label pop up in counter mode
when placing an order. 

Custom User Prompt
Data

For SoftTouch use only.
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7.2 Bar/Dining

Under the General section click on Order Functions. Select the
Bar/Dining tab.

Bar/Dining

- Misc Bar/Dining Settings -

Show employee
logins on bar

With this option selected, all clocked in employees will have a
button showing their name on the login's numeric keypad.
This allows anyone to press the button and login without the
need to swipe an ID card or enter a number.

*NOTE: While this may afford a quick way to login, you
eliminate all security as any employee can ring under any other
employee's number.  For the greatest speed and security, please
look into our RFID solution.

Beverage count vs
guest count for
tables

With this option selected, an employee will be required to have
one or more beverages rung up for each guest.

*NOTE: If this option bit is used, it is suggested that you
program a glass of water at a zero price for those guests who
just want water and/or a No Beverage button for guests who are
not ordering a beverage with their food.
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PreAuthorize Default
Amount

SoftTouch gives you the ability to pre-authorize a credit card to
ensure that a client's credit card is good before they order and
consume the food or beverage.  You can set this for a small
amount like $5.00 just to verify the card, or you can set it for a
larger amount if the tabs at this restaurant or bar are for large
amounts.

Display CC bar
orders by

You can select to display CC bar orders by Last & First Name or
by First & Last Name.

- iPOS/iTable/iKiosk Settings -

Enable iPOS/iTable/
iKiosk server

If you are using one or more of these devices, you must
check this box.
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7.3 Delivery

Under the General section click on Order Functions. Select the Delivery
tab.

Delivery

Delivery contains the following tabs:

1. Settings

2. Zip Codes & Driving Directions

3. Delivery Charges 

4. Delivery Bounds

7.3.1 Settings

Under the General section click on Order Functions. Select the Delivery
tab and then the Settings tab.



Version 6.1.16

52

Settings

- Delivery Settings -

Delivery waiting
time for unassigned
drivers

If a delivery order has been placed and is not assigned to a driver in
the amount of time specified in this field, the order will turn red,
indicating that it should be assigned soon.

Your area code Enter the area code of the restaurant in this field.

Minimum delivery
amount

You can set a minimum order amount that must be satisfied before
a delivery is allowed.  If the order is not as much as the amount
entered in this field, a warning will appear when the employee tries
to send or accept payment.  This warning indicates that the
minimum was not met and gives the option to add additional items
to build the check up to the proper amount or allow the sale anyway
(in case the store is slow and they wish to deliver in spite of the
minimum not being met).

Driver list order You can have the driver list in delivery sort the drivers by user ID or
by rotation (first in).  Make your selection from the drop down.
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Delivery bound look
up

You can establish the area that the restaurant will deliver to by
using zip codes or longitude/latitude.  Although longitude/latitude
will give you the most control over the delivery area, you will have
to use google maps to plot each point, returning to the starting
point to close the delivery area  circumference.

Auto assign
deliveries to

You can assign all deliveries to one person from the drop-down list
here; otherwise deliveries can be assigned manually as orders are
placed.

Print delivery
tickets immediately
on cash out

You have the option to print the check when the order taker places
the order and cashes out the check or when the order is assigned to
the driver.  If you wish to print the check when the order taker
places the order and cashes out the check, select this option.

Disable delivery
payment warning

If you hit send when completing a delivery order, payment is not
collected and it assumes that you will be collecting cash when you
deliver the order.  If you actually take cash (the customer pays cash in
person for an order that should be delivered that night) you get a
warning. If you wish to disable this warning, check this box.

7.3.2 Zip Code and Driving Directions

Under the General section click on Order Functions. Select the Delivery
tab.  Now select the Zip Codes & Driving Directions tab.
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Delivery Zip Codes & Driving Directions

Enter all zip codes that you deliver to by pressing the button and entering in the zip

code.  After adding a zip code, press the  button.  Repeat procedure above for any
additional zip codes.

7.3.3 Delivery Charges

Under the General section click on Order Functions. Select the Delivery
tab.  Now select the Delivery Charges tab.
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Delivery Charges

- Delivery Charges Settings-

The top part of the screen displays all delivery charges configured. Press the Add button
to add additional delivery charges.  The bottom part of the screen is where you configure
a new delivery charge.

Name You can assign any name you wish for the delivery
charge in this field.
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Schedule Name You can put a delivery charge on a schedule.  For
example, if you charge a $2.00 delivery charge during
the day and a $3.00 delivery charge at night, you would
set those schedules in the schedule applet of the
General section in BackOffice (see System Schedules
Tab) and  then select the schedule that applies from this
drop down list.  If you only use one schedule at all
times, you would select the All Day schedule from the
drop down list.

Delivery amount Enter the amount of the delivery charge in this field.

Enable Driver
Payment

If you wish to pay the driver a percentage of the
delivery charge, this box must be checked.

If operating in the United States, this should be left disabled.

Delivery charge % If you wish to pay the driver a percentage of the
delivery charge, enter the percent of the delivery charge
they will receive in this field.  (If the delivery charge is
$2.00 and the driver should get $1.00 of that, enter 50
in the % field.)
From the drop down to the right of the percentage field
you will need to select expense or wage. Select expense
if the driver gets paid daily and select wage if the
percent of the delivery charge that is given to the driver
will be added to his hourly wage and paid in his pay
check.

% of sales If you wish to pay the driver a percentage of the sale
amount rather than a percentage of the delivery charge,
enter the percentage here.  From the drop down to the right
of the percentage field you will need to select expense or
wage.  Select expense if the driver gets paid daily and
select wage if the percent of the delivery charge that is
given to the driver will be added to his hourly wage and
paid in his pay check.

Fixed amount If you wish to pay your driver a fixed amount per delivery,
enter the amount here.  From the drop down to the right of
the percentage field you will need to select expense or
wage.  Select expense if the driver gets paid daily and
select wage if the percent of the delivery charge that is
given to the driver will be added to his hourly wage and
paid in his pay check.
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Use delivery %
ONLY if > 0

7.3.4 Delivery Bounds

Under the General section click on Order Functions. Select the Delivery
tab.  Now select the Delivery Bounds tab.

Delivery Bounds

If you use different delivery charges depending on the location to which you're
delivering, or if you want to establish different zones that you do or do not deliver to,
create different location boundaries and attach Delivery Charges to them here.

- Delivery Zone-

Use the Add button and click in the blank space below Name to type in a name for this
delivery zone. You can create as many as needed.

Under Type, use the drop-down to select either IN or OUT. IN is a zone that you deliver
to. OUT is a zone that you do not deliver to.

You can deactivate this zone by removing the check from Active.

*Note: Whichever zone here has the arrow next to it is selected and will be edited when
you make adjustments under Delivery Charge and Delivery Lat/Lon.
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- Delivery Charge-

Use the Add button and click on the blank space under DeliveryName to activate the
drop-down. From the drop-down, select the delivery charge you want to add to the
selected delivery zone. You can add as many as needed.

You can set up additional delivery charges under the Delivery Charges tab.

*Note: If you have set a Delivery Zone's Type to OUT, you do not need to attach any
delivery charge.

- Delivery Lat/Lon-

This is where you define the actual perimeter/boundaries of the selected delivery zone.

Use the Add button and click in the blank under Lat to type in the latitude and click in
the blank under Lon to type in the longitude. The zone will be defined by connecting the
latitude/longitude points you have supplied (it includes everything within that perimeter).
You must add a minimum of three latitude/longitude coordinates but can add as many as
you need.

*Note: If there is an area within this zone that you do not deliver to, set this area up as
a separate delivery zone and set the Type to OUT.

The Lookup address lat/lon button brings up all addresses from your customer list
(see Customers->Customer List Tab) and allows you to search within it for
latitude/longitude coordinates.

You can also use Google Maps to determine the latitude and longitude of an address or
physical location on a map. Go to 
https://support.google.com/maps/answer/18539?hl=en for more information on how
this is done.

http://www.google.com/maps
https://support.google.com/maps/answer/18539?hl=en
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7.4 Online

Under the General section click on Order Functions. Select the Online tab.

Online

The online area is used by SoftTouch personnel only.  If you have a customer
interested in online ordering and how it can dramatically increase sales, please
contact SoftTouch and they will expedite this service for your customer.
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Part 8 Employees

Under the General section click on Employees.

Employees

Employee Setup contains the following settings:

1. Employee

2. Security

3. Finger Print

4. Job

5. Wage

6. Address

7. Phone Numbers

8. Tills/Pockets

9. Scheduling

10. Tracking

10. Alerts/Emails/SMS

11. Notes
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8.1 Employee List

Under the General section click on Employees and then the Employee list
tab.

Employee List
 

All the employees that you add show up under the Employee list part of the screen. 
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By default, anything with just a black arrow next to it is what the highlighted employee is.  Changes
made will be made to this employee.

If you need to actually select a name, scroll through the list and click on the Employee you would like
to edit; the employee will then be highlighted.

- Current Employee Job List -

To the right of the employee list is the Current Employee Job List. This section lists the jobs
assigned to the employee you have highlighted. Sometimes you will edit details of one specific job of
the selected employee, so you will want to make sure to click on that specific job to select it. When a
job is selected, it will have an arrow next to it and possibly be highlighted.
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- Search for an Employee -
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If your employee list has become too long to scroll through, you may search for an employee by their
last or first name in the search fields.

Tip: Another way to scroll through the employee list one by one if you are in the tabs section is by using the
buttons in the top right corner of the screen near the X sign for exiting SoftTouch BackOffice.  The name of the
employee who is currently selected will be displayed on the top left.

- Hide All Inactive Employees -

If you have a long list of employees and do not want to see the employees that are no longer active
check on the box Hide inactive employees.

If you've already checked on the box to hide inactive employees and then mark another employee as

inactive, pushing the refresh button  will hide that employee from Employee list immediately.

The option to activate or deactivate an employee is found under the Security Tab.



Version 6.1.16

67

8.1.1 Employee Tab

Under the General section click on Employees and then the Employee list
tab. Select the Employee tab.

Employee Tab

- Add an Employee -

Click the  button and fill out the employee information.

- Add an Employee Options -

Third Party ID If you need to create a different ID for this employee for any
reason for your own use outside of SoftTouch, such as for
exporting to payroll, it can be entered here.

First Name and Last
Name

The First and Last Name of the employee must be filled out.

*Note: This section is not optional to fill out.
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Employee Type You can leave this field blank or choose from the following
options:

SoftTouch Employee: When set to this, the employee will
use the POS system for SoftTouch.

iTable Employee: This is used in conjunction with the iTable
solution. When a customer places an order it will show up in 
SoftTouch as the iTable employee placing the order.

Internet Employee: This is used in conjunction with the
internet option for placing an order for delivery / pick up.
When a customer places an order it will show up in SoftTouch
as the  internet employee placing the order.

Self-Pay Employee: This option would be used in
conjunction with the Self-Pay machine where a customer
cashes themselves out. When a customer cashes themselves
out it will show up in SoftTouch as a Self-Pay Employee
cashing out.

Dineblast Mobile Employee:This is used in conjunction with
Dineblast Mobile. 

*Note: This option is not available yet.

iKiosk Employee:This is used in conjunction with the iKiosk
solution. When a customer places an order it will show up in 
SoftTouch as the iKiosk employee placing the order.

*Note: If you leave this field blank the default selection is a
SoftTouch employee. This section is optional to fill out.

Social Security # Enter your Employee's social security number here.

You can choose to show or hide this information by clicking the 
Show/Hide button.

*Note: The social security number will be displayed on the top
of the Hours & Wages report encrypted and on the Employee
Attendance Report in full.  This section is optional to fill out.

Birthday You can add the Employee's birthday information to this
section.

*Note: This section is optional to fill out.

Employment Date You can input when the employee started at the restaurant.

*Note: This section is optional to fill out.
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Group Name This is where you can specify a group name.  When you run
the Hours and Wages report, you can also specify a group
name in the parameters of the report so that only the people
who have the same group name will show up on the report.

Example: If you enter "server" here, you can then enter
"server" in the hours and wages report to see only people who
have "server" in the group name field.

Dealer Account If you check this option it gives the Employee access to the
system as if they are a Dealer. 

**Warning: The Dealer (and maybe the owner) should be the
only ones with the Dealer access to the system. Any changes
you make to a dealer account will bring up a prompt asking if it
is okay to change the account information.

Left/Right Handed You can change the side of the screen where you want the
check to appear when ringing up orders by choosing from the 
Left/Right handed  drop down list.

Button Size You can choose if you want to display small or large buttons
by making a selection from the Button Size drop down list.

Driver Dispatch
Assignment Mode

Advanced: Gives the user the ability to assign other drivers to
the delivery orders as well as themselves.

Basic: Gives the user the ability to assign orders to
themselves.

*Note: If this area is left blank the person will be assigned the
basic functions of the driver dispatch assignment mode.

Once you have entered the employee information, click the  button.
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8.1.2 Security Tab

Under the General section click on Employees. Select the Security tab.
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Security

Step 1.  Make sure the Active/Account Disabled box is checked on for an active employee. 

*Note: If the account is inactive, when you check on the Hide inactive employees box, the Employee's
account will be hidden.

Step 2. Specify a System User ID for the employee. 

*Note: The User ID of an employee you specify here shows up on the guest checks. It is advisable to
have a name placed within this section.  This is also the User ID that is used when accessing
BackOffice.  If you do not want this employee to have access to BackOffice, do not use the Change
Password button under the BackOffice section of this screen.

Step 3. Set a password for this Employee only if they should have access to BackOffice.  Click
on Change Password under the BackOffice section. A box such as below will pop up. Enter the
employee's password in the box and click okay.  The password must be at least 6 characters and
one number. 

*Note: Remember to read the section in the box about Swipe Cards.
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Step 4.  The password will expire after 90 days. You will know when your password will expire by
checking the Password Expires section.

Step 5. The SoftTouch Swipe ID/RFID section is where you will you assign the number or card
the employees will use when ringing up orders, as well as additional SoftTouch options.  

Step 6. Additional SoftTouch options can be adjusted in the Manager Options section.

- Security Option Explanations -

Swipe id/RFID never
expires

If the box is checked, your swipe ID or RFID will not
expire after 90 days.
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Leave cashout/payment
amounts under original
employee

This option should only be enabled for managers. 

Here is why:

Let's say the server needs a manager's help cashing out
their order. There are two things to remember here:

1. When a server starts a check he/she is the owner of
that check and is therefore responsible for the money

2. If the manager cashes out that check, they will have to
physically hand over the money to the person who started
the check because it will be reported under that
employee's server report.

So if this option is not checked, the cash-out amount will
go under the manager's ID and not the server's ID.  When
a manager helps a server cash out their check, you want
the server to still be responsible for the money and not
the manager. Therefore, make sure that manager's
always has the "Leave cash-out money under original
employee" option checked. 

*Note: If a manager started the order and cashed out the
order, the cashout amount will go under manager's ID
even if this option is checked. That's fine, because the
manager is the owner of that check and the manager
cashed it out, so he is the one responsible for the money.

Show bank detail
amounts on screen

This option lets an employee see the amount of
money in each bank that displays in the Tills,
Pockets & Store Management area of the Manager
Screen in SoftTouch.

Change Swipe ID Press this button, then enter the desired employee
number or swipe an employee ID card if you are using
cards.

Change RFID *Note: This must be done from a computer that has an
RFID transmission box installed on it.

Press this button, then wave the RFID bracelet over the
RFID transmission box.

Clear Swipe ID Press this button to remove this employee's swipe
ID.

Clear RFID Press this button to remove this employee's RFID.



Version 6.1.16

74

8.1.3 Finger Print Tab

Under the General section click on Employees and then on the Employee
list tab. Select the Finger Print tab.

Finger Print ID

To register the finger print for an employee press the Register Finger Print button. In the
window that pops up, an employee will need to place his/her finger on the sensor 4 times in order
to complete its registration. After this you might want to verify the finger print scan by pressing
the Verify Finger Print button and having an employee place their finger on the sensor again.
The finger print can be cleared by pressing the Clear Finger Print button.

You have now registered an employee's finger print. 

Options on what you will use the fingerprint ID for are covered later in the manual under 
Hardware->Stations->Hardware Devices->Fingerprint.
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8.1.4 Job Tab

Under the General section click on Employees and then on the Employee
list tab. Select the Job tab.

Employee Jobs

Here you assign either one job or multiple jobs to your employees.

- Assign Job Information -

First select an employee from the Employee list part of the screen, then click the Job Tab.

In the Employee job detail part of the screen click the  button and enter job information in
the fields below.

Active This box must be checked for the specified job to be active.

Job Description Select a job for an employee from the drop-down menu

*Note: What is listed in this section is what is created in the Jobs applet,
which is covered in  Miscellaneous->Jobs.

Security Group Specify the security level for the job. We will talk about security later,
but if you wish to learn more about this feature now go to
Miscellaneous->Security.
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Auto Login If you select a mode from the drop-down field of this section, when
an employee clocks in, swipes their card, or inputs their number into
the POS system, they will always be taken to that mode.

If the Auto Login is left at none, the employee will not be logged
immediately into any mode. They will be brought to the chalkboard
screen.

*Note: A mode is Counter, Dining, Bar, etc.

Job Code 1 If you need to create a job code for this employee for any reason
for your own use outside of SoftTouch, such as for exporting to
payroll, it can be entered here.

Job Code 2 If you need to create a second job code for this employee for any
reason for your own use outside of SoftTouch, it can be entered
here.

Pickup all
employee
checks

Enable this for employees that should have access to other
employees' checks.  Managers, as well as cashiers that close checks
for servers, are a couple of examples of jobs that should be able to
pickup all employee checks.

If the employee has more than one job, this option can be set
differently for each job they work.

Assign RFID or
swipe card on
clockin

If you wish to assign a different swipe card or RFID bracelet each
time this employee clocks in, check this option box.  This is usually
used for RFID bracelets that restaurant owners do not want their
employees going home with.

If the employee has more than one job, this option can be set
differently for each job they work.

Shifts Specify the shift(s) during which this job is applicable to the
selected employee. Use the Add button below this section to
designate more than one shift. Instead of deleting a shift that no
longer applies, you can uncheck Active if that shift might apply
again at a later date. For shifts  to appear as choices here, they
must first be created (see Scheduling->Add Schedule).

- Assigning Multiple Jobs -

You can do this for different job descriptions for each employee. For example, you might have servers that also
work as bartenders or busers. Each employee can have an unlimited number of jobs.

The best way to accomplish this is to assign multiple jobs.
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Step 1. Select/highlight the employee from the Employee list you want to add jobs to.

Step 2.  Under Employee job detail, select a job description and fill in the rest of the above mentioned fields.

Step 3.  Once complete, hit Save and then click Add.

Step 4.  Select another job description and fill in the rest of the above mentioned fields.

Step 5.  Add as many job descriptions as required for that employee, remembering to save each time.

Step 6.  Repeat this process as needed for each employee.

*Note: Pay for a particular job can be adjusted under the Wage tab, which is covered next in
Employees->Employee List->Wage.

To make changes to a job you've previously created, first click/highlight that job under the Current
Employee Job List.

You can deactivate a particular job for later re-activation without having to delete it. Do this by
de-selecting the Active option. If you need to reactivate the job, put a check mark back in the
Active option.

Click  when you're done.

8.1.5 Wage Tab

Under the General section click on Employees and then on the Employee
list tab. Select the Wage tab.

Employee Jobs

Here you assign either one job or multiple jobs to your employees.

- Assign Wage -
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First select an employee from the Employee list part of the screen, select a job from the Current
Employee Job List (if more than one have been assigned), and then click the Wage Tab.

Pay Type Specify how the employee is being paid for this job (ex. hourly or
weekly).

Hourly: This is for any employee who is paid by the hour.

Overtime Exempt: This is for any employee on a salary.  Specify
one week's pay in the Wage Amount field.

Wage Amount Enter the amount the employee is being paid for this job.

Whether this pay is given hourly or weekly depends on what you
specified in the Pay Type field. 

You can choose to show or hide this information by clicking the 
Show/Hide button.

Apply tip credit Enable this for employees who get paid below minimum wage (such
as servers).  The tip credit that was filled out in the Hours & Wages
setup (see System->Hours & Wages) will then be applied in
calculating that employee's overtime wage.

Click  when you're done. You can set different wages for different jobs an employee might
have.

8.1.6 Address Tab

Under the General section click on Employees and then on the Employee
list tab. Select the Addresses tab.
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Address

This section is optional to fill out. Multiple addresses can be listed here for any employee.

First select an employee from the Employee list part of the screen and click the Address Tab if

you haven't already. Click the  button and fill out the fields:

· Description
· Address1 and (optional) Address2
· City, State, and Zip Code

Click the  button when you're finished and the button if you would like to add
another address and repeat the steps listed.

8.1.7 Phone Numbers Tab

Under the General section click on Employees and then on the Employee
list tab. Select the Phone Numbers tab.

Employee Phone Numbers

Here you can add employee phone numbers.
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First select an employee from the Employee list part of the screen and click the Phone Numbers

Tab if you haven't already. Click the  button and fill out the fields:

· Area Code
· Phone #
· Extension (if any)
· Description

Click the  button when you're finished and the button if you would like to add
another phone number.

8.1.8 Tills/Pockets

Under the General section click on Employees and then on the Employee
list tab. Select the Tills/Pockets tab.

Employee Tills/Pockets

Here you can add any tills or pockets that an employee will work out of.  

Assigned tills are used for employees that are banking themselves and will always use the same
"pocket."  In some cases, if there is only one till in a restaurant you can enter that as assigned to
people that work that till so that you do not have to select the till they will be working from each
day.

Assignable tills are for employees that will work out of different cash drawers.  For example, a
bartender may work the front bar, the back bar or the patio bar.  You would want to add all three
tills as assignable so they can select which drawer they will be working out of when they get to
work and find out which area they will be working at.

- Add an Assignable Till -
To add an assignable till to an employee you must first create the drawer.

*Note: If you wish to find out about this function now see under Financial>Banks.
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First select an employee from the Employee list part of the screen and click the Tills/Pockets Tab
if you haven't already. 

Step 1.  Click the  button.
 
Step 2.  Click in the blank white box under the header Assignable.

Step 3.  Select the drawer that this employee will be working out of.

Step 4.  Click the  button.

Step 5.  Repeat the steps above for each additional drawer this employee will use.

8.1.9 Scheduling Tab

Under the General section click on Employees and then on the Employee
list tab. Click on the Scheduling tab.

Scheduling

This is where you can enable employee scheduling to be used with select employees.

Scheduling Enabled Unless you have scheduling enabled, the before and after scheduling
grace periods will not work.  You must also have this box checked
before this employee will show up in the list of employees you can
schedule in the Employee Scheduling area (see 
Scheduling->Employee Scheduling).

*Note: This is  used in conjunction with the Employee Scheduling option
located on the System Schedules tab under Scheduling.
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Before ____ Mins. This means that an employee will not be allowed to clock in earlier
than the number of minutes specified here.

Example: If "Before" is set to 5 min. an employee will be able to clock in
5 minutes earlier than their scheduled time, but not 20 minutes earlier.

After ____ Mins. This means that an employee will not be allowed to clock in later
than the number of minutes specified here.

Example: If "After" is set to 15 min. an employee will be able to clock in
15 minutes later than their scheduled time, but not 20 or 30 minutes
later.

8.1.10 Tracking Tab

Under the General section click on Employees and then on the Employee
list tab. Select the Tracking tab.

Tracking

You can track how many items are sold by a specific employee. This is called Employee Tracking. You
can track items sold by Super Departments, Departments, Family or by the Item Number.

Some establishments use tracking to encourage employees to sell more items, offering them a
reward to do so.

- Add Employee Tracking -

To set tracking for a certain employee, first select that employee from the Employee list part of
the screen.

Under the Employee tracking part of the screen click the  button. If you click twice in the
box under Super Department, Department, or Family, you will then be able to activate a
drop-down menu and choose what item's sales you wish to track. Or click twice in the box under
Item # and type in the number of the item you wish to track.

- Find Out the Item Number -

To find out an item number go to Item Builder under General section, select the Menu & Rule
Builder tab, click the red Items button, expand an item group and select a particular item. On
the bottom right side of the screen, select the Item tab. The item number is displayed under
Item properties.
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8.1.11 Alerts/Email/SMS Tab

Under the General section click on Employees and then on the Employee
list tab. Select the Alerts/Email/SMS tab.

Alerts/Email/SMS

 In the image below, the SMS Via email section shows you how to properly format the phone number.
This could change without notice.

**Warning**: There may be fees and/or charges applied by the cell phone company for texting.
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Email/SMS Address This area is for setting up cellphones to act as pagers through an SMS
message for alerts that are set (in the Pager/Alerts section) to be sent
to managers via Email/SMS.

To set up the Email/SMS you need to fill in the SMTP server information
(seeHardware Section->Email/SMS).

1. Enter the cellphone information. The cellphone number has to be in
an email format that matches the provider within the SMS via email
area.

Example: 1234567890@messenging.sprintpcs.com or 1234567890@vtext.com

2. Navigate to the Pager/Alerts section (see
Hardware->Pager/Alerts) and enable the Pager/Alert system. Make
sure some alerts are activated, such as the Labor Sales, by checking on
the Alert Active box. Check on the Alert manager via email box. 

*Note: It is possible to use the email/SMS settings even if you do not have the
physical LRS paging system installed.

3. Reboot the Server or restart the Pager and Alert services.

Pager ID Shows the current pager number assigned to the employee.

Alerts On If the box is checked on, this enables alerts for the employee. When the
employee clocks in, they will be asked to assign a pager number. The
pager will be unassigned when they clock out.

Master
Pager/Alerts: 

Enable this option for managers so they will receive alerts that are set
to be sent to the manager via pager and/or email after a specified
number of unattended alerts. (This number can be set on the 
Destination tab under Hardware->Pager/Alerts->Alert List Tab.)

SMS via Email
(might change
without notice)

This section helps you to configure emails and SMS messages to be
sent to cell phones. The information here is subject to change based on
cellular/wireless service providers.

mailto:1234567890@vtext.com
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8.1.12 Notes Tab

done

Under the General section click on Employees and then on the Employee
list tab. Select the Notes tab.

 Notes

Here you may add notes regarding your employee.
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8.2 New employee Wizard

Under the General section click on Employees and then click on the New
employee "Wizard" tab.
 
1.  Press the Click here to start adding a new employee button.

2.  You must enter the first and last name.  All other fields are optional.  Press the Next button at the
bottom right of the screen when you are done.

3.  All fields on the Address and Phone # screen are optional.  Press the Next button at the bottom
right of the screen when you are done.
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4.  On the Security Settings screen, specify a System User ID for the employee. 

*Note: The User ID of an employee you specify here shows up on the guest checks. It is advisable to
have a name placed within this section.  This is also the User ID that is used when accessing
BackOffice.  If you do not want this employee to have access to BackOffice, do not use the Change
Password button.

By using the first drop-down list, you can select an employee that has the same security
setting that you wish the newly added employee to have.  Once you select a name from the
drop down list you will get a message:
"Are you sure you want to override the current security settings with security settings from
the selected employee?"
Click Yes if you wish to copy the security settings of the selected employee to you new
employee.

If you wish to manually configure the options shown, refer to the Security Option
Explanations chart below to learn about each option.
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- Security Option Explanations -

Swipe ID never expires If the box is checked, your swipe ID will not expire after
90 days.
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Leave cashout money under
original employee

This option should only be enabled for managers. 

Here is why:

Let's say the server needs a manager's help cashing out
their order. There are two things to remember here:

1. When a server starts a check he/she is the owner of
that check and is therefore responsible for the money

2. If the manager cashes out that check, they will have to
physically hand over the money to the person who started
the check because it will be reported under that
employee's server report.

So if this option is not checked, the cash-out amount will
go under the manager's ID and not the server's ID.  When
a manager helps a server cash out their check, you want
the server to still be responsible for the money and not
the manager. Therefore, make sure that managers always
have the "Leave cash-out money under original
employee" option checked. 

*Note:If a manager started the order and cashed out the
order, the cash-out amount will go under manager's ID
even if this option is checked. That's fine, because the
manager is the owner of that check and the manager
cashed it out, so he or she is the one responsible for the
money.

Show bank detail
amounts

This option lets an employee see the amount of
money in each bank that displays in the Tills,
Pockets & Store Management area of the Manager
Screen in SoftTouch.

5. Clicking next will take you to the Passwords screen.

If this employee should have access to BackOffice, press the Set a BackOffice Password button
and add password for this employee.  
You must set a swipe ID or register a fingerprint for each employee.  If you want the employees to
use a swipe card or type in a number to access SoftTouch, press the Set Swipe ID button and
either swipe the ID card or type in the number this employee will use.  If you wish to register a
fingerprint, you must first have a fingerprint reader installed on this computer.  To register the
fingerprint for an employee press the Register Finger Print button. In the window that pops up, an
employee will need to place his/her finger on the sensor 4 times in order to complete its registration.
After this you might want to verify the finger print scan by pressing the Verify Finger Print button
and having an employee place their finger on the sensor again.
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6.  Click next. Fill in the fields below to set job, security and wage information.  Please refer to the
chart below the Job assignment screen for explanations of each option.
 

If this employee has more than one job, you would enter the first job here, then go back to the
employee record, highlight it, select the Job and Wage tabs and enter the information for each
additional job this employee works.
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Job Description Select a job for an employee from the drop-down menu

*Note: What is listed in this drop-down is what was created in the Jobs
applet (see Miscellaneous->Jobs).

Security Group Specify the security level for the job. We will talk about security later,
but if you wish to learn more about this feature now go to
Miscellaneous section->Security.

Pay Type Specify how the employee is paid (ex. hourly or weekly).

Hourly: This is for any employee who is paid by the hour.

Overtime Exempt: This is for any employee on a salary.  Specify
one week's pay in the wage amount field.

Wage Amount Enter the amount the employee is paid. This is hourly or weekly
depending on the Pay Type specified.

You can choose to show or hide this information.
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Apply tip credit Enable this for employees who get paid below minimum wage (such
as servers).  The tip credit that was filled out in the Hours & Wages
setup (see System->Hours & Wages Tab) will then be applied if
the employee works overtime.

7. Click next. Depending on the type of employee being created, you may be taken to a screen
allowing you to set up the employee's till. If not, skip ahead to step 8.

Under Permanent or Assignable, click one or the other depending on that employee's needs:
· Permanent tills are used for employees that are banking themselves and will always use the

same "pocket."  In some cases, if there is only one till in a restaurant you can enter that as
assigned to people that work that till so that you do not have to select the till they will be
working from each day.

· Assignable tills are for employees that will work out of different cash drawers.  For example, a
bartender may work the front bar, the back bar or the patio bar.  You would want to add all
three tills as assignable so they can select which drawer they will be working out of when they
get to work and find out which area they will be working at.

To add an assignable till to an employee you must first create the drawer.
*Note: If you wish to find out about this function now see under Financial>Banks.

The first drop-down list in the Banks section lets you copy another employee's till settings to this
employee.

Clicking in the box under Banks (with the black arrow) allows you to use a drop-down list to

select a till. If this employee will be using more than one till, use the  button and select
additional tills as needed. Click next when you're ready to move on.
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8.  Press the Finish button at the bottom right corner of the screen.
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Repeat this process for additional employees you wish to add.
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Part 9 Time Editor

Under the General section click on Time Editor.

Time Editor

You can  manage employee time punches in BackOffice through the Time Editor.  From this
applet you can modify a pay rate for a time punch record, edit a time clock entry, add an in and
out time or add a break in and out time.

Employees get paid for breaks.  If you add a break in and out, the employee will get paid for the
time the employee was on break.  If you add a time clock in and out, the employee will not get
paid for the break.

Time Editor includes the following functions:

1. Get Time Clocks

2. Select/Unselect All

3. Adjust Pay Rate(s)

4. Edit Time Clock Entry

5. Delete Time Clock Entry

6. Add In/Out

7. Add Break/In
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9.1 Get Time Clocks

Under the General section click on Time Editor.

Get Employee Time Clock Entries

1.  Select the employee whose time records you would like to view from the Select employee drop
down list.

2.  Use the From and To drop down calendars to select the date range for which you would like to
pull up the selected employee's time clock records.

3.  Press the Get Time Clocks button on the right side of the screen.
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This will bring up a list of all time records for the specified employee during the specified date range.
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9.2 Select/Unselect All

Under the General section click on Time Editor.

Select All Time Clock Entries

1.  You may have more than one record if you select more than one day or if the employee has
clocked out or clocked out on break.  To select all records, press the Time Clock option at the top of
the screen.

2.  From the Time Clock option list, click Select All.

All time clock entries shown on this page should be highlighted, showing they are selected.
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Unselect All Time Clock Entries

1.  Press the Time Clock option at the top of the screen.

2.  From the Time Clock option list, click Unselect All.

All highlighted entries will be unselected.
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9.3 Adjust Pay Rate(s)

Under the General section click on Time Editor.

Adjust Pay Rates

1.  Pull up the time records for the desired employee and date(s). Refer back to Get Time Clocks if
you need help.

2.  Click on the time record with the incorrect pay amount to highlight it. If you would like to make
the same adjustment to multiple records at once, use ctrl or shift while clicking, or use Select All
from the Time Clock drop-down. When the appropriate record(s) is/are selected, press the Time
Clock option at the top of the screen. 

3.  From the Time Clock option list, click Adjust Pay Rate(s).

4.  From the Payment Adjust screen, select the job they worked from the Select a job description
drop down list; select whether the employee was being paid hourly or overtime exempt (salaried)
from the Select a wage type drop down list; select the shift they worked from the Select a shift
drop down list; and enter the wage amount in the Select a wage amount field.  When all entries are
complete, press the Adjust button at the bottom left side of the Payment Adjust dialog box.
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You will notice the amount under the Wage $ header for the highlighted records has changed to
reflect your entry.

Repeat this step for all time clock entries that need to have the pay rate adjusted.
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9.4 Edit Time Clock Entry

Under the General section click on Time Editor.

Edit Time Clock Entries

1.  Pull up the time records for the desired employee and date(s). Refer back to Get Time Clocks if
you need help.

2.  Click on the time record with the incorrect pay amount to highlight it. Press the Time Clock option
at the top of the screen. 

3.  From the Time Clock option list, click Edit Time Clock Entry.

4.  From the Edit Time Clock Entry screen, select the date from the drop down calendar (if
applicable) and/or enter the correct time (if applicable).  When all entries are complete, press the 
Adjust button at the bottom left side of the Edit Time Clock Entry dialog box.
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5.  You will notice the time under the Time Clock header has changed to reflect your entry.
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9.5 Delete Time Clock Entry

Under the General section click on Time Editor.

Delete Time Clock Entries

***When you delete a time clock entry, you will be deleting both the in and the
out time.  

1.  Pull up the time records for the desired employee and date(s). Refer back to Get Time Clocks if
you need help.

2.  Click on /highlight the time record you would like to delete. If you would like to make the same
adjustment to multiple records at once, use ctrl or shift while clicking, or use Select All from the
Time Clock drop-down. When the appropriate record(s) is/are selected, press the Time Clock option
at the top of the screen.

3.  From the Time Clock option list, click Delete Time Clock Entry.

*Note: No confirmation dialog box follows this, so be sure you have selected the correct record(s)
and that you really want to delete them.

Both the clock in and the clock out entry for that time record will be deleted.
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9.6 Add In/Out

Under the General section click on Time Editor.

Add In/Out

Even if you are adding an in and an out time entry, it is a good idea to pull up any time
records for the day you are adding the record for.  This way you can verify that there are no
other time clock entries and if they did work two shifts that all time records for that day are
correct and you are not overlapping time records.

1.  Pull up the time records for the desired employee and date(s). Refer back to Get Time Clocks if
you need help.

2. Look at the existing time records for the date range you specified. Make sure your desired new time
entry will not overlap. It does not matter if a record is highlighted or not.

3.  From the Time Clock option list, click Add In/Out.

4.  From the Add Time Clock Entry input screen, select the job description and shift, then enter the
date and time that this employee should have clocked in and then enter the date and time this
employee should have clocked out. Select a job description and/or shift if this employee has multiple
jobs/shifts. Press the Adjust button when finished.
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The information you just entered will now display on the screen.
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9.7 Add Break/In

Under the General section click on Time Editor.

Add Break/In

***A BREAK IN AND OUT RECORD WILL PAY THE EMPLOYEE DURING THE
BREAK TIME.  IF YOU WISH TO RECORD AN UNPAID BREAK, USE THE ADD
IN/OUT FUNCTION FROM TIME EDITOR.

Even if you are adding a BREAK in and out time, it is a good idea to pull up any time records
for the day you are adding the record for.  This way you can verify that there are no other
time clock entries and if they did work two shifts that all time records for that day are
correct and you are not overlapping time records.

1.  Pull up the time records for the desired employee and date(s). Refer back to Get Time Clocks if
you need help.

2.  Look at the existing time records for the date range you specified. Make sure your desired new
time entry will not overlap.

3.  Click on the time record for which you would like to add a Break/In to highlight it. Press the Time
Clock option at the top of the screen.

4.  From the Time Clock option list, click Add Break/In.
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5.  From the Add Break/IN Entry input screen, enter the date and time that this employee should
have started their break in the fields next to BREAK and then enter the date and time this employee
should have ended their break in the fields next to IN.  Press the Adjust button when finished.

The information you just entered will now display on screen.
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Part 10 Customers

Under the General section click on Customers.



Version 6.1.16

114

Customers

Customer Setup contains the following settings:

1. Settings & Maintenance

2. Auto Completion

3. Filter Customer List 

4. Customer List 
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10.1 Settings & Maintenance Tab

Under the General section click on Customers. Select the Settings &
Maintenance tab.

Settings & Maintenance

- SoftTouch Search Options -

No wildcard search The exact match will have to be entered when searching for a first
and/or last name of a customer.

Example: if you typed in Smith you would get all the listing of all the
last names of Smith, but if you typed in only Smi you would be asked if
you want to add a new customer with the last name of Smi.

Full wildcard
search

When you type in a couple of letters to search by, all fields will be
searched for words containing the letters.

Example: If you typed in SM it would search for any name containing
SM, such as Smithers, Small Town, Asmoth Valley, Delsmor Beach, etc.

*Note: This searches  across first name, last name, company, and
address/city fields.
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Partial wildcard
search

When you type in a couple of letters to search for a word, it will only
search the beginning of the words. 

Example: If you typed in SM it would search only the first part of the
words for SM, such as Smoke, Smith, Smithey. 

*Note: This searches  across first name, last name, company, and
address/city fields.

Enable soundex
(phonetic
algorithm)

If you meant to type a word one way but spelled it wrong and it
sounds the same, the system will bring up a list of words that sound
the same.

Example: If you typed in Smyth but the person's name was really
spelled Smith the computer would bring up a list containing both Smyth
and Smith because they phonetically sound the same.

*Note: This only searches across first name, last name, and company
fields.

- Maintenance -

Delete all
customers

Enables all customers listed in the Customer list to be deleted.

Clear all loyalty Enables all loyalty history and loyalty history tied to customers to
be deleted.

Clear all loyalty
visits

Enables all loyalty visits and loyalty visits tied to customers to be
deleted.

Clear all loyalty
points

Enables all loyalty points history and loyalty points tied to
customers to be deleted.
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10.2 Auto Completion Tab

Under the General section click on Customers. Select the Auto
Completion tab.

Auto Completion

The Disable automatic completion option allows you to turn off auto completion. If disabled, it will not matter
what you have listed under the Address Custom Completion tab or the First Name Custom Completion tab.

Auto Completion explanation includes the following:

1. Address Custom Completion

2. First Name Custom Completion
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10.2.1 Address Custom Completion Tab

Under the General section click on Customers. Select the Auto
Completion tab. Select the Address Custom Completion tab.

Address Custom Completion 

- Auto Completion -

Disable automatic
completion

Checking on this box will prevent it from automatically completing
what you are typing if it matches information already in the
system.

Skip auto
completion fields

Checking on this box will prevent it from automatically completing
fields other than the one you are typing in (such as city, state, and
zip code if you are entering the address).

*Note: This applies only to Address Custom Completion and not
First Name Custom Completion, as First Name Custom Completion
involves only one field (First Name).

- Address Keywords -

Import Data Enables you to import a listing of addresses from the zip codes
software, if purchased, for delivery and take-out in the restaurant's
area.

*Note: You can call 954.531.0471 for the options/prices of addresses.
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Delete all imports If used, this will delete all imported data.

*Note: This will not delete any custom data.

Delete all custom You have the option of adding custom addresses to the address
section (see below for more information). If you decide you would
like to delete only the custom addresses you have plugged in, use
this option.

*Note: This will not delete any imported data.

Filter Data This lets you list data by different parts of the addresses,
alphabetically or logically. (See below for more detail.)

Locate Data This enables you to search the data using different search criteria.
(See below for more detail.)

- Filter Data -
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Fields You have the option of selecting what field, listed within the All tab,
you would like to search. 

*Note: The selection highlighted in blue is what will be searched.

The Searched tab tells you what fields you have already searched.

By Value The By Value tab is shown in the top screen above this chart.

In this mode you type in what you are looking for in the Field Value
section and select the Search Type you would like to use

If you are in the search will search for values listed between the
ranges you have specified.

By Range The By Range tab is shown in the bottom screen above this chart. 

This mode enables a search for values listed between the Starting
Range and Ending Range ranges you have specified.
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Search Type Exact Match: Searches for exactly what you have typed in.

Example: If you type in Smith it will search only for Smith.

Partial Match at Beginning: searches only for the
letters/numbers you have typed at the beginning of the word

Example: If you type in 123 it will search only for items beginning with
123 (it could find 12345 and 12321 but not 51234 or 11233). If you type
in sm it will search only for items beginning with sm (it could find Smith
but not Blacksmith).

Partial Match Anywhere: Searches anywhere in the
words/numbers for what you have typed in.

Example: If you type in 123 or sm it will search for items that contain
123 or  sm anywhere in the sequence (it could find 12345 and 54123; it
could find Smith and Blacksmith).

Field Order This option lets you search the database alphabetically or logically.

Alphabetically: Arranges the searchable options in the Fields area
in alphabetical order (Address, City, Company, etc.).

Logically: Arranges the searchable options in the Fields area in a
format that  follows the order in which address components would
normally appear (Address, City, State, Zip Code, etc.).

View Summary Shows the search results in a separate window based on what you
have told it to search for.

OK Clicking OK will change the customer list you see on the Auto
Completion screen to  show only what you have input into the
search fields.

*Note: If you would like to see your entire address
database again,  make sure all search fields are blank
(you can do this by using theClear buttons or clicking
on New Search). Then, with all input fields blank, click
OK. This will bring up the entire address database in
alphabetical order.
 

New Search This will clear search criteria you've entered so you can start over
fresh.

- Locate Data -
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Field Value This is where you type in the name, partial name, word, etc.
that you are looking for.

Search Type The same concept as listed previously in the Filter Data chart.

Exact Match: Searches for exactly what you have typed in.

Example: If you type in Smith it will search only for Smith.

Partial Match at Beginning: searches only for the
letters/numbers you have typed at the beginning of the word

Example: If you type in 123 it will search only for items beginning
with 123 (it could find 12345 and 12321 but not 51234 or 11233). If
you type in sm it will search only for items beginning with sm (it could
find Smith but not Blacksmith).

Partial Match Anywhere: Searches anywhere in the
words/numbers for what you have typed in.

Example: If you type in 123 or sm it will search for items that
contain 123 or  sm anywhere in the sequence (it could find 12345 and
54123; it could find Smith and Blacksmith).

Fields Select what field you would like searched from the drop-down
list.

First On the customer list, this will place an arrow next to the first
item that matches the search criteria you have specified.

If you have already clicked next a couple of times, clicking First
again will bring you back to that first item.
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Next On the customer list, this will move the arrow to the next item
that matches the search criteria you have specified (the next
one after whatever is currently selected or displaying an arrow).

*Note: When you click Next, the Locate Data box will close. If
you reopen the Locate Data box, your search criteria will still be
there, meaning you can still click Next to navigate to the next
item that matches that criteria.
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10.2.2 First Name Custom Completion Tab

Under the General section click on Customers. Select the Auto
Completion tab. Select the First Name Custom Completion tab.

First Name Custom Completion

The First Name Custom Completion area is the same concept as the Address Custom Completion
area except it only uses first names for imported or added customer data. Within the Filter Data
and Locate Data options, the only difference is that you would only have the First Name as an
option field to search within.

How to use these options was covered previously (see Address Custom Completion Tab).

Example: Visual of Filter Data; as you can see, the only searchable field is "First Name."
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10.3 Filter Customer List Tab

Under the General section click on Customers. Select the Filter Customer
List tab.

Filter Customer List

- Filters -

Show all Shows all the customers in the database in alphabetical order.

*Note: If you have previously filtered the list, click this and then
press Activate Filter if you would like the database to go back to
showing all the customers.

Show all loyalty
awaiting customer input

Searches customer database for loyalty accounts that have
been created but have not had the rest of the customer
information entered yet (such as name, address, etc.).

Birthday Searches the customers based on their birthday month. Use
the drop-down list to select the number corresponding with the
month you would like to search for.

*Note: You must have birth dates entered for the customers to
get any results from this filter.
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Anniversary Searches the customers based on their anniversary month. Use
the drop-down list to select the number corresponding with the
month you would like to search for.

*Note: You must have anniversaries entered for the customers to
get any results from this filter.

Last visited Searches for customers whose last visit falls in between the
dates you specify using the drop-down calendars.

New Customers Searches for new customers you added between the dates you
specify using the drop-down calendars.

# Visits Filters the data by the number of visits the customers have
had. When you specify a range, the lowest number has to
come first.

Example: You can enter "1 to 99," but if you enter "99 to 1" no
customers will show up.

*Note: This section only works if you have visits as an available
option for the customers to acquire under the Loyalty section of

Back Office (see Loyalty->Visit Setup). 

# Points Filters the data by the number of points the customers have
accrued. When you specify a range, the lowest number has to
come first.

Example: You can enter "1 to 99," but if you enter "99 to 1" no
customers will show up.

 
*Note: This section only works if you have points as an available
option for the customers to acquire under the Loyalty section of
Back Office (see Loyalty->Point Setup).

Favorite Items Filters the customers by the item specified in the drop down
menu.

*Note: If you know the name of the item you would like to
search by you can type it into the field, but if the item has not as
of yet had any customers tied to it, the search will be ineffective.

Instead of selecting an item that appears on the drop-down list,
you can type it, but the spelling must be the same. Beginning to
type an item can also help you select that item from the
drop-down list more quickly.

Activate Filter Once you have selected how you would like the customer
database filtered, click Activate Filter to have the data sorted.

Click the Customer List tab to view the filtered data.
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*Note: For those filters that require you to fill in something (a date, number range, etc.), don't forget also to click
the circle to the left of that filter name before pushing 
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10.4 Customer List Tab

Under the General section click Customers. Select the  Customer List tab.

Customer List

You can search the customer list by first and/or last name and by card/loyalty #. you can also
find the customer by barcode if you have assigned a tag with a barcode on it to the customer.

*Note: The black arrow points to the customer currently selected; if you need to select a different customer
you would just click on their name to highlight that customer as your selection.

Customer Tab This will bring up customer detail. In this section you must fill out the
First Name and Last Name fields. The other fields are optional.

*Note: The Customer Card # is usually a field filled out for a customer having
a loyalty card or member card assigned to them. If you are creating a
customer for take out or delivery, they do not need a card # so this option
does not have to be filled out.  

Addresses Tab This information is necessary for when the customer is having food
delivered to them.  If the customer is just ordering takeout, this area will
probably not be filled out.

Phone
Numbers 

These are the customer's main contact number(s).  

Notes If you have any special notes you would like to add about the customer
this is the section to add them to.  When you assign the customer to a
delivery or takeout order, the notes you enter here will pop up in the
upper left corner of SoftTouch for a few seconds.  This is good for putting
things like "Doesn't like cheese."
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- Loyalty/VIP Tab -

The Loyalty Detail and Overall Totals section will automatically list what the customer currently has for all
items applicable, as will the Favorite Items section.

 Options/VIP section

Disable Loyalty If you check this option on for the customer selected in the list, they will no
longer be able to receive loyalty points and/or visits.

Auto Discount Within this section you select a discount to be applied automatically to this
customer's checks. The discount must be listed in the Adjustments section to
show up as an option here.

*Note: To understand adjustments right now see Financial Section->Adjustments.
You can set up any adjustments you would like specifically for the auto discount
section.

Clear all Loyalty Clears all accumulated customer loyalty points and/or visits for the currently
selected customer.

Clear all loyalty
visits

Clears all accumulated customer loyalty visits for the currently selected
customer.

Clear all loyalty
points

Clears all accumulated customer loyalty points for the currently selected
customer.
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Part 11 Scheduling

Under the General section click on Schedules to open Schedules Setup
screen.

Scheduling

Scheduling Setup  includes the following:

1. System Schedules

2. Employee Schedule Setup

3. Employee Scheduling

4. Job Scheduling
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11.1 System Schedules Tab

Under the General section click on Schedules. Select the System
Schedules tab.

Schedules

In the Schedule Section is where you would set up the schedules for the menus to follow and for
the employees to follow.

*IMPORTANT!*

12:00 am rule: 

Before we set up schedules we must first understand the following concept. Restaurants set their
operation date from beginning to close. Their operation date may start at 11:00 am and end at
2:00 am. Restaurants want all sales during this time period to report for this business day. 

In the real world however, the next day really starts at 12:00 am. In other words, Monday
switches to Tuesday at 12:00 am (midnight) in the real world. Schedules follow the real world. 

Therefore when programming schedules one must realize that if a restaurant wants to schedule a
time for 9:00 pm to 2:00 am we must observe the 12:00 am rule that the real world recognizes
from 12:00 am to 2:00 am as the next day even though the restaurant does not.

In other words, to add Monday 9:00 pm to 2:00 am to your schedule, you need to add both
Monday 9:00 pm to 11:59pm and Tuesday 12:00 am to 2:00 am.

System Scheduling  includes the following:

1. Add Schedule

2. Copy Schedule Records
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11.1.1 Add Schedule

Under the General section click on Schedules. Select the System
Schedules tab.

- Add Schedule -

Here you create all your schedules and give a name to each schedule, start and end dates, days
of the week and start and end times.

Schedules are times that the menu items and menus themselves will actually be available for sale
at a restaurant. Schedules can be for Happy Hour, Item Specials that are only available
Wednesday Night between the hours of 7pm to 9pm for example. Schedules may also be used for
when Lunch and Dinner menus begin and end.

- To Add the Schedules -

Step 1. 

First you should always add an all day schedule by clicking on the Add All Day Schedule button. 
The days of the week will be automatically added in from Sunday to Saturday from 12:00am to
11:59pm. All your priced items whether Food or Liquor will be assigned to the All Day schedule by
default if the don't have any specific schedule assigned to them. This will allow their prices to be
available all operation day long.

Step 2.

Click on the  button in the Schedules part of the screen. This will bring up a blank space to
put the name into. Name the schedule. If you would like to have this schedule be used, make

sure the active option is checked on. Click the  button when you are done.
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Step 3. 

Under the Schedule Day/Times there will be a blank area for the schedules. Click on the drop
down menu for Day of the Week and select what day you would like the week to start on for the
restaurant.

*Note: As shown in the example image above, once you choose the day of the week you would like, the
Start Time and End Time are automatically filled in to be 12:00am for the start time and 11:59pm for the
end time.

Step 4. 

To add more days to the schedule keep clicking the   button in Schedule Day/Times part
of the screen. You can list any variety of days you would like.

Example: Adding a Happy Hour Schedule: To add a happy hour schedule from Monday - Thursday from
4pm to 7pm you would just add the schedule Happy Hour and create Monday - Thursday as the days of
the week and put the start times on all to 4pm and the end times to 7pm.

 

Step 5. 

As noted, by default the schedule is always from 12am start time to 11:59 end time. You can
change this by clicking within the start time area and typing in what you would like the start time
to do and then do the same for the end time area. 

- Adding Schedules for a restaurant open past midnight -

To Add: Say you have a restaurant that runs from 10:00 am to 2:00 am. If a particular schedule
goes past Midnight, then you must stop the time at 11:59 pm on each day and create a new start
time for the next day at 12:00 am to whatever am time you want it to stop (for example 2am).

*Note: This means you will be using Sunday from 10am to 11:59pm and then the real world Tuesday
from 12am to 2am in Monday's operation day schedule.

This is and example of what the set up would look like:
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*Note: See above image:

The Sunday schedule goes from 10:00am to 2:00am. In order to achieve this, a Sunday was added that
goes from 10:00am to 11:59pm. Then a schedule is added below that is for Monday that goes from
12:00am to 2:00am. A note was placed next to it to show that the Monday schedule from 12am to 2am is
really part of Sunday's schedule. This note is not necessary, but is useful to remind someone of how the
schedule is set up.

11.1.2 Copy Schedule Records

Under the General section click on Schedules. Select the System
Schedules tab.

- Copy Schedule Days/Times -

To copy one or more records press and hold Ctrl key on your keyboard and click the grid on the
left of the day(s) you wish to copy (this way you specify that this is the record to be coped). See
image:

 

 - Currently selected record
 

 - Record to be copied
 

 - Multiple selected records

After you have selected records you wish to copy click the "Copy Records" button under Schedule
Day/Times. See image below:
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Then in the Schedules part of the screen highlight the schedule name you wish to copy the
selected records to and click "Paste Records" button under Schedule Day/Times. See image:

 

Tip: You can copy multiple items at one time by holding down the CTRL key as you select them.
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11.2 Employee Schedule Setup Tab

Under the General section click on Scheduling.  Select the Employee
Schedule Setup tab.

Employee Schedule Setup

Here you specify how you want your employee schedule to be set up.

Week starts on: 

Select the start day of the week you prefer from the drop-down menu. 

*Note: Most restaurants prefer to start their day on Sunday.

Employee weekly max total hours: 

Specify the maximum total hours a week for your employees. 
If an employee reaches their maximum weekly hours, a warning dialog will be displayed to notify them.
0 value disables the warning and no maximum weekly hours are set.

- Schedule Intervals -

30 Min If this option is selected, the time grid in the employee scheduling
has 30 minutes appended to each hour.

Example:
1:00 PM
1:30 PM
2:00 PM
2:30 PM
3:00 PM
3:30 PM etc.

*Note: this setting takes up more screen space.
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60 Min If this option is selected, the time grid in the employee scheduling
increases by 1 hour.

Example:
1:00 PM
2:00 PM
3:00 PM etc.

**WARNING**

Once you have employee schedule times all set in the BackOffice and you later decide to change
schedule intervals, your times will be affected; the system will round your times to the closest
minute interval selected.
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11.3 Employee Scheduling Tab

Under the General section click on Scheduling.  Select the Employee
Scheduling tab.

 Employee Scheduling

In the Employee Scheduling you see a grid of the week with dates and times. Dates at the top
and times on the left side.

Step 1. Click on Select Employee button at the top 

They are grouped by job or name (you can switch between the groupings by pressing the buttons
at the top); click the plus signs to show all employees in the group.
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Step 2. Select an employee whom you are creating this schedule for and click Ok.
*Note: Only Employees who have scheduling enabled will show up in the list of employees to
choose from.  To enable an employee to be scheduled, go to the Employees area in BackOffice,
select an employee, then go to the Scheduling tab for that employee. Put a check mark in the
"Scheduling Enabled" option.

- Add Schedule Item -

Step 1.  Click the + sign button at the top left to add a schedule item.

Step 2.  Next you fill out fields in the Schedule Entry screen that shows up
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Employee You've already selected which employee you are creating this
schedule for by clicking the Select Employee button, so this
employee's name is displayed here.

Job Employee may have more than one job assigned to them so
make sure to specify from the drop-down menu which of their
jobs this schedule is for.

Description Enter a description of the schedule for an easy reference
later. (Optional.)

Start Time Specify the start date and time of the schedule.

End Time Specify the end date and time of the schedule.

Schedule Type Select whether it is a work time or an off time.

Weekly recurring
schedule

If this option is checked the schedule will repeat weekly. You
don't have to manually copy and paste the same schedule
from one week to the other ones.  This is good if you know a
certain employee can never work on Tuesdays, for example.
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You can also create schedules by clicking and dragging the mouse on the grid from the start time
to the end time under the specific date column.

Example: Let's say you've decided to create a schedule for an employee on 11/15/2004 from 9:00 AM
to 5:00 PM.

Step 1.

Under the selected date column (11/15/2004) you left click and hold with your mouse the
field/cell on the selected start time (9:00 AM) and drag the mouse down until you reach the
selected end time (5:00 PM). You see the fields from 9:00 AM to 5:00 PM get highlighted
according to your dragging selection.

2. Now right click with your mouse in that highlighted area.

3. Next you fill out fields in the Schedule Entry screen that shows up. Since you already
automatically specified date, start and end times of the employee schedule while dragging the
mouse through the time fields, you will only need to fill out Job, Description (optional) and
Schedule Type fields, and if applicable the Weekly recurring schedule checkbox. Refer back to 
Add Schedule above for a detailed description of each option.
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*Note: If a down pointing arrow shows up in the schedule box it means that the schedule extends from
one day to the next (example: from 11/15/2004 at 8:00 PM to 11/16/2004 at 3:00 AM).



Version 6.1.16

146

11.4 Job Scheduling Tab

Under the General section click on Scheduling.  Select the Job Scheduling
tab.

Job Scheduling

Job Scheduling has the same concept as the Employee Scheduling and works exactly the same
when creating a schedule by the job. But instead of the Select Employee button at the top we
have a Filter Job(s) button, and the grid is a little different.

- Filter Jobs Button -

Clicking the Filter Job(s) button allows you to select only those jobs you wish to create schedules
for and/or view schedules of. In other words, only the jobs you select are displayed in the grid.

- The Grid -

Both the dates and the times are at the top of the grid. The time is displayed from AM (left) to PM
(right).
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Part 12 Item Builder

Under the General section click on Item Builder to open the Menu Builder
screen.

Item Builder

Item Builder includes the following::

1. Departments

2. Menu & Rule Builder

3. Smart Rules

4. Menu Categories

5. Item Maintenance
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12.1 Departments

Under the General  section click on Item Builder. Select the Departments
tab.

Departments includes the following:

1. Departments
 

2. Copying Items
 

3. Deleting Items
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12.1.1 About Departments

Under the General  section click on Item Builder. Select the Departments
tab to open the Departments Setup screen.

Departments:

You always need to create a Super Department first that will hold your Department(s), which
will then hold the Families.

Example: tree view structure of the Departments is illustrated below to help you.

- Super Departments -

Step 1. 

To create a Super Department click on the  sign located within the same line as the name
Super Department and type in the name you would like to give the Super Department. There are
usually three to four category names added to this section, but (as shown in the example above)
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you can have as many categories as you would like.

Example:

The main categories usually used for Super Departments are:

1. Food (food)
2. Beverages (non-alcoholic drinks)
3. Liquor (alcohol items; beer, wine, etc.)
4. Merchandise (t-shirts, mugs, etc.)

The name of the Super Department is what will be displayed on-screen in the check display area
of SoftTouch.

Example: (see image below):

 

*Note: These Super Departments allow you to give discounts to certain categories without
affecting the other categories

Example: A discount on all food items that won't give a discount to liquor and merchandise
as well.

(See Financial->Adjustments for more information about setting up discounts.)

Step 2.

Super Departments must have a Type assigned to them. There are only three types: Food,
Beverage, and Merchandise. Use the drop down under Type to select the correct type.

*Note:  Assigning "Beverage" as the type will allow it to be used for the POS button named Reorder
1st order, which allows a server to order a second, third, or fourth round of drinks that's the same as
the first without also reordering, say, an order of chicken wings they ordered with it (discussed in the
SoftTouch POS manual).

You can also customize your remote printer tickets based off the Type assigned to a Super

Department. (For more information on setting up printing, see Printers/Coursing.)

Step 3. 

Click the   button to save it. To delete a Super Department click the  button.

*Note: Once a super department has sales history tied to it through the family and department, it
cannot be deleted.

- Departments -

Departments' categories are needed by accountants and/or bookkeepers for report purposes. 
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Step 1. 

The Departments are linked to the Super Departments. To add a Department, make sure you
have the correct Super Department highlighted before you begin.

Step 2.

Once you are ready to add a Department, click the  button to add it, and type a name
under Name.

You can have as many Departments as you would like listed under the Super Department
highlighted and/or you can name your Department with the same name you used for your Super
Department.

Examples:

The super department of Beer could have a department named Beer.

The super department of Merchandise could have Retail and Rentals as the departments.

Step 3.

Click the   button to save it. To delete a Department  click the  button.

*Note: Once a Department has sales history tied to it through the family, you cannot delete the
Department.

- Families -

Every item in the menu must be tied to a family for report purposes. Here we will create families;
information about tying individual items to families will be given under Menu Builder
Tab->Items->Assign Family....
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Step 1. 

Families are linked to departments, which are linked to super departments. Make sure you have
the correct super department and department selected.

Step 2.

Once you are ready to add a family, click the  to add it, and type in the name under Family
name. 

Typical Families might include Appetizers, Entrees, and Deserts if you're in the food department,
or Vodka, Gin, Rum, Red Wine, and White Wine if you're in the liquor department.

Step 3.



Version 6.1.16

155

Each Family has several options; see below for descriptions:

Real Time Pricing The Drop Down menu gives you two options:

 1. Real Time Pricing: SoftTouch overrides the price according to
the schedule and system's current time. 

Example:
4:00pm-7:00pm Budweiser is $1.50
7:00pm-12:00am Budweiser is $3.00

So if Sam orders a Budweiser at 5:00pm he pays $1.50. Then if he re-orders
it 6:00pm he still pays $1.50, but if he orders it again at 8:00pm he has to
pay $3.00

*Note:This is useful for re-ordering when you have schedules setup (we will
talk about schedules later or you can learn about them now by going under 
General section->Scheduling.)

 2. No Real Time Pricing: If the Family is set with No Real Time
Pricing, SoftTouch will not override the price depending on current
time.

Example:
Early Bird price is available for any check opened under Early Bird schedule
until the check is cashed out.

**IMPORTANT**

 

Liquor should always be under Real Time Pricing. Food
should be under No Real Time Pricing.

Type The drop down menu lets you assign a type to the family from one of
four options:

1. Beverages
2. Appetizers
3. Entrees
4. Desserts

There is a "Switch View" button in SoftTouch which enables you to
see what course each table is currently on.  In order for this to work,
you MUST assign a type to each family.

*Note: If a family doesn't exactly match one of the 4 types, you can
leave this field empty for that family.

**IMPORTANT**

 

All drinks must have "Beverage" set as the Type for
both the Super Department and the Family in order for
them to work with the Reorder 1st Order button (orders
a second, third, or fourth round of drinks that's the
same as the first) and the Beverage Count to Seat Count
feature.

 

Disable Loyalty
Points

If there are certain Families that should not be included in Loyalty
calculations, such as Liquor or other alcoholic beverages, then put a
check mark in the box for "Disable Loyalty Points" for that particular
family.

Serving Minutes Used in conjunction with the "Is food served" alert in the pager and
alerts system. The "Is Food Served" alert must have the "Use family
serving times" option enabled. (See more information about setting up
pagers and alerts under Hardware->Pager/Alerts.)

Example: If you put in 20 minutes for the Serving Minutes on the Pizza
family, and the "Is food served" alert is active with the "use family serving
times" enabled, then an alert will be sent to the server's or manager's pager
if the food hasn't been served 20 minutes from when it was added to the
check. 

*Note: A barcode scanner must be set up in the kitchen which will scan a
barcode on the ticket which will in turn send a page to the server to tell
them to pick up the food.  Once the server picks up the food, they can scan
a second barcode on the ticket to mark the food as served.

Upsell If this is checked, the family will be shown in the Upsell display. The
Upsell display is shown by manually clicking the "Upsell Display"
button while taking an order in SoftTouch.

*Note: The Upsell display can be displayed automatically when
sending a check. To enable this, go to the Stations area in BackOffice
(under Hardware) and then to the Options tab. With the correct
station selected, put a check mark in the "Display Upsells" option
box. The SoftTouch POS manual explains how to have it displayed
manually.

Disable VAT If this option is checked, if any item from this family is added to a
check in any mode (Bar, Dining, Delivery, etc.), the VAT will be
automatically disabled for all items on the check.

Example: Some states allow you to use VAT on liquor items in the bar, but
as soon as food is added to the check, then the whole check must use
regular add-on tax.  In this scenario, you would put a check mark in the
"Disable VAT" option for all the food families, and leave it unchecked on all
the liquor families.



Version 6.1.16

156

Type The drop down menu lets you assign a type to the family from one of
four options:

1. Beverages
2. Appetizers
3. Entrees
4. Desserts

There is a "Switch View" button in SoftTouch which enables you to
see what course each table is currently on.  In order for this to work,
you MUST assign a type to each family.

*Note: If a family doesn't exactly match one of the 4 types, you can
leave this field empty for that family.

**IMPORTANT**

 

All drinks must have "Beverage" set as the Type for
both the Super Department and the Family in order for
them to work with the Reorder 1st Order button (orders
a second, third, or fourth round of drinks that's the
same as the first) and the Beverage Count to Seat Count
feature.

 

Disable Loyalty
Points

If there are certain Families that should not be included in Loyalty
calculations, such as Liquor or other alcoholic beverages, then put a
check mark in the box for "Disable Loyalty Points" for that particular
family.

Serving Minutes Used in conjunction with the "Is food served" alert in the pager and
alerts system. The "Is Food Served" alert must have the "Use family
serving times" option enabled. (See more information about setting up
pagers and alerts under Hardware->Pager/Alerts.)

Example: If you put in 20 minutes for the Serving Minutes on the Pizza
family, and the "Is food served" alert is active with the "use family serving
times" enabled, then an alert will be sent to the server's or manager's pager
if the food hasn't been served 20 minutes from when it was added to the
check. 

*Note: A barcode scanner must be set up in the kitchen which will scan a
barcode on the ticket which will in turn send a page to the server to tell
them to pick up the food.  Once the server picks up the food, they can scan
a second barcode on the ticket to mark the food as served.

Upsell If this is checked, the family will be shown in the Upsell display. The
Upsell display is shown by manually clicking the "Upsell Display"
button while taking an order in SoftTouch.

*Note: The Upsell display can be displayed automatically when
sending a check. To enable this, go to the Stations area in BackOffice
(under Hardware) and then to the Options tab. With the correct
station selected, put a check mark in the "Display Upsells" option
box. The SoftTouch POS manual explains how to have it displayed
manually.
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Disable VAT If this option is checked, if any item from this family is added to a
check in any mode (Bar, Dining, Delivery, etc.), the VAT will be
automatically disabled for all items on the check.

Example: Some states allow you to use VAT on liquor items in the bar, but
as soon as food is added to the check, then the whole check must use
regular add-on tax.  In this scenario, you would put a check mark in the
"Disable VAT" option for all the food families, and leave it unchecked on all
the liquor families.

Step 4.

Click the   button to save it. To delete a family  click the  button.

*Note: Once a family has sales history tied to it, you cannot delete the family.

*Note: If you later decide to change the name of a Super Department, Department, or Family just
highlight its name first by clicking on it and then type in the new name over the selection and save it.

12.1.2 Copying Items

Under the General  section click on Item Builder. Select the Departments
tab to open the Departments Setup screen.
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You can easily copy Family items between Departments or a Super Departments.

-Copy Item(s) -

To copy a Family item simply highlight it first and then click Copy Records button. See image
below:

Next, highlight the Super Department and then the Department where you want to place the
copied item to and click Paste Records button. See image:

Tip: You can copy multiple families at one time by holding down the CTRL key as you select the families.
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12.1.3 Deleting Departments

Under the General  section click on Item Builder. Select the Departments
tab to open the Departments Setup screen.

Delete Departments:

If you wish to delete a Super Department, Department or a Family highlight it first by clicking on

its name and then click the  sign in the appropriate section of the screen (Family, Department
or Super Department depending which one you want to delete). A confirmation dialog will show
up asking if you really want to delete item. Click yes. See image:

Explanation to what the action of each button is. 
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12.2 Menu Builder Tab

Under the General section click on Item Builder. Select Menu & Rule
Builder tab.

Menu & Rule Builder Tab

Before you start building items and menus you must first setup:
 

1. Printers

Note: Instructions for setting up the printer hardware is in the Complete Setup Guide. But click the
link above for instructions on setting up printers in BackOffice.

2. Tax Table

3. Departments

The Menu Builder explanation includes the following:

1. Command Bar

2. Modifiers

· About Modifiers

· Create Modifiers

· Rename Modifiers

· Assign Family to Modifiers

· Attach Price to Modifiers

· Customize the Button of Modifiers

· Duplicate Modifier Groups

3. Links

· Create Links

· Rename Links

· Adding Modifiers to Modifiers

· Link Modifier to Modifier

4. Items

· Create Menu Items

· Rename Menu Items

· Assign Family, Attach Price, Customize Button, Assign Adjustments
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· Special Pricing

· Add Modifiers to Items

· Set Properties and Organize

· Copy Modifiers from Item to Item

· Duplicate Item Groups

5. Sizing the Grid

6. Making Menus from Item Groups

7. Main Menus
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12.2.1 Command Bar

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Listed in this section is the Command Bar.

Command Bar

The Command Bar is the group of options listed at the top of the Menu Builder Tab.

- Above Buttons Explained - Left to Right -

These are in order from left to right. In BackOffice you can also see the names of the buttons by holding
your mouse cursor over them without clicking (the name will appear after a moment).

Expand All Nodes If you are in Modifiers, Items, or Links, clicking on this will expand
all the groups.

Collapse All Nodes If you are in Modifiers, Items, or Links, clicking on this will collapse
all the items so all you will see is the top group in the hierarchy.

Add a Modifier
Group

1. Within the Modifier section, click on the Modifier Builder, and
now you can click this button to add a new Modifier group. Once
you have named the modifier group you then have the option to
start building modifiers under the group. You can immediately add
a price to the modifier in this section. When you are done adding
modifiers click the cancel button.

2. If you are within the Items or Links tabs you can use this button
to add a modifier group you've already created to an item, item
group, or linke group.

*Note: This is explained in further detail here.
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Add an Item
Group

1. Within the Items section, click on the Item Builder, and now you
can click this button to add a new Item group. Once you have
named the item group you then have the option to start building
items for the group. Under the item group builder you have the
options to either create new items or you can select existing items
that are currently under another item group to copy properties
from. 

2. If you are copying the properties of another item, you have the
option of copying not just the item but also the item's modifiers
and/or links by checking on the "Yes copy modifiers and Links"
option at the bottom of the pop up window. You must type in an
item name for this to work.

3. Within the Links section, you can add Item groups to Link
groups. Link groups can also have individual items added to them.

*Note: This is explained in further detail here.

Add a Link Group 1. If you have selected the Link Builder within the Links section,
you can click this button to add a new Link group. After you have
added the Link group, you can add modifier groups, item groups, or
even other link groups.

2. You can create a new item or new modifier under the Link group.

*Note: This is explained in further detail here.

Add an Item 1. You can add an item to an Item Group within the Item Builder or
to Link groups within the Link Builder.

2. You can create an item and then tie a link group, item group,
and/or a modifier group to that item to use as modifiers.

3. You cannot add an item to a modifier group.

*Note: This is explained in further detail here.

Add a Modifier 1. You can add a Modifier to a modifier group, item group, or link
group.

2. You can copy an existing modifier under an item, item group,
and/or link group.

3. You cannot add a modifier to a modifier.
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Open node from
Disk

This option lets you import a pre-saved Menu into the system. 

In order to load a menu the sales history has to be cleared. 

Note:  The menu must be placed saved within the C drive - either in the
Softtouch folder, in it's own folder, or on the C drive with its own folder.
You cannot place the menu on the desktop or within the My Documents
folders and upload it. The menu must be a zipped file in order for it to
load.

**Warning**: The Menu you load has to be on the same version of
SoftTouch that your system is on. 

Save Node do Disk Saves the entire menu to disk. You can specify where you would
like the menu to be saved and give it any name you would like.

Cut Node(s) Lets you select a group or node within a group and cut the node
and/or group. If you cut a Group node everything listed under will
also be cut and remain tied to the group node. If you cut just a
node anything tied to the node (such as an item) will remain tied to
the node.

Example:  Works like cut and paste.  You can use this to cut the
ketchup modifier from the "Burger mods" group and paste it to the
"French fry mods" group.

Copy Node(s) Lets you select a group or node in a group and copy the node or
group. If you copy a Group or a node anything listed under it will
be preserved.

Paste Nodes 1. Lets you paste a node you have copied and/or cut. This will
paste everything tied under the node as well. 

2. If you have only selected one node to be pasted you will be
asked Do you wish to add a new item from this copy? You can
choose Yes, No, or Cancel.  If you choose yes, nothing will be tied
to the new node - no family, no price, no print groups, etc. If you
choose no, everything will be tied - printers, taxes, prices, all the
names you gave the buttons, printing, etc.  In essence, choosing
No will create a copy of the same item into another group, so the
same item is now in two places.



Version 6.1.16

165

Duplicate Selected
Items

Select a Modifier Group, Item Group, or Link Group. Choose the
Duplicate Selected Items option. The below image is what you will
see.

1. Item/Modifier Name: You can choose this option to replace any
modifier name you have with another name. This is used
subsequently with the either the Button Text, Print Name, Receipt
name, or the node's Name.

Example: Very useful for pizza mods.  You can duplicate the Small Pizza
Mods and Replace the word "Small" with "Large."  All new modifiers will be
created in the new group, but they will have the same names as they did
in the original group.

2. Button Text: Can be used in conjunction with the Replace option
listed under Item/Modifier Name area to Replace the button text
with a different name. 

3. Print Name: The name that will print on the kitchen remote
printers.

4. Receipt Name: This will be what prints out on the check and
receipt for the guest. 

5. New Name: You can rename the group a different name if you
don't want to just replace aspects of the name.

6. Copy prices, tax, or printers area: If you check any of these on
you can copy the prices, the tax, and or the printers assigned to
the items, modifiers, etc. listed within the group you are
duplicating. 

*Note: Uncheck any of the prices, tax, or printers area and nothing will be
copied to the new group.
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Node Updater You can use the node updater on several modifier or item nodes
you have selected or just one.  

Tip: You can select multiple items or modifiers using the SHIFT or CTRL
keys as you click on the items (within one group at a time, not across
multiple groups).  You can also simply select a group to update all the
items or modifiers within it.

*Note: If you are changing the price on different nodes just make sure the
nodes you have selected are the ones you want to be on the price you are
changing it to unless you are just adding a new price and leaving the price
that already exists.

Step 1: Lets you choose how you want to update the node you
have selected. There are there options in the drop down section
that are user friendly and self-explanatory.

Step 2: Choose the area(s) of the node you would like the update
to affect by placing a check mark in the blank box(es).

Step 3: Set the changes you would like to make. Note that
additional options are displayed across the different tabs. Changes
will only affect the categories you selected in step 2.
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Rename Node Lets you rename a group or a node within a group. 

*Note: If you rename an Item or Modifier that is located in multiple
groups, the name will change in all places.

Sort Node Sorts the nodes you have selected alphabetically from A to Z.

Find...
If you cannot find a node or item you can select this button and
typing in what you think the node has in its name (anywhere in its
name) to search for it.

Find Next... If you have used the "find" option you can then use this option to
keep searching through the finds for the sub-string you have
searched. It will continue to highlight items until it cannot find
anymore matches, at which  time you will get a message saying
"search string: sub not found."

Delete Node Deletes highlighted items, modifiers, links, or groups (nodes).

*Note: If you delete a modifier group, you must also remember to delete
it from any items it may be attached to.  

Clear all Menus This will clear the entire menu. This means the menu will be gone,
completely gone. No menu, no menu tied to a station, no
Items/Stock anymore. Nothing.

**Warning**: Do not use this unless absolutely necessary.  The only
time this should be used is if you need to re-program an entirely new
menu with all different items.

Copy all Items into
this Link Node

Copies all items into highlighted link groups.

*Note: Used only for Online menu creation. Do not use for other
purposes.

Move Node Up Lets you move the selected node up one.

Works when you have selected a modifier, an item, a modifier
group, an item group or a link group underneath the Modifier
Builder, Item Builder, or Link Builder.

*Note: If you right click on the item this option is also listed.

Move Node Down Lets you move the selected node down one.

Works when you have selected a modifier, an item, a modifier
group, an item group or a link group underneath the Modifier
Builder, Item Builder, or Link Builder.

*Note: If you right click on the item this option is also listed.
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Move Node to Top
of List

Lets you move the selected node to the top of the list.

Works when you have selected a modifier, an item, a modifier
group, an item group or a link group underneath the Modifier
Builder, Item Builder, or Link Builder.

*Note: If you right click on the item this option is also listed.

Move Node to
Bottom of List

Lets you move the selected node to the bottom of the list.

Works when you have selected a modifier, an item, a modifier
group, an item group or a link group underneath the Modifier
Builder, Item Builder, or Link Builder.

*Note: If you right click on the item this option is also listed.

Spell Check Word must be installed on the computer in order to use this spell
check feature because it uses Word's spell check engine.

**Warning**: Do not try to use this option unless you have Word
installed on the machine.

Set Default Button
Color Scheme

This option will set the color for the node(s) you have selected to
the default blue color used for SoftTouch.

Copy Button Color
Scheme

1. You can select a Modifier, Modifier Group, Item, Item Group, or
Link Group (basically anything in the menu) and copy the color
scheme of the object you have selected.

Example: If I select a Modifier Group and copy its color scheme that I
then paste the button color scheme onto another Modifier Group, nothing
within the group's color schemes will be affected, only the group node. 

2. If you have selected an item or modifier node that you pasted
under a different area as a copy of the and you choose to not add a
new item/modifier from the copy and you go to change the button
colors on one of the items, the other item will not be affected.

Example: Select the Coke item under Beverages in the Items section and
change the color to red. Copy the Coke item and paste it into any link
group. Go back to the original coke item listed in the beverages item
group and change the color to green. Now look at the color scheme of the
coke item under the link group, you will see it stays red.

*Note: It will only copy the color scheme for the actual node selected and
if you have pictures placed on the node's button that you are copying, the
pictures will not be copied with the color scheme to the other node; you
would have to load the picture separately.
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Paste Button Color
Scheme

You can paste a color scheme you have copied from any node or
node's group onto any other node or node group. It will only affect
the node you have selected. 

*Note: See "Copy Button Color Scheme" examples (above) for details.

800 Lets you see how the button configurations and colors will look on
an 800x600 screen resolution.

*Note: This is just for testing button colors, setup, display, etc. This does
not upload the menu with the proper buttons for you.

1024 Lets you see how the button configurations and colors will look on a
1024x768 screen resolution.

*Note: This is just for testing button colors, setup, display, etc. This does
not upload the menu with the proper buttons for you.

Update Stations Lets you do a menu update while you are live so you do not have to
restart all the POS stations. 

*Note: This only updates any menu changes you make. If you change any
other settings not in the Menu Builder section in SoftTouch you will want to
restart the POS for the changes to take effect.

12.2.2 Modifiers

Under the General section click on Item Builder.  Select the Menu & Rule
Builder tab. Select the Modifiers button.

- Modifiers -

Everything on the screen below is what is listed for a modifier group. The biggest thing to pay
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attention to on this screen that is different from Items and Links sections is the option to Skip in
Bar Mode. 

Skip in Bar Mode lets you create a modifier group for things such as liquor and have that
modifier group available for servers to select from but hides the modifier group from the
bartenders.

Modifiers  explanation includes the following:

1. About Modifiers 

2. Create Modifiers

3. Rename Modifiers

4. Assign Family to Modifiers

5. Attach Price to Modifiers

6. Customize the Button of Modifiers

7. Duplicate Modifier Groups
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12.2.2.1About Modifiers

Under the General section click on Item Builder.  Select the Menu & Rule
Builder tab. Select the Modifiers button.

About Modifiers 

Step 1. You must set up the modifiers first before you can build the actual menu items.

Step 2. Modifiers are everything that you can add to, remove from, or replace on your items - in
other words, everything you can customize your items with.

Examples: The temperature of a steak, the kind of dressing for the salad, the toppings on a
pizza, extra pickles and no mayonnaise are all modifiers.

Step 3. In the SoftTouch System there are two types of modifiers: automatic and manual.
 

Automatic modifier This is a group of options that automatically pops up when the
item is chosen in SoftTouch.

Example: When you choose a salad in SoftTouch a choice of
dressing  can pop up automatically.

Manual modifier These are choices that do not pop up automatically when an
item is chosen in SoftTouch. A Server needs to highlight the
item and press the Modify button in order for the modifiers to
show.

Example: Steak comes with Mushrooms and the customer requests
NO MUSHROOMS. A server would select the steak on a check in 
SoftTouch, press the button to bring up the modifiers and choose No
Mushrooms.
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- Examples of Modifiers -

NO Modifiers For when a customer wants to exclude something that comes
with the ordered item.

ADD Modifiers When a customer wants to add something that does not come
with the ordered item. ADD Modifiers can be set to have an
additional price on top of the item.

XTRA Modifiers When a customer wants more of something that already comes
with the ordered item. XTRA Modifiers can be set to have an
additional price on top of the item, but might be a lower price
than an ADD modifier since this already comes with the menu
item and we are just adding some more of it.

Example: extra cheese or extra dressing.

SUBSTITUTE
Modifiers

When a customer wants something else instead of what
already comes with the ordered item. If restaurant allows
substitutions of this type then here is where you would enter
it. This modifiers can be set to have an additional price.

Example: Customer wants a side salad instead of fries.

INSTRUCTION
Modifiers

When a customer makes a special request. 

Example: Ordered item includes sauce and a customer has
requested sauce be put on the side.  Other Instructions are Rush,
See Server, Do Not Make, etc. 

 

- Manual Modifiers may be set up in two different ways -

 

One way is to set up groups for all menu items (for example: Filet, NY Steak etc.) You would
then go through each menu item and add all the possible NO, ADD, XTRA, SUBSTITUTE and
INSTRUCTION modifiers for each individual item on the menu. If the item comes with tomatoes
for example, then you must add NO TOMATOES modifier for this item. If there are 10 other items
with tomatoes then you must add NO TOMATOES for each of those items. This way of creating
modifiers is tedious and hard to maintain. If you want to add another No Modifier, NO CHEESE for
example, to a couple of menu items you would have to go to each individual group of each item
to add it.

Another way is to set up general groups for NO, ADD, XTRA, SUBSTITUTE and INSTRUCTION
modifiers. You would then add all the possible No Modifiers for all items on the menu into the NO
group, all the possible Add Modifiers into the ADD group, all Xtra Modifiers into the XTRA group
etc. Those general groups would be tied to all the menu items and the Servers can pick the
modifiers they want out of these general groups.
There might appear, for example, a No Mushrooms modifier for a certain menu item that does not
have mushrooms to begin with, but the Server would simply not pick No Mushrooms for this item.
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This way of creating modifiers is far faster and easier to maintain. If you want to add another No
Modifier all you have to do is add it once into the general NO Modifier group and it will be
available to all the other items that may also use this No Modifier.

Always create groups for your modifiers. You will then add all the modifiers from the entire menu
into the appropriate groups.

- Few examples of Modifier Groups and Modifiers - 
 

Modifier Group Dressings Pasta Choice

Modifiers House
Creamy
Bleu Cheese
Ranch
Honey Mustard
French
Caesar etc.

Linguini
Spaghetti
Angel Hair
Rigatoni
Penne
Gnocchi etc.

Pizza Toppings Meat Temperatures Sauces

Pepperoni
Sausage
Mushroom
Green Peppers
Hot Peppers
Black Olives
Anchovies etc.

Rare
Medium Rare
Medium
Medium Well
Well

Tomato
Marinara
Mushroom Sauce
Meat Sauce
Marsala Sauce etc.

**Warning**: Modifiers (yellow) can never be used to modify modifiers. 

12.2.2.2Create Modifiers

Under the General section click on Item Builder.  Select the Menu & Rule
Builder tab. Select the Modifiers button.

-Create Modifiers-
 

Step 1. 

Click on the yellow button labeled Modifiers. See image below:

 

Step 2. 

Highlight the top category called Modifier Builder by clicking on it. See image:
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 Step 3. 

When Modifier Builder is highlighted click on the Add Modifier Group icon (yellow block with label
M) See image:

 

Step 4. 

A small window will pop up asking for a New Modifier Group Name. If you want to start setting up
No Modifiers enter No Modifiers as a name. We have just created a Modifier Group.  A dialog box
will appear that asks you if wish to start entering the names of the items that will fall in this
menu item group.  To add modifiers to a group right away, just enter the item name and price (if
applicable), then press the Create button at the bottom of the dialog box.  When you have
finished creating modifiers for this group, press the Cancel button at the bottom of the dialog box.

If you created the group and did not add modifiers to the group, or to add modifiers to an existing
group, highlight a modifier group by clicking on it. Then click on the Add Modifier icon (small
yellow M). See image:

 

Step 5. 

A window will pop up asking to enter a Modifier name. Enter No Tomato for example and press
Create. We have just created a Modifier. The window will stay up after you create each modifier.
You can continue adding more modifiers and click Create each time.  When you are finished
adding modifiers to the current modifier group, click the Cancel button.
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12.2.2.3Rename Modifiers

Under the General section click on Item Builder.  Select the Menu & Rule
Builder tab. Select the Modifiers button.

 - Rename Modifiers -
 

Step 1. Highlight either the Modifier Group or the Modifier that you wish to rename.
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 Step 2. Click on the Rename Node icon. (Or right-click and select Rename Node.)
 

Step 3. Enter new name and click OK.
 

Step 4. Change the button text to the same corresponding name. More information on
customizing buttons is provided shortly (see Customize the Button of Modifiers).
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12.2.2.4Assign Family to Modifiers

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Modifiers button.

- Assign Family to Modifiers -

After adding all the No Modifiers, you must double click the No Modifier Group or click the + sign
next to the No Modifier Group to expand it and you'll see all the modifiers you have just added.
You must now assign a family to each modifier that you have created. Remember you created
Families previously under Departments? For a reminder, see Item Builder->Departments.

Highlight the first "No Lettuce" modifier by clicking on it. On the right side of the screen, make
sure the Modifier tab at the bottom is selected and look at the fields under Modifier properties.
Click the drop-down menu in the Family field and all the families that you have previously created
will show up. Select the "Food Modifier" family. See image:

 *Note: You can assign a family to multiple nodes amongst other things using the "node updater" (refer
back to Item Builder->Command Bar).

Now the "No Lettuce" modifier is completed:



Version 6.1.16

178

 

*Note: The Print Name is what would be sent to the kitchen; the Receipt Name is what would print on
the check/receipt. You can name both whatever you want, or if you leave either of these fields blank then
the modifier or item name will print.

12.2.2.5Attach Price to Modifiers

Under the General section click on Item Builder.  Select the Menu & Rule
Builder tab. Select Modifiers button.

- Attach Price to Modifiers -

Some modifiers may have a price attached to them (usually some ADD, XTRA and SUBSTITUTE
modifiers).
Highlight a modifier you want to attach a price to by clicking on it. On the right side of the screen
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at the very bottom you will see folder-like tabs. Click the Pricing tab. See image below:

 

*Note: When a modifier is selected, the only tabs you can open are Modifier, Pricing, Menu Details, and
Stock. Other information like tax will be the same as the item it's modifying.

 

You will now see Price Details fields right above the tabs. In the Amount field type in the price
for the modifier then in the Schedule field click the drop-down menu. All the schedules that you
have previously created will show up. (You can learn how to create schedules under 
Scheduling->Add Schedule.) Select the All Day Schedule if you would like the modifier to have
that price all day long.

 

If it should be different prices during different schedules, use the Add button to create multiple
prices, selecting the schedule and filling out the pricing options for each (explained below). All
prices are shown under the Item pricing list.

You can also have different prices during the same schedule but for different order types
(takeout, delivery, etc., explained below).

To make changes to one of the prices, click on it under the Item pricing list to highlight it and
then edit the Price details below.

- Pricing Options -
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*Note: The Default Price, Override, and Lock Price boxes are obsolete. They have been overtaken by
security items in the Security applet and also by the Priority here in the Pricing tab in Items & Stock.

Order Type You can specify what order type you would like the pricing tied to. You
can select All Orders or pick one specific type.

Example: If you put the price to be only for Dining mode, the selected price
will only be reflected on a check created in Dining mode. 

Active If the box is unchecked, the selected price will not be charged.

Open Price Enables you to put whatever price you would like on the item.

Not
Discountable

Sets up the node's price to not be affected by any
adjustments/discounts.

Priority Lets you choose which price should go into effect if the schedules of
any active prices overlap.

Example: If you have items that need a happy hour price of say $1.00
and then a regular (all day schedule) price of say $3.00, you need the
happy hour price to go into effect when both the happy hour and all
day schedules are overlapping.  So the priority is what allows you to
choose which price goes into effect when you have overlapping
schedules. Set the happy hour price priority to 1 and all day schedule
price to 2. (Lower number - 1 - is first priority.)
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Amount is per
lb/oz for scales

You have already typed in the price here in the Amount field.

Note, however, that if you are using scales/weight for the item it is
modifying then you would want to set the price amount as what the
item would cost per pound or ounce so when the item is weighed the
price can be calculated correctly.

To enable scales/weight for an item, click on that item (red), click on
the Item tab on the bottom right, and look for the Enable Scale field.
From that drop-down, select either Pounds (lbs) or Ounces (oz).

Example: Put the price at $1.00 and set the node up as a weighted node. This
means whenever this node is chosen and you place an item on the scale to be
weighed, SoftTouch will calculate how much the item ways times the price you
have entered in Back Office. So if you have a 2lb chicken with a price of $1.00
per lb, the chicken's total would then be $2.00.

*Note: You can assign price to multiple nodes using the "node updater" listed here.

12.2.2.6Customize the Button of Modifiers

Under the General section click on Item Builder.  Select the Menu & Rule
Builder tab. Select Modifiers button.

Customize the Button of the Modifiers -

You can change the button color, font style and color of every modifier. This feature is available to
you on the right side of the screen when the Modifier tab is selected. You'll see the options at the
very top under Button properties. With the modifier selected/highlighted on the left side of the
screen, to change the button color simply click the rectangle under Color and all the colors will
pop up. Choose your color and click OK. 

 



Version 6.1.16

182

 

To change the size, style and/or color of the font on a button highlight your modifier first then
click the Font button (between Button Text and Color). A font properties screen will pop up from
where you will be able to set different font, style, size and color. See image below:
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- SHORTCUT -

There is a shortcut to assign a Family and customize button colors, font size and colors for a
group of modifiers at once.
Highlight the major group "No Modifiers" for example. Then click on the "Node Updater" icon (it
looks like U letter). See image below:

 

An Updater screen will show up and you will see check boxes to update price, family, tax, button
color and font, and printer. You will also see folder-like tabs for these items as well. 
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Select the Buttons tab, and there you can choose button color and font type, size and color. Click
the Family tab, scroll down the list and choose Food Modifiers as your family. Now check the
check boxes (under Step 2) marked Update family, and Update button color, and Update button
font, as those are the three things you are setting now. When the boxes are checked click the OK
button. The system will now update all Modifiers in the modifier group that you have highlighted.

You may do the same thing for pricing for a group if all the pricing is the same. If each price is
different, then you will have to highlight each modifier separately and enter a price and schedule
under the Pricing tab for that particular modifier.

12.2.2.7Duplicate Modifier Groups

Under the General section click on Item Builder.  Select the Menu & Rule
Builder tab. Select Modifiers button.

-Duplicate Modifier Groups-
 

Step 1. Highlight the Modifier Group you wish to duplicate.

 
Step 2. Click on the Duplicate icon in the toolbar. See image below:
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Step 3. A small window will pop up with a few fields.  Enter the existing text you want to replace
in the "Replace" field and enter the text you want to change it to in the "With" field.  The example
below would change "Small Pizza Mods" to "Large Pizza Mods".  You also have the option to
change the Button Text, Print Name, and/or Receipt Name for the new group.

 

 

Example: If you're duplicating Sm (small) Pizza modifiers with Lg (large) Pizza modifiers, simply put in
Sm in the "Replace" field and Lg in the "With" field. All the new duplicated modifiers will now have Lg
instead of Sm in front. If you did not label Sm Pizza modifiers, then just leave the first "Replace" field
blank and enter Lg in the second field ("With"). Lg will now be added to the front of all new duplicated
modifiers.

Step 4. Once you click OK, it will take a few seconds (depending on how many modifiers are in
the group).  Once it is finished duplicating the group, you will see the new group at the bottom of
the list. 
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12.2.3 Links

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Links button.

- Links -

After you've set up modifiers (if you haven't learned how to set up modifiers yet, see under 
Modifiers) you will want to link NO MODIFIERS, ADD MODIFIERS, XTRA MODIFIERS,
SUBSTITUTE MODIFIERS and INSTRUCTION MODIFIERS together. This allows the Servers to
choose these modifiers as categories.

Links explanation includes the following:

1. Create Links

2. Rename Links

3. Adding Modifiers to Modifiers

4. Link Modifiers to Modifiers
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12.2.3.1Create Links

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Links button.

Create Links
 

Step 1. Click on the blue button labeled Links. See image below:
 

 

Step 2. Highlight the top category called Link Builder by clicking on it. See image below:
 

 

Step 3. When the Link Builder is highlighted click on the Add Link Group icon (blue block with
label L). See image below:
 

 

Step 4. A small window will pop up asking for a New Link Group Name. Name your link group
"Manual Modifiers." We have just created a Link Group. Now we need to the add NO, ADD, XTRA,
SUBSTITUTE and INSTRUCTION Modifier Groups (yellow) to it that we discussed creating under 
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Modifiers->About Modifiers and Create Modifiers. 

To do so highlight the link group you have just created, Manual Modifiers, by clicking on it. Then

click on the Add Modifier Group icon  (yellow block with label M). All the modifiers you have
created earlier will appear. Hold down the CTRL key on your keyboard and highlight the NO, ADD,
XTRA, SUBSTITUTE and INSTRUCTION groups and click Select button. 

All these modifiers will be joined together under the link group "Manual Modifiers." You can click
on the plus sign next to "Manual Modifiers" to see the modifiers you added. This is the link group
that we will link to the menu items instead of linking each of the above modifiers to each item.

12.2.3.2Rename Links

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Links button.

Rename Links
 

Step 1. Highlight the Link Group you wish to rename.

 

 

Step 2. Click on the Rename Node icon.

 

*Note: You can also highlight the link and right click to select the "rename node" option.
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Step 3. Enter new name and click OK.

 

12.2.3.3Adding Modifiers to Modifiers

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Links button.

Adding Modifier Items to a Link Group

Occasionally there will be choices of Soup or Salad for Entrees. There is no problem with Soup,
but Salad may require a dressing. If you create these add-on Soups and Salads as Yellow
modifiers (because they're modifying a food item by adding onto it), you will find that you will not
be able to add dressing to the Salad. 

This is because You CANNOT modify a Modifier with a Modifier (in other words: anything Yellow
cannot be modified with a modifier [yellow]).

You may however create Links Groups containing modifiers that can then be linked to items for
modification purposes.

Example: You want to create a Soup or Salad modifier with Dressings as a modifier for Salad.

To do that you must first create Dressings as a Yellow modifier group as was previously discussed
(you can learn how to create modifiers under Modifiers). 

Step 1. Click on the blue button labeled Links. See image below:
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Step 2. Highlight the top category called Link Builder by clicking on it. See image below:
 

 
Step 3. When the Link Builder is highlighted click on the Add Link Group icon (blue block with
label L). See image below:
 

 

Step 4. A small window will pop up asking for a New Link Group Name. Name your link group
"Soup or Salad".
 

Step 5. Highlight the new Soup or Salad group you just created. Then click on the Add Item icon
(small red i). See image below:
 

 
A dialog will pop up asking to enter an item name (and price if applicable) you wish to add. Type
in the name of the first kind of soup and click Create. The dialog will still be open and you can
continue typing in the name of each soup and each salad offered.
 

CAUTION: You are only allowed one unique name to an item or modifier. Using the name a second time
will address the first item with the same name. Each item must have a unique name for Food or
Liquor Costing purposes.
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For this example what you should type is Side Soup and Side Salad so as not to be confused with
other salads that you may want to add later on.

After adding Side Soup and Side Salad or side Pasta Fagiole, side Minestrone, side House Salad,
and side Caesar Salad etc., click Cancel to stop adding any more items.

Because we're going to make these items available as optional add-ons to other menu items, we'll
call them "Modifier Items."

- Assign Family to Modifier Item -

Now double click the Soup or Salad Link Group or click the + sign next to the Soup Link Group to
expand it and you'll see all the items you have just added. You must highlight each item and
assign a family to it like you did previously for modifiers (select the Item tab on the bottom right
and fill in the Family field under Item properties).

- Attach Price to Modifier Item -

If there are any prices that you want associated with any of these modifier items go to the Pricing
tab at the bottom of the screen and enter it there. See image below:

If adding a price, do not forget to assign a price schedule for the item.

- Assign Printer and Tax -

Since this is an item to be used as a modifier you must assign a printer for this item to go to and
tax.
Highlight an item first then on the right side of the screen at the very bottom click the Printers
tab. See image below:

Under Print Groups click on the white rectangle for the drop-down arrow to show up. See image: 

Then click the drop-down arrow and choose the printer.

Now click the Tax tab at the very bottom of the screen. See image:

Under Tax Tables click on the white rectangle for the drop-down arrow to show up. Then click the
drop-down arrow and choose the tax that you have created in the Tax Tables area. You can
specify more than one tax if necessary.
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*Note: You can add Adjustments if you would like to these items as well using  the Adjustment tab.
This will not make the system automatically apply adjustments to the item, it just makes them available
to be applied.

12.2.3.4Link Modifier to Modifier

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Links button.

- Link Modifier to Item Modifier -

After completing everything described for adding modifier items to link groups (under Adding
Modifiers to Modifiers), highlight your first or only side salad (item) within the Soup or Salad Link
group by clicking on it. 

Step 1. 

With the salad highlighted click the Add Modifier Group icon  (yellow block with label M).

You will see all the modifiers that you have previously created. Highlight Dressings and click the
Select button. Now dressings are tied to your side salad.

Step 2.

Click the + sign next to side salad within the Link group and you will see the dressings group that
you have just added. 

Highlight that dressings group by clicking on it and on the right side of the screen under Group
properties you will see the fields Forced Quantity, Quantity, Non Priced, Manual Modifier, Skip,
and Node Display. 

 

For Dressings we would likely want to put the Force Quantity at at least 1 (see explanation below).
(It may help to add a No Dressing modifier in the dressing modifier group in case someone does not
want dressing; this will be more clear than a salad with no dressing specified.)

*Note: If it is not the server that makes the salad, this helps the expo because then they would know
what dressing to put with the salad.

In this case we want the dressings to be automatic so when the Server selects Salad in SoftTouch a
choice of Dressings automatically pops up So we will not put on the Manual Modifier Option. 

Group Properties
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Force Quantity Any number put into the Forced Quantity field would be how many
modifiers the server would be forced to select before they can move
on.

If you put the Force Quantity to 0, the Servers can choose to use
the Go On button without choosing any modifier options. 

If you set the Forced Quantity to 1 the Server would be forced to
choose at least one modifier before they could go to the next
screen.

(You can set this to higher numbers as well.) 

Example: Say I want a server to be required to select one dressing for a
salad before going to the next screen. I would put the Forced Quantity at 1
and then the server would be able to go to the next screen only if they
selected at least one dressing.

Quantity If you leave the Quantity field at 0 then the Servers will have
unlimited choices of Salad Dressings (can select as many as they
want before continuing). 

If you only allow a choice of 1 dressing then you must enter 1 in
the Quantity field. 

If you allowed 2 choices then you would enter 2 in the Quantity
field.

Non Priced Allows you to specify a number of modifiers to be non-priced.

Example: If you would like the include the first two modifiers on a pizza
for free but charge for the rest, set the Non Priced Modifiers option to 2.

Manual Modifier A modifier group is always automatic by default, meaning it will
automatically appear after selecting an item it's attached to.

 If you want a modifier group to be a manual modifier you must
check the check box called Manual Modifier. Manual modifiers will
not pop up automatically when you order the item in SoftTouch. 
You have to select the item in the check, then hit the "Modify"
button, and then the manual modifiers will show up.

*Note: This can only be turned on for one of the modifier or link
groups assigned to an item.  Also, the modifier or link group that is
selected as the manual modifier should be the bottom most group
attached to the item. 
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Skip If you have a modifier group you do not currently need for an item,
rather than deleting the group you can check on the Skip option so
that group is skipped. When you want to have the modifier group
available for the item again you would just have to uncheck the
skip option for the group.

Example: For a limited time a BBQ rib dinner platter has the choice of
another set of side options. While in effect, the skip option would not be
checked. Once the special ends (but it is a special that re-occurs once ever
couple of months) you would just check the skip button on so you do not
have to delete the group.

Node Display All Modes: Displays the modifier group option in all modes.

SoftTouch Only: Only displays the modifier group in the SoftTouch
Mode. 

Example: This is good if you need to add a specific group modifier that is
only going to be used for the online menu.

Online Only: Only displays the modifier group for the Online
mode.

Kiosk Only: Only displays the modifier group for the Kiosk mode.

*Note: Defaults to All Modes.

Step 4. 

We have now created item modifiers for menu items that require a Soup or Salad with Dressing
choice. This link group is now ready to be added to items (see Items->Add Modifiers to Items).

Example of What a Soup or Salad Link Modifier would look like:

12.2.4 Items

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button.

- Items -
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After you've set up Modifiers (you can learn how to create modifiers under Modifiers) and then
Links (you can learn how to create links under Links) you can build the actual Menu Items.

Items explanation includes the following:

1. Create Menu Items

2. Rename Menu Items

3. Assign Family, Attach Price, Customize Buttons, Assign Printers, Tax, and Adjustments

4. Special Pricing

5. Add Modifiers to Items

6. Set Properties and Organize

7. Copy Modifiers from Item to Item

8. Duplicate Item Groups
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12.2.4.1Create Menu Items

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button.

- Create Menu Items -
 

Step 1. Click on the red button labeled Items. See image below:

 

 
Step 2. Highlight the top category called Item Builder by clicking on it. See image below:

 

 

Step 3. When the Item Builder is highlighted click on the Add Item Group icon (red blocks with
label I). See image below:
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You can now add Item Groups using the same manner as you did with Modifier and Link Groups
.

As soon as you create an Item Group you will be prompted to start adding items (with prices) to
that group immediately, or you can hit cancel on that screen if you like to create more Item
Groups before you start adding individual items. To manually add items to a group later, highlight
the group you want to add to by clicking on it and then click the Add Item icon (small red i). See
image below:

 

 

Start adding items for the group highlighted.  Click Create after each item, then hit Cancel when
finished adding items to that group.



Version 6.1.16

198

Example: If the group is Appetizers, then add all the appetizers from the menu. If you are separating
Lunch and Dinner Appetizers then remember to use an L or D in front of the item name to distinguish it
from Lunch and Dinner.

12.2.4.2Rename Menu Items

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button..

- Rename Menu Items -
 

Step 1. Highlight either the Item Group or the Item itself you wish to rename:
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Step 2. Click on the Rename Node icon (or right click and select Rename node). See image
below:

 

Step 3. Enter new name and click OK.

 

Step 4. If an individual item (not an item group), click the Item tab on the bottom right
and change the button text and print name to match.
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12.2.4.3Assign Family, Customize Button, Attach Price, Assign Printer and Tax

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button.

Using the Node Updater icon  you can assign Families, make button changes, and assign Print
Groups and Tax to all the items in the group at once (see Command Bar) or you may assign a
Family, attach a Price and Price Schedule, and assign Print Groups and Tax using the bottom tabs
for each item in the group separately one at a time.

*NOTE: When you are in the Items section of the Item/Menu Builder you will be able to access all tabs
on the bottom right except the Modifier tab. The Menu Details tab is used for Online Ordering.

- Customize Button, Assign Family, and Other Item Options -

Each individual item will allow you to have a different name displayed on a button (Button Text)
from what you have entered as the Item Name. You can also customize the name of the item as it
should appear when printed remotely (Print Name) and on guest checks (Receipt). If you do not
change/edit the Print Name or Receipt fields, the system will assume the same name (that you
entered in the beginning) for all areas and will use that name. See image:
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Family Select this item's family from the drop-down. Families will only appear here
if you have created them under Item Builder->Departments.

Barcod
e/PLU

Note that this is the section where you enter the barcode or PLU for items
that can be scanned.

This is also important for use with Liquor Dispensing (see 
Hardware->Stations->Hardware Devices->Liquor Dispensing).

NOTE: If you are using Price Embedded Barcodes, then only put the
actual PLU code in this field, do not put the entire barcode into this field.
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Enable Scale From the drop-down you can choose to disable the scale or select whether you will
be weighing in ounces or pounds. If you select to weight in ounces or pounds,
whatever you enter for the amount on the Pricing tab will be the price per ounce or
pound (whichever you selected here).

Roll Modifiers $ Adds the price of any modifiers into the price of the item when printed.

86 Disables this item from being ordered in SoftTouch and also disables
customers from ordering this item online if online ordering has been
enabled.

Allow Refills Used with self-ordering, this allows customers to order a refill of this item
(at no charge).

Upsell Display Displays this item in the Upsell feature when activated, which can be chosen
manually or automatically through use of SoftTouch's Seat Statistics to
suggest an upsell based on seating demographics.

Non Taxable All modifiers and items normally have to be assigned to a tax.  If there are
any items that should not be charging tax, then this option must be enabled
for those items.

Do not print on
check/receipt if
$0

If this is a non-priced item and you do NOT want it to print on the guest
check and customer receipt, enable this option.

Non priced
modifiers

Allows you to specify a number of modifiers attached to this item to be
non-priced.

Example: if you would like the include the first two modifiers on a pizza for free but
charge for the rest, set the Non Priced Modifiers option to 2.

*Note: Only works for the first modifier group attached to the item.
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Page Break 1. When this option is checked on, a page break is created so that when you
go to the POS your modifiers/items will be listed on more than one page for
easier reading.

2. A page break should go on the item/modifier right before the item you
would like to start on the new page.

3. Enter page names so that each tab will have an appropriate name.

In the above screenshot, the page break would go on the last chicken item in the Chicken and
Veal group so that all the veal items will be on a separate page.

Tip: Use the "800" or "1024" buttons to preview what the group looks like after
enabling the page break for one or more of the items in group.

Node Display All Modes: Displays the modifier group option in all modes.

SoftTouch Only: Only displays the modifier group in the SoftTouch Mode. 

Example: This is good if you need to add a specific group modifier that is only going
to be used for the online menu.

Online Only: Only displays the modifier group for the Online mode.

Kiosk Only: Only displays the modifier group for the Kiosk mode.

*Note: Defaults to All Modes.

- Set Item Price -

Highlight an item you want to attach a price to by clicking on it. On the bottom right side of the
screen, click the Pricing tab. See image below:

 

 

You will now see Price Details fields right above the tabs. In the Amount field type in the price
for the item then in the Schedule field click the drop-down menu. All the schedules that you have
previously created will show up. (You can learn how to create schedules under Scheduling->Add
Schedule.) Select the All Day Schedule if you would like the item to have that price all day long.

 



Version 6.1.16

204

If it should be different prices during different schedules, use the Add button to create multiple
prices, selecting the schedule and filling out the pricing options for each (explained below). All
prices are shown under the Item pricing list.

You can also have different prices during the same schedule but for different order types
(takeout, delivery, etc., explained below).

To make changes to one of the prices, click on it under the Item pricing list to highlight it and
then edit the Price details below.

*Note: The Default Price, Override, and Lock Price boxes are obsolete. They have been overtaken by
security items in the Security applet and also by the Priority here in the Pricing tab in Items & Stock.
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Order Type You can specify what order type you would like the pricing tied to. You
can select All Orders or pick one specific type.

Example: If you put the price to be only for Dining mode, the selected price
will only be reflected on a check created in Dining mode. 

Active If the box is unchecked, the selected price will not be charged.

Open Price Enables you to put whatever price you would like on the item.

Not
Discountable

Sets up the node's price to not be affected by any
adjustments/discounts.

Be sure to check on this option for each individual price/schedule it
applies to. (See Set as Not Discountable for an example
walk-through on setting up this feature.)

Example: A customer has a 20% off coupon and you have a caviar item that
you don't want to discount. If that item is set to Not Discountable, 20% off will
be applied to everything  on the check except the caviar.

Priority Lets you choose which price should go into effect if the schedules of
any active prices overlap.

Example: If you have items that need a happy hour price of say $1.00
and then a regular (all day schedule) price of say $3.00, you need the
happy hour price to go into effect when both the happy hour and all
day schedules are overlapping.  So the priority is what allows you to
choose which price goes into effect when you have overlapping
schedules. Set the happy hour price priority to 1 and all day schedule
price to 2. (Lower number - 1 - is first priority.)

Amount is per
lb/oz for scales

You have already typed in the price here in the Amount field.

Note, however, that if you are using scales/weight for the item then
you would want to set the price amount as what the item would cost
per pound or ounce (depending on which you selected) so that when
the item is weighed the price can be calculated correctly.

To enable scales/weight for an item, click on that item (red), click on
the Item tab on the bottom right, and look for the Enable Scale field.
From that drop-down, select either Pounds (lbs) or Ounces (oz).

Example: Put the price at $1.00 and set Enable Scale to Pounds (lbs). This
means whenever this node is chosen and you place an item on the scale to be
weighed, SoftTouch will calculate how much the item weighs times the price
you have entered in BackOffice. So if you have a 2lb chicken with a price of
$1.00 per lb, the chicken's total would then be $2.00.

*Note: You can assign price to multiple nodes using the "node updater" listed here.
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- Print Groups and Tax -

 

*IMPORTANT*:

DO NOT FORGET to specify printers and tax for each item!! With an item selected, click
the Print Groups and Tax tabs on the bottom right.

For print groups and taxes to display in the drop-downs for each of these tabs, you must
first create them.
Read about setting up printers and print groups under Hardware->Printers/Coursing.
Read about creating taxes under Financial->Tax Table.

If you use an expediter printer in your establishment, make sure you also add the
expediter print group.
Read about expediter under BackOffice Toolbar->Template Screen->Expediter Template
and Seat Positions.

- Adjustments -

On this tab you can choose to attach adjustments to the item. Adjustments can be coupons,
discounts, specials, etc.

You must create the adjustments first in order for them to show up on the drop-down menu. Read
about adjustments under Financial->Adjustments.

12.2.4.4Set Item as Not Discountable

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button.

- Set Items as Not Discountable -
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If you wish to not discount some items, you can set those items to Not Discountable in the Menu
Builder, as outlined below.

Example: A customer has a 20% off coupon and you have a caviar item that you don't want to discount.
If that item is set to Not Discountable, 20% off will be applied to everything  on the check except the
caviar.

Step 1.  In the menu builder click on the red button labeled Items.

Step 2.  Expand an Item Group inside of which is the Item you wish to set to Not Discountable.

Step 3.  Highlight that item by clicking on it.

Step 4.  On the right side at the very bottom click on the Pricing tab.

Step 5.  If your item has several prices then under Item pricing list section select the one you
want to be not discountable by clicking on it.

Step 6.  Under Price details section select the Not Discountable checkbox.



Version 6.1.16

208

Step 7. Repeat steps 5-6 if you want to set other prices for that item to Not Discountable as
well.

Step 8. Repeat steps 2-6 for all other items you want to be Not Discountable.

12.2.4.5Add Modifiers to Items

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button.

- Add Modifier Groups or Link Groups to Items -

After you have added Items to an Item Group and assigned the necessary information to the
items, you can now add Modifier Groups and/or Link Groups to an Item. (Refer back to 
Modifiers->Create Modifiers and Links->Create Links for help setting these up.)

Step 1. 
Highlight the Item you want to add a Modifier or Link Group to, then click on the Add Modifier

Group icon  (yellow block with label M) or Add Link Group icon  (blue block with label L).

Step 2. 

In the window that shows up you will see all the modifier or link groups you have created earlier.
Highlight the modifier or link group you want to add and click the Select button. Tip: You can
hold down the CTRL key to select multiple groups at one time.

You have now added a Modifier or Link Group to an Item.

Recall and consider adding some of the link groups we created earlier, such as Manual Modifiers
(see Links->Create Links) and Add Soup or Salad (see Links->Adding Modifiers to Modifiers
).

**WARNING**: Only one group under an item can be a Manual Modifier (have the Manual Modifier
option checked).  If you add a manual modifier to an item, it must be the LAST modifier group
listed under that item.
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- Add Item Groups as Modifier Groups to Items -

You can add an Item group to an item as a modifier much the same way as you add a Link Group
to an item.

This is good for if you have an item that is a modifier that needs to have modifiers tied to it as
well. This works basically the same as using a Link as a modifier does, except you are not limited
to how many item groups you use as modifiers under an item.

Example: You need a group of sides for a steak, but there is a potato option and the potato needs to
have items tied to it as well. You would create all the side options as items and with the potato you could
then tie regular (yellow) modifiers.  Then you can take that item group and tie it to the steak for side
options.

12.2.4.6Set Properties and Organize

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button.

- Set Properties and Organize -

After you have added all the modifier, link, and item groups you want to the menu item, double
click the item and/or the group that this item is located in or click the + sign next to them. All the
modifier (yellow), link (blue), and item (red) groups that you've added will show underneath.

 

Step 1. 

Highlight the first modifier group (any color). Under the Group properties you'll see the options
that were explained under Links->Link Modifier to Modifier. Adjust these as needed.

If using the Add Soup or Salad Link Group we created in Links->Adding Modifiers to Modifiers
, the Quantity (not forced) should be set to 1 if only one soup or salad can be added on to an
entree for that price.

If using the Manual Modifiers Link Group we created in Links->Create Links, the Quantity (not
forced) should be left at 0 so the server can choose as many manual modifiers as needed.
Remember to check the Manual Modifier option box so these modifiers will pop up only if the
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server pulls them up by touching that item on the check in SoftTouch.

ATTENTION:
 

Make sure Manual Modifiers are the last group attached to an item.
 

Example: Soup or Salad should come before Manual Modifiers (which are NO, ADD, XTRA, SUBSTITUTE
and INSTRUCTION modifiers).

If you need to move a Modifier up or down, there are an Arrow icons to move it one space up or
down, or to the top or bottom of the group. See image below:
 

12.2.4.7Copy Modifiers from Item to Item

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button.

- Copy Modifiers from Item to Item -

Once you have added all the modifiers you needed to the item, you may copy these modifiers to
another menu item under the same group or to an item under another group that needs to use
exactly the same modifiers.

Step 1. Highlight the Menu Item you want to copy Modifiers from and click the Copy Node icon
on the toolbar. See image:

 

 

*Note: You can also highlight the item, right click and select Copy node.

Step 2. Now highlight the Menu Item you want to copy Modifiers to and click the Paste Node
icon on the toolbar. See image:
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*Note: You can also highlight the item, right click and select Paste node.

You have now copied all the Modifiers, including Quantity field value and Manual check box
selection, from one menu item to another menu item.

If you want to keep copying the same Modifiers to more Menu Items, you can continue selecting
items and pressing the Paste Node icon (you do not have to copy the same modifiers over and
over).

12.2.4.8Duplicate Item Groups

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Select the Items button.

- Duplicate Item Groups -
 

Step 1. Highlight the Item Group you wish to duplicate.

Step 2. Click on the Duplicate icon in the toolbar. See image:

Step 3. A small window will pop up with a few fields.  Enter the existing text you want to replace
in the "Replace" field and enter the text you want to change it to in the "With" field.  

Example: The following example would change "Small Pizza Mods" to "Large Pizza Mods".  

You also have the option to change the button text, Print Name, and/or Receipt Name for the new
group, and to copy the prices, tax, and/or printers. This is explained in detail here.
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Example: If you're duplicating Sm (small) Pizza items with Lg (large) Pizza items, simply put in Sm in
the first "Replace" field and Lg in "With" field. All the new duplicated items will now have Lg instead of Sm
in front. If you did not label Sm Pizza items, then just leave the first field "Replace" blank and enter Lg in
the second field "With". Lg will now be added to the front of all new duplicated items.

Step 4. Verify/Enter the name for the new Group and click OK.
 

 

12.2.5 Sizing the Grid

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. 

- Sizing the Grid -

When you have all the Items, Modifiers and Links added to a group, you can change the grid size
to fit the menu.

Highlight the Item Group and click on the 800 icon or 1024 icon on the toolbar. See image below:
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This will open the preview window of the grid size. See image:
 

When you're ready, click the red X in the top right corner of the grid preview window to exit it.

If you want to make the buttons bigger or smaller, on the right side of the screen under the 
Group properties you will see a Rows field and a Columns field with numbers in them. See
image:
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Rows is the number of buttons going vertically.
Columns is the number of buttons going horizontally.

Increasing the number of Rows and/or Columns will make the buttons smaller and decreasing the
number will make the buttons larger.

To see how it works play with these numbers by entering different values. Then re-highlight the
Item Group and choose the 800 or 1024 icon to preview the new results.

- Paging the Grid -

If the menu goes onto another page, you may label the pages in the white space under Page
Names. See image:

 

If you want to force items to go to another page, highlight the item that you want to be the last
one on the previous page and check on the Page Break check box. See image:
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This will force all the following items to go to the next page.
You can have up to 6 pages total.

**WARNING**:
 

When using the grid Rows and Columns feature, make sure you do not set the Rows
and/or Columns to be so big that it cannot accommodate all the menu items in that
group. If the menu items cannot be displayed, there will be an error message.

12.2.6 Making Menus from Item Groups

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. 

- Making Menus from Item Groups -

After all the menu items are added into their appropriate groups (for example: Appetizers,
Entrees, Desserts) you will need to make them into a completed menu.

Step 1. Click on the blue button labeled Links. See image below:
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Step 2. Highlight the top category called Link Builder by clicking on it. See image:

 

 

Step 3. When the Link Builder is highlighted click on the Add Link Group icon (blue block with
label L). See image:

 

 
Step 4. Enter a New Link Group Name (for example: Lunch Menu, Dinner Menu, Liquor Menu).
Name it depending on the Restaurant needs. For our examples, we will call it a Food Menu or the
Main Menu.

Step 5. Now highlight this Food Menu group you've just created and click on the Add Item Group
icon (red block with label i). See image:
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Step 6. In the window that shows up you will see all the Item Groups you created earlier.
Highlight all the groups that you want to have in this Food Menu or Main Menu (or whatever
you've called it) by holding down the CTRL key while you select the groups or Shift key while
clicking the first and last in a series. Then click the Select button.

Click on the plus sign next to the Food Menu / Main Menu to see all of the item groups you've
added to it.

The following example shows what the Main Menu Link might then Look like:

*Note: You can create new Link Groups for Liquor or Lunch and Dinner. Follow the same steps
starting from Step 2.

12.2.7 Main Menus

Under the General section click on Item Builder. Select the Menu & Rule
Builder tab. Click on the Main Menus button.
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Once you have created your Food Groups and have linked all your items to them, you have to
define those link groups as actual menus by going to the "Main Menus" area.

Step 1. Click on the green button labeled Main Menus. See image below:

 

 
Step 2. On the right side of the screen under the Main Menus title you will see a little black
triangle with fields for Name and Menu Definition. See image below:

 

Click the  button and under the Name field create a unique name for the menu you want to
link to.
 

Examples: Dining Menu, Bar Menu, Lunch Menu, and Dinner Menu. If you have a unique Take out menu
then create the name Take Out Menu.

 

Next to the name you just entered, click in the white space under Menu Definition. A window will
show up and you will see the Food Menu group you created earlier, and all other Menus that you
have created.

Highlight Food Menu (or other desired menu) and click the Select button.

You have now linked the Food Menu to the name Dining Menu. Repeat the same steps starting
from Step 2 until all the Menus have been named and linked under the Main Menus.

*Note: If you've already filled in the Menu Definition field but want to change it, you have to
double click that field.

Step 3. Another feature you will need to understand in the Main Menus area concerns the Home
Tab. 
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This field allows you to customize how your users will see the order screen in SoftTouch. By
default, when you create a new menu name, the Home Tab is not checked. This means that
when you enter the order screen for that area (let's say Counter, for instance), you will be
presented with the first group (the one that is at the top of the list) in your Food Menu. See
image below.

Now let's take a look at the Dining Menu with the Home Tab checked. You will see that it displays
all of the groups in the Food Menu in the main screen. See image below.
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You will notice that the side, hot-jump menu does not change. This feature can be very useful in
a bar situation, where you would like to have you most sold items as the main order page and
still have quick access to the rest of the menu on the right.

Step 4. If you do not wish the menu categories on the right-hand side to appear, check on the
Hide Tab Menu button.

This is what the Dining Menu would look like with both the Home Tab and the Hide Tab Menu
options checked on.
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You are now finished with the building and linking of your Menus. These menus must be assigned
to Stations (learn how under Hardware section->Stations->Menus tab) and Price Schedules
must be attached to Stations (learn how under Hardware section->Stations->Price
Schedules tab).
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12.3 Smart Rules Tab

Under the General section click on Item Builder. Select the Smart Rules
tab.

This section is explained in detail in the Coupons and Combos Manual.
This manual can be downloaded at: www.softtouchpos.com

http://www.softtouchpos.com
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12.4 Menu Categories Tab

Under the General section click on Items & Stock.  Select the Menu Categories
tab.

Menu Categories

*Note: This section is used for SoftTouch programmers who handle the Online set up. 

Sort The Sort Order displays in which order the online tabs will appear on the
website.

Category and Tab
Name tabs

 
The Category and Tab name are usually the same name as what is
posted on the restaurant's take out menu.

Description (html
allowed)

The Description area is where we can fill in information about the Group.
You can put html coding in this section.

Hide Tab The Hide Tab option allows us to either see or hide the tab online for the
menu category.

*Note: If you choose to hide a tab it will still be listed under the default tab
named "All categories" when viewing the menu online.
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12.5 Item Maintenance Tab

Under the General section click on Items & Stock.  Select the Item Maintenance
tab.

Item Maintenance 

This area is to list all the created items in the database. If you delete nodes from the menu, the nodes will
still appear in this area until deleted from this area as well.

Search Item You can type the partial first part of an item or the full name. If you
type the first letter, it will automatically scroll down to that area, and
as you type each letter it will search through to find the item that
contains the letters.

Show All items: Lets you sort through modifiers as well as the items

Items Only: Lets you sort through just the items (no modifiers)

Modifiers Only: Lets you sort through just the modifiers (no Items)

PLU/Barcode You can look up an item by its barcode or PLU by placing these in this
field. 

*Note: You should be able to scan or manually type in the code to
search.
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Filter Filters items by letter combinations entered in the field.

Example: If you start typing in "pa" it will look up all items that have
"pa" anywhere in the name (not just the beginning). It is not case
sensitive.

Scrolling options

The arrows with a line next to them go to the beginning or end of the
entire list. 

The arrows without the lines go up or down one by one. 

The minus button deletes items. 

The Check-mark button saves the item.

The X Button undoes a change you have made.

The curved arrow button refreshes the list.

Active Check or uncheck this box next to any item that you wish to activate
or deactivate. If the item is inactive (box unchecked) the item cannot
be ordered.

*Note: If you deactivate the item/modifier here, it will deactivate the
item/modifier in the menu as well.
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Part 13 Stock/Barcodes

Under the General section click on Stock/Barcodes.  

Stock/Barcodes

Stock/Barcodes explanation includes the following:

1. Create and Manage Items

2. Tie Stock Item to Menu Item
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3. Barcodes
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13.1 Stock

Under the General section click on Stock/Barcodes.  

Stock/Barcodes

SoftTouch point of sale includes stock counts.  The stock items entered can be linked to multiple
items.  For example, if you enter a bottle of wine as a stock item, you can link it to the bottle in
menu items with a count of 1 and also tie it to the glass of wine with a quantity of .125 (where you
get 8 glasses from one bottle).

If you wish to do full blown inventory, please check the member area of the SoftTouch website, 
www.softtouchpos.com, to check for certified partners that we integrate with.

13.1.1 Create and Manage Items in the Inventory

Under the General section click on Stock/Barcodes.  Select the Stock &
Inventory tab.

- Stock/Inventory -

This is where you add and manage your inventory items. When adding new stock items you can either
manually enter them one by one or you can import items from a family.

- Add Stock/Inventory -

To add a new stock item, click the  button in this section and fill out the fields below:

Stock Name The name of your stock item.

Current Stock
Count

Number of items you currently have in stock.

http://www.softtouchpos.com
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Unit Cost Cost per item.

Warning at Specify a quantity after which the warning of low stock is displayed.
If 0 value entered the warning is never displayed.

*Note: Once you run out of an item in the inventory you will not be able to
ring up that item anymore.

- Add Stock Button -

If you are entering stock items that are packaged by boxes rather than being a single item, it's useful to
utilize the Add Stock button, which does the calculations for you.

Step 1. Highlight the stock item you need to update.

Step 2.   Click the Add Stock button (next to Refresh Stock Count button).

Step 3.  Enter the number of boxes for the item.

Step 4.  Enter the total item quantity in each box.
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Step 5.  Your old stock count and the new stock count you just entered are displayed below. Click Ok.

Step 6.  Enter unit cost (if you haven't already).

Step 7.  Specify a quantity for the low stock warning (if you haven't already).

- Importing Items from a Family -

Step 1.  From the drop-down menu to the left of the Import items from family button, select the
family containing the items you wish to import into inventory.
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Step 2.  Click Import items from family button.

Step 3.  Click Yes to the confirmation dialog.

Step 4.  Item names from that family are imported and appear on the list. Now you need to set the
Current Stock Count, Unit Cost and Warning at (if desired) for each of the imported items.
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13.1.2 Tie Stock Item and Menu Item Together

Under the General section click on Item Builder.  Select the Menu & Rule
Builder tab. 

- To Tie a Stock Item and a Menu Item Together  -

Step 1.  Under the Menu Builder tab click on the red button labeled Items.

Step 2.  Expand the Item Group that contains the Item you wish to tie to an inventory. 

Example: You want to tie the item 7 Up, which is in the group of Beverages, to your inventory. To do this, you
start by expanding the Beverages item group and highlight the 7 Up item.
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Step 3.  Select the Stock tab on the bottom right. Click on the blank space under Stock Name and select
the corresponding name from the drop-down list. For it to appear in the drop-down list, you must first
create it (refer back to Create and Manage Items in the Inventory if needed).

Step 4.  Next set the quantity used by clicking in the blank space under Qty Used and typing a number.
Each time you ring up this item, the number you enter for Qty Used is deducted from inventory. In this
case you will most likely have the Unit value set to 1. When a customer orders a bottle of 7 Up, 1
bottle of 7 Up is taken out of the inventory.

Take apple pie as an example of when you might want to set the Qty Used to a value other than 1. If you
sell it by the slice and there are 4 slices to a pie, you would set the Qty Used to 0.25. That way, the
apple pie inventory would go down by 1 after 4 slices have been ordered.

Step 5.  If the item contains multiple parts that you want to keep inventory for, use the Add button and
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repeat Steps and 3 and 4 for each component.

Example: For a hamburger, maybe you want to separately track inventory of burger patties and buns,
especially if you also use buns for say a pulled pork sandwich, meaning you likely use a different
number of patties than buns.
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13.2 Barcodes

Under the General section click on Stock/Barcodes.  Select the Barcode
Templates tab.

Barcode Templates
This area is used to define Price Embedded Barcodes (barcodes that have the price of the item

encoded within it).

*Note: There are default templates within the system. If the entire number in the image below is the item's PLU, you
would not need a template and you would want to either delete or define the pre-existing templates listed in this
section to correspond to the barcode.

*Note: When you are using Price Embedded Barcodes, you should only enter the PLU portion of the barcode into
the PLU field on the item.  Do not put the entire barcode into the item's PLU field.

Template Name This is where you can name the template what you would like to;
usually the name corresponds with the type of barcode, but it does not
have to be named anything specific.
   

Barcode Length Enter the length of the barcode here.  

*Note: If you scan the barcode into Notepad, it is whatever number the
barcode scans in first that is to be counted; that would let you know if the
first number (say the 0 in the image at the bottom of the page) is part of
the barcode or not.

Prefix The prefix is the 1 digit identifier of the barcode. You only need to use
a prefix if you define 2 templates of the same length, the prefix will
identify which template to use.

Example:  If you have two barcodes that are both 12 characters long, you
would want to use the prefix to establish the difference between the
barcodes. 

PLU start The character where the PLU starts.

Example: In the image at the bottom of the page, the PLU would be
16000 and the location would start at number 2. So for the PLU start area
you would put the number 2.
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PLU Length The length of the PLU.

Example: In the example on the bottom, the PLU would be 16000 and the
length would be 5. So you would put five in the PLU length area.

Price Start Where the Price would start in the barcode. 

Example: In the Image below we can say the price is $60.60 which means
the price would start 8 numbers into the barcode sequence. You would
then put the number 8 for the Price Start.

*Note: If you are not going to use the embedded barcodes, this area
should be left blank.

Price Length The Length of the price that is embedded within the barcode. 

Example: In the image below the price length would be 4 (if it is $60.60
as mentioned above) so you would put a 4 in this area.

*Note: If you are not going to use the embedded barcodes, this area
should be left blank.

Barcode Example: 
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Part 14 Seating/Zones

Under the General section click on Seating/Zones.

Seating/ Zones

Seating Setup includes the following:

1. Sections
 

2. Designer

3. Rentals

4. Zones 

5. Zone Creator

6. Preferences

7. Seating List



Version 6.1.16

240



Version 6.1.16

241

14.1 Sections Tab

Under the General section click on Seating/Zones. Select the Sections tab.

Sections

If your place of business is big you can create sections you can switch between. For example, you can
have Main Dining Room, a Sidewalk Cafe and a Main Bar sections.

- Seating Sections  -

Sections you add show under the Seating Sections part of the screen. Check boxes and all other fields will
shows the settings you have selected in the Seating detail section, which is on the lower half of the screen.

- Seating Detail  -

Here you add sections and select options for the seats/tables in that section.
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- Create Sections -

In the Seating Detail part of the screen click on the  button and fill out the fields below:

Section name Enter name for the section.

Section type Select the station type. Your choices are Dining or Bar.

Section order Decides where the section will be listed in the front end. If you put a 3
here, it will be the 3rd section in the list of sections.  A 1 entered here
would show up at the top.

Section screen width
and height

Notice that the Default SoftTouch and Hostess Size buttons will change
this to 1024x768.

If you change the layout size to be bigger than your monitor can fit for
display, SoftTouch will automatically create quadrants.

Use as a hostess
section

If checked, this seating layout will be used for the hostess system (if
you are using SoftHost).

*Note: Only one section can be used for the hostess layout. If you
have multiple seating layouts, you will need to combine those layouts
into one large layout to use with the hostess program.

- Seating caption first half -

Display name If checked, customer name will be shown on a seat/table.

Display seat If checked, a seat number will be shown on a seat/table.

Display total If checked, a total will be shown on a seat/table.

Remove seat/table #
when occupied

If checked, a seat/table number will not be shown while a
customer is at the table.

 - Seating caption second half -
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Display latest
course

If checked, customer's current meal course will be displayed on a
table.

Example: If a customer is having dessert, dessert will be displayed on their
table.

This is useful because it helps you tell how soon a customer is to
leaving based on how close their current course is to the end of a meal.

Display occupied
time

If checked, the customer's length of stay is displayed.

Display alert(s) If checked, server or time alerts will be displayed.

Click the  button when finished.

The next step is to go to the Designer tab and begin designing the seating layout.
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14.2 Designer Tab

Under the General section click on Seating/Zones. Select the Designer tab.

Designer

This is where you create the floor plan or floor plans for the different areas in the restaurant. Whichever
section is currently selected under the Sections tab (refer back to Sections Tab if needed) is the one that
you will be creating or editing the design of here. Remember, the screen size here is determined by what
you entered for Section screen width and height under the Sections Tab.

- Start Designing  -

In order to begin making changes to the selected floor plan, click the Start Designing button.

As soon as you click this button, it will change to "Stop Designing"; you will click this button when you are
finished making changes.

- Objects, Design, and Screen Tabs  -

Before you begin to add objects, it's helpful to understand these three tabs on the left.
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Select the Objects tab for a scrollable list of items you can add. To add an item, click on its name in this
list and then click anywhere on the design screen.

If you have clicked on one of the item names on the left but don't actually want to add an item right now,
you can click on the Cursor button to be able to click normally and select rather than add items.

Select the Design tab for a number of helpful tools.

*Tip: You can select multiple items by holding Shift and clicking multiple items.

Copy Copies the selected item(s). (You must then paste the item if you want the
copy to show up.)

This tool is also available when you right click on an item.

Paste Pastes the copied or cut item(s). You can paste an item multiple times
without clicking copy again.

This tool is also available when you right click on an item.

Delete Cuts or deletes the selected item(s). (You can then paste the item if you want
it to reappear.)

This tool is also available (as Cut/Delete) when you right click on an item.

Clear all This will delete all items from the current floor plan. A dialog box will pop up
asking you to confirm that you want to clear the entire page.
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Select all Clicking this button will select all items.

Clear sel. Clicking this button will unselect all items.

go back This will send the selected item(s) behind any other items it overlaps.

go front This will send the selected item(s) in front of any other items it overlaps.

Zones You can use this to assign a zone to the selected item(s). This will bring up a
dialog box with choices available based on what you set up under the Zones
tab.

Select the zone you would like to add the table to then click OK.

This tool is also available (as Assign Zone) when you right click on an item.

*Tip: Select multiple tables and assign a zone to all tables with the same
zone.



Version 6.1.16

247

Preferences You can use this to assign a preferences setting to the selected item(s). This
will bring up a dialog box with choices available based on what you set up
under the Preferences tab.

This tool is also available (as Assign Seat Prefs) when you right click on an
item.

*Tip: Select multiple tables and assign a seating preference to all tables with
the same seating preference.

Select the Screen tab to change the way you move items across the screen.

Snap to grid Put a check in this box if you would like items you move to move by the
increments you set for X Steps and Y Steps (below). This can make it easier
to line up items with one another.

X Steps Set this to the number of steps an item should move to the left or right when
you move it.

If an item is placed at coordinates 0, 200, for example, and has X Steps set
to 10, moving it to the right will move it to 10, 200 then 20, 200 and so on.

Y Steps Set this to the number of steps an item should move up or down when you
move it.

If an item is placed at coordinates 200, 0, for example, and has Y Steps set to
10, moving it downward will move it to 200, 10 then 200, 200, 20 and so on.

- Item Properties  -

No matter which tab on the left is selected, the bottom left will show (and allow you to edit) the selected
item's properties.



Version 6.1.16

248

If more than one item is selected, only properties that can be set for both items will be shown (and can be
edited).

If you select the blank design screen, the screen's properties are shown (and can be adjusted).

All items have four properties in common, which are explained here. Properties unique to different types of
items will be discussed below as we talk about each type of item.

Height This shows the current height. You can change this number to edit the
height. Height will be added to or subtracted from the bottom.

Left This number indicates where this item starts, counting from the left
side of the screen. You can change this number to move the item;
decreasing it will move it to the left and increasing it will move it to the
right.

Top This number indicates where this item starts, counting from the top of
the screen. You can change this number to move the item; decreasing
it will move it upward and increasing it will move it downward.

Width This shows the current width. You can change this number to edit the
width. Width will be added to or subtracted from the right.

You can also change the size and position of selected items by using your cursor. When you click on an
item, black dots will appear around its outer edge. To change the size, click on any of these dots and drag.
To move it, click anywhere inside of it and drag.
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- Table Selector  -

Once you've placed tables/seats (explained later), an easy way to find/select a certain one is to choose it
from the drop-down near the Start/Stop Designing button.

- Background  -

Let's start by adding a background. Generally this represents the floor of this section of the restaurant.

Select Background from the Objects tab on the left. Click and drag on the white space on the right to
create a space where you want that background to appear, or just click and a small-sized background will
appear.

Now click on the background item to see and edit its properties.
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Align These will change the position of the selected background, maintaining
its current width.

alBottom - Positions it along the entire bottom side.
alClient - Makes the background occupy the entire floor. If you want to
change away from this, it may be easiest to first adjust the height
(below).
alCustom - Custom alignment; select this if you want to change it
from one of the other alignments.
alLeft -Positions it along the entire bottom side.
alNone - No alignment; the first setting from when you created it.
alRight - Positions it along the entire right side.
alTop - Positions it along the entire top side.
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BackgroundColor Use this drop-down to change the color.

BackgroundType Use this drop-down to change the texture/pattern. There are carpets,
tiles, woods, and more.

OriginalColor If you set this to True, it will revert back to the color it was when you
created it.

- High Resolution Tables, Seats, and Pool Tables  -

On the Objects tab on the left side of the screen, find Hi Resolution Table, Hi Resolution Seat, and Hi
Resolution Pool Button. Each time you want to create one of these, click the name and then click
anywhere on the designing screen.

*Note: If you use computers that require simpler graphics, you can use low resolution versions of these
items instead (explained below).
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Color There are two color options - gcDark and gcLight.

For tables, gcDark will make the table dark and the number light, and
gcLight will make the table light and the number dark.

For pool tables, color only affects the number.

For bar seats, color has no effect.

PoolTable This should be set to True for pool tables and False for tables and seats.

SeatCount For tables, use this to edit the maximum number of people that can sit here.
(Up to 8 chairs will be added on the image, but set this number as high as
needed.)

This is important for use with SoftHost so that the system knows how many
people can be seated at each table.

*Tip: You can change the seat count of multiple tables at the same time by
holding down the SHIFT key while you click on the tables and then changing
the number in this field.

SeatingNumber This number is used to identify the seat, table, or pool table.

You may need to refer to these numbers when working under the Zones,
Zone Creator, and  Seating List tabs.

SeatingRental When setting up rentals, set this to True. Refer to Rentals Tab for more
information on setting up rentals.

SeatingType This shows whether the item is a seat (stSeat) or a table (stTable).

Shape This is particularly useful for tables, as you can change the shape of the table
to round (ttRound) or square (ttSquare) and also have the option of it being
a booth (ttBooth).

You can also use this field to change the item between a table, bar stool (
ttBarStool), and pool table (ttPoolTable).
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Size The size of a table can be set to small (tsSmall), medium (tsMedium), or
large (tsLarge).

A bar stool can be set to small or large (you can set it to medium, but it will
appear the same as the large setting).

The size of pool tables cannot be adjusted.

*Note: For these items, size should be adjusted instead of Height and Width.

*Note: If you need to create more than one of the same image or animation (or any other item), you can
copy and paste that item. Right click the item and click Copy, then right click the screen and click Paste.

- Low Resolution Tables, Seats, and Pool Tables  -

If your computers require simpler graphics, you may want to use low resolution tables, seats, and pool
tables. On the Objects tab on the left side of the screen, find Low Resolution Table, Low Resolution
Seat, and Low Resolution Pool Button. Each time you want to create one of these, click the name and
then click anywhere on the designing screen.
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Font Use this field to change the font of the number that appears on the item.

To change it, click on the field where it says (TFont) and a button with three
dots will appear on the right-hand side.

Click this button, choose the font features you want, and click Ok.

PoolTable This should be set to True for pool tables and False for tables and seats.

SeatCount For tables, use this to edit the maximum number of people that can sit here.
(Up to 8 chairs will be added on the image, but set this number as high as
needed.)

This is important for use with SoftHost so that the system knows how many
people can be seated at each table.

*Tip: You can change the seat count of multiple tables at the same time by
holding down the SHIFT key while you click on the tables and then changing
the number in this field.

SeatingColor Use this drop-down if you would like to change the color of the item.

SeatingKind Use this drop-down to change the shape of the item. You can change it to a
rectangle (btnRectangle), oval (btnOval), or capsule shape (btnCapsule).

SeatingNumber This number is used to identify the seat, table, or pool table.

You may need to refer to these numbers when working under the Zones,
Zone Creator, and  Seating List tabs.

SeatingRental When setting up rentals, set this to True. Refer to Rentals Tab for more
information on setting up rentals.

SeatingType This shows whether the item is a seat (stSeat) or a table (stTable).

- Images and Animations -

Images and animations help replicate actual floor plans onto the screen, giving employees a better visual
representation of your restaurant. Use these items to add bar surfaces, computers, dart boards,
jukeboxes, stages, plants, and more.
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On the Objects tab on the left side of the screen, find Hi Resolution Image, Low Resolution Image,
and/or Animation. Each time you want to create one of these, click the name and then click anywhere on
the designing screen.

*Note: You may have to increase the size of an item for the entire image to display. Size can be adjusted
by clicking an dragging the dots around the edge of a selected item or by editing the height and width
fields on the left.

You will see some of these fields depending on which item is selected:

Flip

(low-res images)

flFlipDown - Flips the item over a horizontal axis (turns it upside down).

flFlipRight - Flips the item over a vertical axis (flips everything from left to
right).

flNone - This will revert the image back to its normal position without being
flipped vertically or horizontally.

ImageType

(low-res images;
hi-res images)

Use this to choose what image you would like. Choices include bar surfaces,
computers, stages, plants, and more.
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AnimateType

(animations)

Use this to choose what animation you would like. Choices include a fire
place, palm trees, fish, and more.

Animate

(animations)

Set this to true if you would like to use the image's animation/movement.

Set this to false if you would like it to stay still like a regular image.

ManualSize

(low-res images;
animations)

Set this to true if you would like to be able to adjust the size of the actual
item.

If this is set to false, the size of the item's outer edge will change the but
the image inside it will stay the same size.

Rotate

(low-res images)

roNone - This will revert the image back to its normal position without being
rotated to the left or right.

roRotateLeft - Rotates the image left by ninety degrees.

roRotateRight - Rotates the image right by ninety degrees.

- Drawing/Shapes  -

Drawing/Shapes can be added to your floor plan / design for any purpose you might need. In the image
below, for example, maybe the the red crisscrossed area represents an area that is undergoing
renovations where parties should not be seated. You might use drawing/shapes to create other basic
images of objects in your restaurant for which an image or animation is not available.

On the Objects tab on the left side of the screen, find Drawing/Shapes. To create a shape, click on this
item name and then click  and drag to the appropriate size on the designing screen.
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Align These will change the position of the shape. This should primarily be used for
rectangle shapes (see Shape below).

alBottom - Positions it along the entire bottom side.
alClient - Makes the background occupy the entire floor. If you want to
change away from this.
alCustom - Custom alignment; select this if you want to change it from one
of the other alignments.
alLeft -Positions it along the entire bottom side.
alNone - No alignment; the first setting from when you created it.
alRight - Positions it along the entire right side.
alTop - Positions it along the entire top side.

BrushColor Change the color inside of the shape.

BrushStyle Change the pattern inside the shape.

Caption Enter text here if you would like the shape to have a caption. The caption will
appear in the center of the shape.
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Font Use this to change the font of the caption if there is one.

To change it, click on the field where it says (TFont) and a button with three
dots will appear on the right-hand side.

Click this button, choose the font features you want, and click Ok.

PenColor Change the color of the shape's perimeter.

PenStyle Change the pattern of the shape's perimeter.

Shape Change the shape. You can choose from a circle, ellipse, rectangle, rounded
rectangle, rounded square, or square.

- Label  -

Labels can be used to add text anywhere to your floor plan / design. In the image below, for example,
labels have been used to help identify the different computer stations and seating zones.

On the Objects tab on the left side of the screen, find Label. Each time you want to create a label, click
this item name and then click anywhere on the designing screen.
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Align These will change the position of the label.

alBottom - Positions it along the entire bottom side.
alClient - Makes the background occupy the entire floor. If you want to
change away from this.
alCustom - Custom alignment; select this if you want to change it from one
of the other alignments.
alLeft -Positions it along the entire bottom side.
alNone - No alignment; the first setting from when you created it.
alRight - Positions it along the entire right side.
alTop - Positions it along the entire top side.

Caption Enter the text you want to appear.

Color Choose a color for label (background color). For this color to show, you must
set Transparent (below) to False.

Font Use this to change the font of the caption if there is one.

To change it, click on the field where it says (TFont) and a button with three
dots will appear on the right-hand side.

Click this button, choose the font features you want, and click Ok.

Transparent False - The entire label, including background color, will display.

True - Only the text will display.

- Stop Designing -

When you are finished designing the selected section, press the Stop Designing button.

- Load and Save -

Use the load button (folder with a green arrow) to open a saved floor plan / design. A dialog box will
appear; navigate to the correct location and file name then click Open.

Use the save button (blue disk) to save the current floor plan / design to a location on your computer or
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connected external drive. A dialog box will appear; navigate to the correct location, type in a file name,
then click Save.

*Note: These buttons are only usable when you have clicked on Stop Designing.

14.2.1 Hostess Layout

Under the General section click on Seating/Zones. Select the Designer tab.

Combining Layouts

This is of special importance for use with SoftHost.

If you have a restaurant that has multiple seating layouts, you will need to combine those layouts into
one large layout to use with the Hostess program. For instructions on combining seating layouts
(assuming you have already created them separately), follow the instructions below:

1.  First, make sure a section has been added for this hostess layout under the Sections Tab. Select/
highlight the first section you need to add to the hostess section.

2.  Now under the Designer Tab, click "Start Designing."

3.  Click on the Design tab, then click "Select All," then "Copy."

4.  Click "Stop Designing."

5.  Go back to the Sections Tab and select/highlight your Hostess layout, then go Back to Designer.

6.  Click "Start Designing"

7.  Click on the Design tab, then click "Paste".
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8.  You will see that the layout gets pasted to the blank space in your Hostess layout.  While the layout
that you pasted is still highlighted, click and drag the whole layout to the right so that you will have
space to put the next layout.

9.  Click "Stop Designing"

10. Now we must repeat the process for adding more layouts to this one. Go back to Sections and
select the second layout you wish to add to the Hostess layout, then proceed back to the Designer
tab. Now repeat steps 6 - 19.

11. If you have followed all the step properly thus far, you should have successfully combined two
layouts into one.  The new layout should look something similar to below with two layouts directly
side by side:
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You can continue adding more layouts to this one; just make sure your Section screen width and
height for this layout are large enough to fit more layouts.
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14.3 Rentals Tab

Under the General section click on Seating/Zones. Select the Rentals tab.

Rentals

In our rentals example we are going to use Pool Table rentals.
Before you start setting up pool table rentals (or any other rentals for that matter), you must first set up
Schedules for each individual pool table or for all pool tables. Set up day and night schedules and perhaps
weekend and weekday schedules as well.  If your rentals are going to be the same price all the time, then
you don't need to create a new schedule; you can just use the All Day Schedule.

If needed, refer to Scheduling in this manual for detailed information on how to set up schedules.

Rentals explanation includes the following:

1. Create Rental
 

2. Activate Rental in Seating Designer
 

3. Create Department for Rentals
 

4. Add Rental Item to Main Menu
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14.3.1 Create Rental

Under the General section click on Seating/Zones. Select the Rentals tab.

Rental Description of Options

Here you create your rentals and assign schedules, rental count and amounts to them.

 

Flat Rate When this option is checked the system charges a specified flat rate
no matter how long the customer uses the rental. So if you want to
charge hourly, leave the Flat Rate option unchecked.

Example: Your hourly rate for the number of 7 customers is $7.00. If they
use a rental for 3 hours, you charge them $21.00. But if the Flat Rate option
is checked than no matter how many hours they use a rental (3 or 5 or more)
they still pay only $7.00.

Crossover Rate When this option is checked the system knows to jump to the next
schedule once the schedule at which the rental was initiated is over.

Example:  From 9:00 am to 6:00 pm (day time) your rate is lower and from
6:00 pm to 12:00 am (night time) your rate is higher. You would have two
rental names with two different schedules. Let's say a customer rents a pool
table at 4:00 pm and uses it until 8:00 pm. If the Crossover Rate option is
checked, the system will know to start charging customer a higher (night
time) rate after 6:00 pm. But if it's not checked then a customer continues to
pay the lower (day time) rate even though it is after 6:00 pm and the rent
amount at these hours is different.

Rental Count You can set the rate depending on the number of people using the
rental. To do so specify the number of customers here.

Amount Enter the amount depending on the specified number of customers.

Example:
  if 1 customer - it is $1.00
  if 7 customers - it is $7.00
  if 10 customers - it is $15.00
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- Create Rental -
 

Step 1.  

First you need to give your rental a name. To do so click on the  button in the Rentals part of the
screen on the left and a blank line for the new record will appear with a star indicator next to it. See
image:
 

Click next to the star and type in a name for your rental. Now under the Schedule Name column click in
the white space for the drop-down menu to appear and choose a schedule for this rental. If this rental will
have a Flat Rate make sure you check Flat Rate option otherwise leave it unchecked. If this rental will
have a Crossover Rate make sure you check Crossover Rate option otherwise leave it unchecked. Click the 

 button to save when you are finished.

Step 2.  

Now we need to specify pricing for the new rental we just created.
Highlight a rental name if isn't already by clicking on it and in the Pricing part of the screen to the right

click on the  button. If you want to set the rate by the number of customers using the rental, click in
the white space under Rental Count column and type in a number of customers. Then under Amount
column click in the white space and type in the price for the number of customers you just entered. Create

as many Rental Counts and Amounts for that rental as you need. Click the  button to save when you
are finished.

14.3.2 Activate Rental in Seating Designer

Under the General section click on Seating/Zones.

Activating a Rental in Seating Designer

Step 1.  

First, from the Sections tab, select the seating section in which you want to activate your rentals. See
image below:
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Step 2.

Now select the Designer tab and turn on the Designer by clicking the  button.

Step 3.
 

Select the rental item by clicking on it. (Be sure to click on the Pool Table number).  In this case we use pool
table as an example. Set SeatingText as Player and SeatingRental to True. See image:
 

Step 4.
 

Having pool table still selected click on the Rentals tab at the bottom of the screen. See image:
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Step 5.

 

Under Rental Pricing section of the screen you need to add the appropriate rate schedules that you created
earlier under Create Rental to this pool table.

Click on the  button, then click a field next to the star for the drop-down menu to show up, choose the

schedule and click on the  button to save the changes. See image:
 

You have to do all of the steps described above for each individual pool table.

If you have already set the properties of each pool table to SeatingRental True and SeatingText Player, you
can use the Copy Rental and Paste Rental buttons to copy one table's rental pricing to other tables.

Step 6.

When you are finished, exit the Design mode by clicking the  button. The changes you've
made will be automatically saved.

14.3.3 Create Department for Rentals

Under the General section click on Seating/Zones.

Creating a Department for Rentals

Under the Departments tab of the Item Builder, set up a Super Department, Department and a Family (or
Families) for rentals.
See example image below:
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If needed, refer to Item Builder->Departments in this manual for detailed information on how to set up
departments.

14.3.4 Add Rental Item to Main Menu

Under the General section click on Item Builder. Select the Menu & Rule Builder
tab.

Adding a Rental Item to the Main Menu

Step 1.
 

Click on the blue button labeled Links. See image below:

 

Step 2.
 

You need to add your rental to the main menu. Highlight your Main Menu group and click on the Add Item
icon (small red i). See image:
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Call this item Pool Tables.

Step 3.
 

Highlight your newly created Pool Tables item. With the Item tab selected on the bottom right, under Item
properties select the Family to be Rentals or Pool Tables (depending on how you've set it up earlier in the
Departments). See image:
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Step 4.
 

At the bottom of the screen on the right click the Rentals tab (it is located right after Adjustments tab) and
set up the properties for this rental item.
First, check the Use Seating/Rental Pricing checkbox. Then under Minimum Charges specify a minimum
charge for minutes if there is any or a minimum charge of a fixed dollar amount if there is any. Under No
Charge specify the number of minutes for no charge. This allows a customer to change their mind during the
specified number of minutes without incurring any charge. See image:
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Step 5.
 

Add another item called Pool Table re-rental. Under the rental properties do not add any minimum charge or
any free charge. This button is used for re-starting the pool table timer when a player leaves.
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14.4 Zones

Under the General section click on Seating/Zones. Select the Zones tab.

Zones

Zones are reserved for use with SoftHost.

A zone is a group of tables that a server will work during his/her shift.

A zone group is a group of zones. Zone Groups allow you to have different zone
configurations based on how many servers are working. For example, you can make a zone
group with 4 zones for when there are 4 servers working and also make a zone group with 3
zones for when there are 3 servers working.

Before you begin setting up zones, make sure you know the different zones being used,
which tables are in each zone, and different zone configurations when different numbers of
servers are working.

*Note: You can also mass create zones and the zone group they are part of by using the
Zone Creator tab.

- Add Zones -

1.  In the All Zones section, click on the plus sign (+) to create a new zone.

2.  Give the zone a name and description. Don't worry about the Zone Transfer Tag field for now; it is
explained later. 

3.  Leave the Zone Type field set to Hostess.

4.  Continue until you have created all your zones.

- Add Seats to the Zones -

1.In the All Zones section, highlight the zone you would like to add seats to.
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2.In the All Seats section, select multiple tables you would like to add to the zone by holding down the
CTRL key while clicking them.

3.Now click the plus (+) sign in the Seats for: Zone (x) section to add those seats to the zone. Click
Yes on the dialog box that pops up to confirm this is what you want to do.

- Create Zone Groups -

Zone groups are needed so that it will be easy to change configurations as servers go home throughout
the night.

Here is an example restaurant that uses 3 different Zone Groups: "4 Servers", "3 Servers", and "2
servers".

- Create Zone Groups -

1.  Make sure you have created all the zones you will need under the All Zones section. Remember, if
for example you want to have a zone group of four zones when you have four servers, a zone group
of three zones when you have three servers, and a zone group of two zones when you have two
servers, this will require nine zones.

A four server zone group could include zones 1-4. (Notice here that table 13 is assigned to both Zone 2
and Zone 3. In this scenario, SoftHost will ask which server to assign the check to because it will see
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there is an option there. The same goes for table 10, which is assigned to both Zone 1 and Zone 4.)

A three server zone group could include zones 5-7.

A two server zone group could include zones 8-9. (This zone group can also be used when there is only
one server; you will just need to assign the same server to both Zone 8 and Zone 9 at the same time.)
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2.  In the Zone Groups section, click the plus sign (+) to add a new zone group. Give it a name.
Leave Group Type as "Hostess."

3.  Now save the changes by pressing the save button .

4.  Select/highlight the Zone Group you want to add zones to.

5.  In the Zones assigned to group section, click the plus sign (+) to add a zone to that group. Click
on the new blank field under Zone Name and click on the drop-down to select a zone you would like
to add. Continue adding/selecting zones until you have added all zones needed for that group.

6.Continue adding the rest of your groups and the zones in those groups by repeating steps 2-4.

- Create Zone Transfer Tags -
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Zone Transfer Tags are used so that servers can be automatically reassigned to another zone as
servers go home and different zone groups must be used. In the All Zones section, click in the field
under Zone Transfer Tag to type in a tag name. You can use any text you want; in the image below,
numbers were used.

In the image above, Zone 1 and Zone 5 have the same Zone Transfer Tag.

Let's say that Zone 1 is in the zone group used when there are four servers and Zone 5 is in the zone
group used when there are three servers.

When a server leaves and there are three servers instead of four, the server who was assigned to Zone
1 will be automatically reassigned to Zone 5 because these zones share the same Zone Transfer Tag.
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14.5 Zone Creator

Under the General section click on Seating/Zones. Select the Zone Creator tab.

Zone Creator

Zones are reserved for use with SoftHost.

The Zone Creator allows you to mass create multiple zones and the zone group they are
part of all at once. However, you will still need to assign seats to these zones as well as any
Zone Transfer Tags under the Zones tab.

Zone prefix
description

When creating zones, it will add whatever you type here to the
beginning of each table number added.

Example: If you want each new zone to be named Zone1, Zone2,
Zone3 etc., type "Zone" here.

Zone type Set this to Hostess.

From ___ To ___ Specify the range of zones you want to create.

Example: If you enter From 1 to 4, zones 1, 2, 3, and 4 will be
created.
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Zone group name Type a name for a new Zone Group you would like the zones you are
creating to be added to.

Zone group type Set this to Hostess.
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14.6 Preferences

Under the General section click on Seating/Zones. Select the Preferences tab.

Preferences

Preferences are reserved for use with SoftHost.

At almost any restaurant, people are going to ask to sit in certain areas of the restaurant, such as
sitting in a booth rather than a table.

Use this section to set up sets of tables that meet certain guest preferences.

Once this is set up, SoftHost is able to look at specific tables that meet the customer's preferences and
create a customized estimated wait time for the availability of those specific tables.

 

- Create Preferences -

1.  Click the plus sign (+) to add a new Preference. Type in a name in the Preference Description
field.

2.  Now save the changes by pressing the save button .

3.  Place a check in the box for "Do not break down averages" if desired.

If the box is checked, the average stay/wait times for this set of tables will be pooled in with the
average of other tables to create a more overall restaurant-wide average.

If the box is not checked, SoftHost will isolate the average for tables in this preference group. This
may be useful if you have an "Outside Seating" preference or other group that includes tables where
people are known to stay longer than if sitting in other areas of the restaurant.

4.Set the SmartHost preference score by moving the slider along the scale.
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If a high value is set for a preference area, SoftHost will work to seat guests at other tables in the
restaurant before these ones. In other words, these seats are highly requested and should be left if
possible for those who request them.

A low value for a SmartHost preference score will mean that the tables will not be weighted any
differently than tables that have no specific preferences assigned.

- Assign Preferences to Tables -

1.  Make sure your hostess layout is selected in the Sections Tab, then go to the Designer tab.

2.Click the Start Designing button.

3.  Click on a table you would like to assign a preference to. Then "Right Click" on the table. A small
option menu will pop up.  Choose "Assign Seat Prefs."

4.Select the preference you would like to add to the table to then click OK.

5.Click "Stop Designing" when finished.
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Tip: You can select multiple tables at the same time by holding down the SHIFT key.  Then you can
"Right Click" on one of the tables that you highlighted, click "Assign Preference", and select a
preference.  This will assign the same preference to all the highlighted tables at the same time.
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14.7 Seating List

Under the General section click on Seating/Zones. Select the Seating List tab.

Seating List
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Seat # This is a list of the seats in the system.

Seat Count This defines how many people can fit at the table.

Type This is automatically filled in based on how you labeled this seat
number when using the Designer (see Designer Tab).

Table Alert
ID

ID of the Table Alert unit that is going to be placed at this table.

Dineblast
Seating #

If you have subscribed to use self-pay, this shows the Dineblast
Seating  IDs you should post at the tables for customers to use.

To generate these numbers, select the Seating List drop-down
menu from the gray tool bar at the very top and then click on 
Generate Table #'s for Dineblast.
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Part 15 Loyalty

Under the General section click on Loyalty.

Loyalty
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Loyalty includes the following:

1. General Settings

2. Visit Setup

3. Point Setup
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15.1 In-Store Loyalty

Under the General section click on Loyalty. Select the In-Store Loyalty tab.

In-Store Loyalty includes the following:

1. General Settings

2. Visit Setup

3. Point Setup

15.1.1 General

Under the General section click on Loyalty. Select the In-Store Loyalty tab and
then the General tab.

Here you setup your general loyalty settings.

- Loyalty -

These options allow you to make individual settings within each store.

Allow daily duplicate
loyalty transactions

This allows a customer to visit a store more than once per day and still
get credit for the visit.

Disable Loyalty Print
Chit

This will prevent the loyalty chit from being printed manually.
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Enable visit scans
without an order

This allows the customer to visit a store but not have to purchase
anything to get credit for the visit.

*Note: One Loyalty Point is given for each dollar spent.

Example: If a customer orders a pizza that is $10.00 then he will get 10 loyalty points.   

15.1.2 Visit Setup

Under the General section click on Loyalty. Select the In-Store Loyalty tab then
the Visits tab.

Here you setup your loyalty visit setting receipt.

- Visit Setup -

 

When setting up the visit count, there are two areas of concern:

1.number of visits required for redemption
2.minimum qualifying amount for a visit

The first setting is always required for the loyalty visit program to work, but the second can be overridden
on the General tab with the Enable visit scans without an order setting (see In-Store
Loyalty->General).

- Visit Redemption PrintOut -

This is the space where you enter what you want your redemption receipt/chit to look like. This will be
printed on the customer receipt if they have the number of visits that are required, so make it easy to read
and understand.
Follow the 40 character ruler so that all type is visible on the receipt.
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15.1.3 Point Setup

Under the General section click on Loyalty. Select the In-Store Loyalty tab and
then the Points tab.

Here you setup your loyalty points settings and receipts/chits.

- Point Setup -

Here you will set up your redemption breakpoints. You can set up as many breakpoints as you want.
Enter the lowest point value first and use the Add button or the down arrow on your keyboard to enter the
next point value. Continue until all breakpoints are entered.

- Point Redemption PrintOut -

This is the space where you enter what you want your redemption receipt/chit to look like. This will be
presented to the customer, so make it easy to read and understand.

Follow the 40 character ruler so that all type is visible on the receipt.

Realize that each breakpoint must have a separate PrintOut entered.

*Note: It is recommended that you add to the receipt footer all of the possible point redemption levels and what
the customer will get once they reach those point levels. This way the customer will know what discounts are
available to them once they reach certain point levels.  Go to Miscellaneous->Receipt Template for instructions on
editing your receipt template.
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15.2 Mercury Loyalty (V1)

Under the General section click on Loyalty. Select the Mercury Loyalty (V1) tab.

- Server Settings Tab -

These settings make it possible to use Mercury Payment Systems to record your loyalty transactions and
use SoftTouch at multiple stores. 

This means that a customer can visit any one of your locations and know that their loyalty visits and
points will follow them to each store.

 

Enable This allows the multi-store function to work.

Merchant ID This is the merchant ID provided to you by Mercury Payment Systems.

Server IP/DNS
Address(es)

Internet address(es) to link to Mercury Payment Systems.

Server Port This is the port used to communicate from your server to the DNS
address.

- Visits and Points Tabs -

The information here is automatically copied over from what was entered under the In-Store Loyalty tab (see 
In-Store Loyalty->Visit Setup and Point Setup).
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15.3 Mercury Loyalty (V3)

Under the General section click on Loyalty. Select the Mercury Loyalty (V3) tab.

***Mercury Loyalty (V3) has been disabled.***
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Part 16 Hostess

Under the General section click on Hostess. 

Hostess
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Hostess includes the following:

1. Hostess Module Setup

2. Hostess Delete Reasons



Version 6.1.16

296



Version 6.1.16

297

16.1 Hostess Module Setup Tab

Under the General section click on Hostess. Select the Hostess Module Setup
tab.

Here you setup your SoftHost module estimate and SmartHost settings.

- SoftHost hostess general settings -

 

Enable hostess system This allows the Hostess functions within SoftTouch to work.

Enable table BUS Mode
status for sections

This will change the color of the tables or seats to green after they have
been cashed out which signifies that the table will be available soon.   A
server or bus boy needs to press that table or a seat in order to confirm
that indeed that table or seat has been bused and is now ready for
seating the next customer.

NOTE: It is very important for the bus boy or server to mark a table in
SoftTouch as bused immediately after they have cleared the table.  This
will help the SmartHost system to give more accurate estimates for wait
times.

Hostess system uses
pager hardware

Enables pager (coaster) hardware to be used in conjunction with
SoftHost so that parties on the waiting list can be handed a coaster that
can be called when a table is available for them.  

Make bused tables
unavailable

If checked, the SmartHost system will see tables that are in "bused"
status as unavailable.

# of available tables to
highlight when not
using SmartHost

This refers to the # of available tables that will be highlighted in blue if
not using SmartHost.  If SmartHost is enabled, then two tables will be
highlighted.

Highlight timeout This sets the number of seconds to highlight tables.
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# of minutes to
transfer call aheads to
waiting list

This sets the number of minutes before a call ahead's scheduled arrival
time to be transferred into the waiting list.

# of minutes to delete
a no show for call
aheads

If a call ahead has not arrived by x minutes past their scheduled arrival
time, they will be automatically deleted.

- SoftHost module estimate and SmartHost settings -

Disable SmartHost   Disables the SmartHost system. The Hostess system can still be
used without SmartHost enabled, but you will not get any wait time
prediction.

Round estimates up
(closest 5 min)

  All SmartHost estimates will be rounded up to the nearest 5 min. 
For example, a 12 min wait time estimate will be rounded to 15 min.

Auto adjust estimated
times from accuracy %

  Increases the wait time in relation to the accuracy percentage.  If
the accuracy percentage is 75%, this option will increase the
predicted wait time by 25%.

Only upgrade to ___
seat up

  Maximum table upgrade from a certain party size.  For example, if
set to 2, a party of 2 can only be upgraded to a table for 4 (and not
a table for 5 or more).
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Min. # of minutes for a
table upgrade

  Waiting party will not be upgraded to a larger table until the number
of minutes you enter here has passed.

# of hours to estimate
wait times

  The SmartHost system will only estimate wait times based on the
past # of hours you enter here.  For example, if you enter 3 hours,
the SmartHost system will only calculate wait times from averages
over the past 3 hours of business. 

Increase over average
estimates by ___

  If a table exceeds the time after which it was predicted to be
available, then the SmartHost system will increase the wait time for
this table by the percentage you enter here.

Min % for guest
average

  If this is set to 10%, for example, then if at least 10% of the current
tables in the restaurant have parties of 2, then SoftHost will create a
separate average for them.  On the contrary, if there is only 1 party
of 2 and 12 parties of 4, then the time from the party of 2 will just
get thrown into the average with the parties of 4.

Use ... to calc averages   There is a choice to calculate averages based on the time from when
the check was opened to when the table was bused or to when the
check was closed.

Employee rotation   By check count - This will assign the next table to the employee
that has the lowest number of active checks.

  By rotation - Tables will be assigned to employees by rotation,
meaning that if there are four servers working, the first employee on
the list will be assigned to serve the first, fifth, ninth (and so on)
parties to be seated.

*Note: This may not hold true while a wait is an effect, at which
time parties will be seated in whichever server zone that has a table
available.

Assignments can also be manually overridden.

- Smart Host Scoring System -

This slider controls how the SmartHost system will assign tables.   
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More table match:  The more you move the slider to the right, the more SmartHost will try to get an exact match for
parties and their preferences.  This may slightly increase wait time, but parties are more likely to get seated at their
preferred table with this setting.

Less wait time:  The more you move the slider to the left, the more SmartHost will try to decrease the wait time by seating
parties at tables that may not exactly match their preferences or party size. 

SmartHost optimized default values: This button will reset all Hostess settings to their optimized default.

Note: SmartHost can be manually overridden at any time by the person operating the Hostess program.
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16.2 Hostess Delete Reasons Tab

Under the General section click on Hostess. Select the Hostess Delete Reasons
tab.

- Hostess Delete Reasons -

Here you can setup reasons for deleting a party from the waiting list in the SoftHost package.

When you delete a party from the waiting list, you will be asked to select one of the reasons that you set
up here.

To add a Hostess deletion reason, click on the  Add button, enter a new reason and click the   Save

button to save when you are finished.
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Part 17 SoftTouch Msgs

Under the General section click on SoftTouch Msgs.

SoftTouch Msgs
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You will see a list of any SoftTouch messages that the site could benefit from.  To view a message,
highlight the appropriate message from the Message List and press Get Messages.
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Part 18 Hardware Section

The Hardware section.

The Hardware section contains the following:

1. Stations

2. Self-Pay

3. Printers/Coursing

4. Pole Display

5. Caller ID

6. Credit Cards

7. Pager/Alerts

8. Email/SMS

9. Dineblast Mobile
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Part 19 Stations

Under the Hardware section click on Stations.

Stations

Stations explanation includes the following:

1.  Stations

2.  Options

3.  Order Functions

4.  Security

5.  Hardware Devices

6.  Tax

7.  Price Schedules

8. Menus

9. Sharing
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19.1 Station Tab

Under the Hardware section click on Stations. Select the Station tab.

Station

All the stations that you add show up under the Station list part of the screen.

By default, anything with just a black arrow next to it is what is highlighted/selected.

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Stati
on #

This is the SoftTouch record number for this station.

Activ
e

This box is checked by default when you create a new
workstation.  It must be checked for the station to operate.
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Loca
tion

This is the name you assign to the station. 

IP
Addr
ess

This is the station's IP address. 

Get
IP

Under Station List, select/highlight the name of the
workstation you're on, then press the Get IP button. The IP of
the selected workstation you are on will automatically fill in the
IP of the computer you are on.

*Note: This can only be done for the workstation you are
physically at.

Stati
on
Type

Your choices from the drop down are:
SoftTouch Station - used for SoftTouch POS workstations
SoftTouch iTable - used for the iTable, table mounted solution
Dineblast Online Station - used by SoftTouch when setting up
online menus
Self-Pay Station - used for Self-Pay Kiosk
Dineblast Mobile Station - reserved for future use
SoftTouch iPOS Station - used for the iTouch hand held devices
SoftTouch iKiosk Station - used for the iKiosk stations

Reve
nue
Cent
er

You select the revenue center you want this station to report to
from the drop down.  To learn more about Revenue Centers
now, click Revenue_Centers.

Devi
ce ID

This is where you enter the Device ID if using the iTouch hand
held solution.

Note
s

This is an optional field where you can clarify what this station
is used for with a longer description than used in the Location
field.
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19.2 Options Tab

Under the Hardware section click on Stations. Select the Options tab.

Options

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Miscellaneous

Cashout
Using
Enter Key

If checked, allows you to hit Enter key on the keyboard when on the cashout screen. Equivalent of pressing the
Enter button on-screen.

Print
Voided
Check

When this option is checked voided checks will be printed.

Print
Voided
Items

When this option is checked voided items will be printed.

Disable
immediat
e printing

When an employee rings up a delivery order, you have the option to print the check when the payment is applied or
when send is hit, or you can wait until the order is dispatched to a driver.  If you wish to wait until the order is
dispatched to a driver, check this option box.

Force
seat stats

When this option is checked a server will have to enter customer statistics for each person on a table, such as
gender and age group.  The system will then keep track of the appetizers and desserts most frequently ordered for
each demographic and can display suggestions in the Upsell display.
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Force
seat
name

When this option is checked a server will have to enter the customer's name occupying the seat.

Show VAT
amount
on screen

When this option is checked the value added tax is displayed for liquor items.

Display
upsells

When this option is checked all upsells (from Items & Stock and from Seat Statistics) are appropriately displayed.

Lock/Dis
able
Station

When this option is checked you will not be able to take orders in SoftTouch from that station.

Enable
Quick
Quantity
Buttons

Puts the quantity buttons across the top of the screen for fast ordering of large quantities of an item.  Makes it very
easy to punch in 6 Buds, for example.

En
ab
le
Cr
ed
it
Ca
rd
In
te
rf
ac
e

When this option is checked the station will allow credit cards to be accepted.
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19.3 Order Functions

Under the Hardware section click on Stations. Select the Order Functions tab.

Order Functions



Version 6.1.16

315

Order function explanations include the following:

1.   Enable/Disable

2.   Counter

3.   Dining

4.    Bar

5.   TakeOut

6.   Delivery

7.   Pickup

8.   DriveThru

9.   iTable

10. iKiosk

11. Online

19.3.1 Enable/Disable

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Enable/Disable tab.

Enable/Disable
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First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

- Station Functions -

1.  Under this list is all the options for Functions/Modes that can be displayed in the POS system. Enable
only the functions needed by the restaurant.  

The List:

Calculator Useful when the cashier/server needs to figure out how to evenly split
a tender between two cash tenders to get the proper change. 

Open Drawer If the drawer is set to "manual open" this option will let you manually
pop open the drawer.

Order History This button will allow you to pull up a history of the last checks rung
to reopen a check, reprint a check, adjust a payment on a check or
add a credit card tip to a check.
The number of checks that will be displayed is determined by what
you set in the System applet under the General tab (see 
System->General Tab for more information).

Caller ID The Mode that lets you get into the Caller ID area to answer the
incoming calls. Only needs to be enabled if you have Caller ID set up
for your system.

Info Gives information about SoftTouch; cannot be unchecked.

Delivery Enables Delivery Mode.

Driver Dispatch If you have Delivery Mode Checked on, you must also have the Driver
Dispatch area checked on, because Driver Dispatch is where you
assign the deliveries to the drivers.

Counter Enables Counter Mode on the highlighted workstation.

Take Out Enables Take Out mode on the highlighted workstation.

Drive Thru Enables Drive Thru mode on the highlighted workstation.

Pickup Used in Conjunction with Counter (if Counter mode is not set to cash
out immediately), Take Out, and Drive Thru modes. This is the section
the checks are placed in for cashout purposes.
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Bar Enables Bar mode on the highlighted workstation. 

Dining Enables Dining mode on the highlighted workstation.

Employee Enables Employee mode. This mode is where the employees can view
their checks, assign drawers, etc.

System Enables System mode. This is where the Managers can overview
checks, get into House Accounts, do a Manual Z, etc.

2. To enable any of the modes listed, place a check next to that item under the Visible column. Anything
unchecked will not be displayed for the station selected.

Example:
 

- Display Order -

1. You can click and drag on the functions/modes that are checked on for visibility in this section. Once
you have dragged and dropped the list into the order in which you would like it displayed in the POS
system you can click the Save New Order button.

2. If you click the Refresh button before you click the "Save New Order" button, the list will refresh back to
the original state. Once you have clicked the "Save New Order" option, if you move some things and then
click refresh without clicking Save New Order, it will default to the last order of the list you saved.

19.3.2 Counter

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Counter tab.

Counter
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First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Lock
Down

If checked, once you enter counter mode, the system will stay in counter
mode until another mode is selected.
 

Print
Receipt

If checked, you will get a receipt for every transaction rung in counter
mode.

Disable
Send/
Suspen
d
Button

If checked, you will not be able to Send an order while in counter mode.

Ask
Coaste
r

If checked, you will be prompted to enter the number assigned to the
coaster you give the customer to page them when their order is ready.

Ask
Dine
In/To
Go

If checked, you will be prompted to select whether each counter order is
a Dine In order or a To Go order.

Ask
Custom
Field

If checked, you will be prompted to enter information pertaining to the
custom field you set up.
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Ask
Name

Your options from the drop down are:
Ask name on "Send" - you will be prompted for customer name only

when using Send
Ask name on "Cashout" - you will be prompted for customer name only

on Cashout
Ask name on "Send/Cashout" - you will be prompted for customer name

with Send or Cashout
Don't ask for a name - you will not be prompted for a customer name

* If left blank, you will not be prompted for a customer name.

19.3.3 Dining

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Dining tab.

Dining

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

- Dining Options -

Lock Down If checked, once you enter Dining mode, the system will stay in Dining
mode until another mode is selected.

Auto
PreAuthoriz
e on new
check

With this selected, if you ring a check in dining mode and go to the cashout screen,
you will see a pre auth button that is automatically on.  You can now swipe a card
and it pre-authorizes the credit card rather than closing the check.  This can be done
by station.
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Disable Print
Check
Button

If checked, the Print button will not work in Dining mode on the
highlighted workstation.

Ask for RFID
card
assignment
for the order

This should most likely be left unchecked except for use with self-pay
stations.

- Tips Options -

Do not ask
for a tip at
cashout

When you select this option, you will not be asked for a tip when you
apply a credit card payment to a check.

Ask for a
tip at
cashout
before
approval on
media with
tip

When you select this option, you will be asked to enter a charge tip
before the receipt is printed for the guest to sign when you apply a credit
card payment to a check.

Ask for a
tip at
cashout
after
approval on
media with
tip with
credit card
interface
enabled

When you select this option, you will be asked to enter a charge tip after
the receipt is printed for the guest to sign when you apply a credit card
payment to a check.

Dining
Section

Select the layout you will be using for Dining mode from the drop-down. I
f you wish to learn more about this feature now go to 
Seating/Zones->Designer Tab.
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Check
display
style

You can select one of the following Check display styles form the drop
down:

· Seating List/Floating List
· Seating Full/Floating List
· Seating List/Floating Full
· Seating Full/Floating Full

Seating refers to checks at a table or seat and Floating refers to orders
that are not attached to a certain table or seat (if someone orders a drink
from the bar but walks around, for example). When you view all seating
of floating checks in SoftTouch, List will show basic details of checks and
Full will show the actual check images. List allows more to be viewed at
once. Full may take longer to load on some computers.

19.3.4 Bar

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Bar tab.

Bar

First select the station by highlighting it from the Station list part of the screen. This is the
station you will be making changes to.

- Bar Options -

Lock Down If checked, once you enter Bar mode, the system will stay in Bar mode
until another mode is selected.
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Ask name at
bar

If checked, you will be prompted to assign a name to each bar order.

Auto
PreAuthoriz
e on new
check

With this selected, if you ring a check in bar mode and go to the cashout screen, you
will see a pre auth button that is automatically on.  You can now swipe a card and it
pre-authorizes the credit card rather than closing the check.  This can be done by
station.

Disable/
Hide Print
Check
Button

If checked, the Print button will not work in Bar mode for the highlighted
workstation.

Disable
Quick
Bar

Quick Bar is a feature that will allow an employee to ring up sales and
close them out without assigning the check to a table or running a tab. 
It is designed for high speed scenarios where the bar will close out the
checks as they ring them, for a pay as you go situation.  

- Tips Options -

Do not ask
for a tip at
cashout

When you select this option, you will not be asked for a tip when you
apply a credit card payment to a check.

Ask for a
tip at
cashout
before
approval on
media with
tip

When you select this option, you will be asked to enter a charge tip
before the receipt is printed for the guest to sign when you apply a credit
card payment to a check.

Ask for a
tip at
cashout
after
approval on
media with
tip with
credit card
interface
enabled

When you select this option, you will be asked to enter a charge tip after
the receipt is printed for the guest to sign when you apply a credit card
payment to a check.
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Bar
Section

Select the layout you will be using for Dining mode from the drop down. I
f you wish to learn more about this feature now go to 
Seating/Zones->Designer Tab.

Check
display
style

You can select one of the following Check display styles form the drop-
down:

Seating List/Floating List
Seating Full/Floating List
Seating List/Floating Full
Seating Full/Floating Full

19.3.5 TakeOut

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the TakeOut tab.

TakeOut

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Lock
down

If checked, once you enter Takeout mode, the system will stay
in Takeout mode until another mode is selected.
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Ask
Date
Time
Stamp

If checked, the system will prompt the user for a date and time
at the beginning of each transaction.

Print
Receipt

If checked, you will get a receipt for each transaction rung in
Takeout mode.

New
Takeout
Order
Options

You can select one of the following Takeout Order Options form
the drop down:

Search for a customer - This will bring up a customer's past
order history.

Do not search for a customer - This requires customer
information but does not bring up past order history.
Fast takeout only - This does not require customer
information or bring up or create order history.

19.3.6 Delivery

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Delivery tab.

Delivery

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Lock
down

If checked, once you enter Delivery mode, the system will stay
in Delivery mode until another mode is selected.

Ask
Date
Time
Stamp

If checked, the system will prompt the user for a date and time
at the beginning of each transaction.
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19.3.7 Pickup

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Pickup tab.

PickUp

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Show
counter
orders

If checked, you will see any Counter orders that were sent,
rather than closed, in Pickup mode.

Show
takeout
orders

If checked, you will see any TakeOut orders that were sent,
rather than closed, in Pickup mode.

Show
drive
thru
orders

If checked, you will see any Drive Thru orders that were sent in
Pickup mode.

Sort
pickup
order
by

You can select one of the following "Sort pickup order by"
options form the drop-down:
Check date/time ascending
Check date/time descending
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Display
filter

Used in a dual drive through scenario.

19.3.8 Drive Thru

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Drive  Thru tab.

Drive Thru

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Lock
down

If checked, once you enter Drive Thru mode, the system will
stay in Drive Thru mode until another mode is selected.

Print
Receipt

If checked, you will get a receipt for each transaction rung in
Drive Thru mode.

19.3.9 iTable

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the iTable tab.
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iTable

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Seating
#

Enter the table number where this iTable device (highlighted
above) will be located.

Table
inactivity
timeout

Enter the amount of time this device should go unused, in seconds,
before the device reverts to the welcome screen. 

Cashout
Timeout

Enter the number of seconds that you wish the station to stay on
the cashout screen before it times out.

Final
Screen

If you wish the screen to display a final message, enter it here.

19.3.10 iKiosk

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Kiosk tab.
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iKiosk

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Can the
Station
Cashout

If checked, you will be able to cash out from the kiosk.

Print
Receipt

If checked, you will be able to print a receipt from the kiosk,
providing you have the station set up to print properly. (To learn
more about setting up printing, see Printers/Coursing).

Auto
Close to
Cash

This should most likely be left unchecked but is available for special
meta payment situations; automatically closes as a cash payment.

Ask Dine
In/To
Go

If checked, the system will ask if the order is dine in or to go with
each transaction.
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Ask for
tip (on
media
w/tip)

If checked, you will be asked for a tip when cashing out to a credit
card at the iKiosk.

Kiosk
inactivit
y
timeout

Enter the number of seconds that you wish the station to stay
active before it times out.

Ask
Name

Your options from the drop down are:
Ask name - you will be prompted for customer name
Don't ask for a name - you will not be prompted for a customer
name

Cashout
Timeout

Enter the number of seconds that you wish the station to stay on
the cashout screen before it times out.

Final
Screen

If you wish the screen to display a final message (e.g., Please pay
at the cashier station), enter it here.

19.3.11 Online

Under the Hardware section click on Stations. Select the Order Functions tab,
then select the Online tab.

Online

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Display
online
alerts

If checked, an alert will appear on the screen of this
workstation any time an online order is placed.  This is used in
conjunction with online ordering.
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19.4 Security Tab

Under the Hardware section click on Stations. Select the Security tab.

Security

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

General:

Disable clockin Disables employees from being able to clock in on specific stations.
This can help an owner or manager keep track of payroll by forcing
them to clock in or out on a station that is in plain view.

Can the station
cashout

If this option is not checked you will not be able to cash out at that
station; you will only be able to take orders. So check this option if
you want to be able to cash out at the highlighted station.

Force tenders
(disable enter
key & fastcash)

Forces employees to enter an exact tender amount.  They will not be
able to cashout simply by hitting the Enter button.  For example, if the
customer hands them a $20.00 for a check total of $19.24, they must
enter "$20.00" in SoftTouch.  The FastCash key will also be disabled.
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Allow drawer to
be opened while
in an order

If checked, you will be able to open the cash drawer (see SoftTouch
button below) using the "No Sale" button while in the middle of the
order.  Used most often to make change for a customer while in
counter mode.

*Note: The restaurant needs to be aware that this can cause security
issues if the drawer can be opened in the middle of an order.

System Timeouts

Login Screen
Theme

You can change login screen theme: traditional or black.

Station inactivity
timeout

Set the time (in seconds) when the system will go to the login screen
after an order when on the main (chalkboard) screen.

End of bar order
inactivity timeout

Sets the time (in seconds) when the system will go to the login screen
after an order when in Bar mode.

End of dining
order inactivity
timeout

Sets the time (in seconds) when the system will go to the login screen
after an order when in Dining mode.

Spotter/Cashout Display

Spotter
Display

If checked, you will see a Spotter Display when orders are cashed
out, that will display the Total of the check and the Change due to
the customer in a very large print so a manager can spot check
orders.

Cashout/Spott
er Timeout 

Allows you to specify the time (in seconds) after a check is cashed
out before you will be automatically returned to the floor layout or
chalkboard.
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Disable
employee to
quickly exit

If checked, you will not have access to the Yes button to quickly
exit the Cashout Spotter screen.  The screen will stay on for the
specified number of seconds and then the system will automatically
exit the Cashout Spotter screen.
 

Confirm
before closing
the sale

If checked, you will need to press Yes or No to verify the amount
tendered on the Cashout screen.
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19.5 Hardware Devices

Under the Hardware section click on Stations. Select the Hardware tab.

Hardware

Hardware explanations include the following:

1.   Drawers

2.   Printers

3.   MSR

4.    Fingerprint

5.   Caller_ID

6.   Pole_Display

7.   Liquor_Dispensing

8.   Scanners/Other

9.   Scale

10. TVS_Cameras
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11. Coin Dispenser

19.5.1 Drawers

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Drawers tab.

Drawers

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Name You will enter the name of the cash drawer in this field.  If you
have 2 cash drawers, you may want to name them Cash Drawer 1
and Cash Drawer 2. To add additional drawers, use the Add button
above, in the blue bar. The name can be entered in the list of
Drawer names on the left or in the blank field on the right.

Interfac
e

You can select one of the following Interfaces:
No Interface
Printer Interface
OPOS Interface
M-S Cash Drawer USB Interface
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Position If you have more than one cash drawer attached to a workstation,
you can select position 1, 2, 3 or 4 depending on where the cash
drawer is plugged in.

OPOS
Name

If this is an OPOS drawer, enter the OPOS name here.

Can be opened
manually

If checked, you will be able to perform a No Sale (opening the
drawer between sales)   from this workstation.

Drawer
compulsion
(USB support
only)

How With this option selected, you must close the drawer before
you can ring a new order. You need a USB drawer from MS Cash
Drawer for this to work.

Timeout for
drawer to be
closed

How many seconds the station should wait before displaying a
message for the employee to close the drawer.

Allowable tills
to be used with
this drawer

Clicking on the space below Till Name will activate a drop-down
from which you can select a till that will be used with the
highlighted cash drawer. To add another till, use the Add button
below this section.

To add a till that is not on the list, press the Create button, but
you may need to  go to the Banks applet to adjust its settings.
Another option is just to create a new till using the Banks applet
and then return here, where it will now appear on the drop-down
list.

19.5.2 Printers

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Printers tab.
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Printers

 

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Check Print
Group

From the drop-down list of printers set up in Windows on the selected
station, select the printer you wish to print the 40 column guest check.

Receipt Print
Group

From the drop-down list of printers set up in Windows on the selected
station, select the printer you wish to print the 40 column receipt.

Other Print
Jobs

From the drop-down list of printers set up in Windows on the selected
station, select the printer you wish to print all other print jobs.

Report Printer From the drop-down list of printers set up in Windows on the selected
station, select the printer you wish to print the 80 column reports.

Printers to
ignore for
remote
printing

You can opt to have the selected station ignore remote printing to a
particular remote printer.  This is useful if you have a bar remote
printer and you wish drinks to send to the bar remote printer when
servers ring up from a server station, but not have drinks print to the
bar remote printer when the bartender rings up drinks from a bar
station. To ignore multiple printers for remote printing, use the Add
button and select additional printers.

For more information on setting up printing, see Printers/Coursing.
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19.5.3 MSR

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the MSR tab.

MSR

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

If you are using an OPOS MSR, enter the OPOS name here.

19.5.4 Fingerprint

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Fingerprint tab.

Fingerprint

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

You can select from the following options:

Disable Biometrics - if selected, fingerprint readers will not work
Enable Biometrics Globally - if selected, fingerprint readers will work for ringing sales as well as time

clock and override functions
Enable Biometrics for Time Clocks Only - if selected, fingerprint readers will work for time clock only
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Enable Biometrics for Overrides Only - if selected, fingerprint readers will work for overrides only
Enable Biometrics for Overrides & Time Clocks Only - if selected, fingerprint readers will work for time

clock and override functions

19.5.5 Caller ID

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Caller ID tab.

Caller ID

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Enable
Caller
ID
Interfac
e

This box must be checked for Caller ID to work on this workstation.

Caller ID
Notificat
ion

You can select from the following options:
No notification - if selected, you will not be notified when a call

comes in
Popup notification - if selected, you will get a popup notification
with the customer's name and phone when a call comes in

19.5.6 Pole Display

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Pole Display tab.

Pole Display
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First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

- Assign Pole Display -

 

Enable pole
display

If checked, the pole display is enabled. To disable, simply uncheck the
check box.

Pole Display
Code

From the drop-down menu choose a pole display. For pole displays to show
up here, you have to set them up using the Pole Display applet. 

COM port Specify the COM port that pole display is connected to on the workstation.

OPOS This is used for NCR machines that employ OPOS drivers to display.  Leave
blank if using a normal serial pole display.

Pole Message Enter the message to be displayed when pole display is idle.

19.5.7 Liquor Dispensing

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Liquor Dispensing tab.



Version 6.1.16

340

Liquor Dispensing

Liquor Dispensing Interface

This is where you configure your liquor dispensing settings. We currently use the Berg "Basic"
interface, so to ensure compatibility check with your manufacturer that they also use the standard
Berg "Basic" interface.

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

- Serial Interface (Berg "basic" specifications) -

Check the Enable liquor dispensing box if you are connecting a liquor dispensing unit and want
SoftTouch to interact with it.

COM Port This is the COM port used on the computer.

Baud Rate This is the speed of data transfer (typically 9600).

Parity This is typically set to None.

Data Bits This is typically set to 8.

Stop Bits This is typically set to 1.
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19.5.8 Scanners/Other

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Scanners/Other tab.

Scanners/Other

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Name This is the name of the device at the station.  You can name it
whatever you want, typing the name into either the space in the list
on the left or the blank field on the right. To add more device names,
use the Add button.

Active This box must be checked in order for the selected device to be
active.
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Message ID Used in conjunction with the Paging/Alert system.  This is the
message to be displayed on the server's pager when a chef scans a
barcode to tell them to come pick up the food.  This will tell the server
WHERE to go to get the food.  Put something like "Chef Station 1" or
"Chef Station 2."  If you only have one place where the servers pick
up the food, then this can be left blank.

Device Type This is type of device you are setting up:

Serial
Bluetooth
Keyboard

USB or PS/2 type scanners should be set to Keyboard.

Transmit Type Front End Code Mode - With this option you can:

· Look up tickets in System > Overview
· Assign deliveries to a driver 
· Automatic Item scanning
· Look up tickets in the Pickup section
· Pickup checks while on the Dining or Bar seating layouts

Back End Mode - This mode is designed to be used in conjunction
with a pager system so that servers will be alerted when the chef has
finished making food. A scanner set to "Back End Mode" would be
placed in the kitchen with the Chefs.
 
· Chef will scan an order in the kitchen when food is ready so that the

server will be paged.

· Server will scan the order when they pick up the food and bring it to
the table.  This marks the food as "served" so that they will stop
being paged. 

Convert to Keyboard Data - Anything coming through the serial
port will get converted to keyboard data.

Coaster Mode Only - Use this mode if the restaurant is using
coasters only and not pagers.  The coasters are given to customers
and are called by scanning a bar code on the kitchen ticket when the
customer's food is ready.  

Pager Mode Only - Use this mode if you are using employee pagers,
but not coasters.  

- Serial Settings -

If you are using a keyboard device, you can ignore these settings.
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Baud Rate This is the speed of data transfer (typically 9600).

COM Port This is the serial communication port.

Terminator Terminating signal (typically 13).

Display LCD
feedback

When checked, displays feedback text to a scanner with an LCD
display.

Clear Display code Display codes for the LCD.  Refer to your manufacturer's manual for
this code.  Must be in decimal format.

Display Start Delay Number of milliseconds to wait before displaying LCD feedback after a
scan. This is useful if the scanner has a default message after a scan
and you need to wait until that message is cleared before displaying
feedback.

Display End Delay Number of milliseconds to wait before clearing the LCD feedback.

You can test a serial device by pressing the  button, then scanning a barcode of some
kind.  Any data passed through the serial port will show up in the Serial port  test results window.
If no data is showing, check to make sure your com port assignment is correct.  When you are

finished testing, click the  button.  

*NOTE: You must exit the softclient.exe which you will find in the system tray  while testing
the scanner using the 'Start Device' and 'Stop Device' buttons.  Once you are finished, restart softclient.exe. 
It can be found in the SoftTouch folder on the C drive or in your start menu programs under SoftTouch.  Also,
after making any changes to the scanner settings, you must exit and restart the SoftClient.

Keyboard Settings:  

If you are using a serial device, you can ignore these settings.
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Prefix The prefix that is programmed into your scanner.  This field requires an
Ascii code.  For example, if your prefix is a an Ampersand (&), that
would correspond to a 38 in Ascii code.  For instructions on
programming a prefix into your scanner, refer to the manufacturer's
user manual.

Suffix The suffix that is programmed into your scanner.  This field requires an
Ascii code.  For example, if your prefix is an asterisk (*), that would
correspond to a 42 in Ascii code.  For instructions on programming a
suffix into your scanner, refer to the manufacturer's user manual.

Allow Keystrokes Don't use; leave unchecked.

*NOTE: If you are using a PS/2 or USB "keyboard wedge" barcode scanner, then there are certain
characters you should avoid for the prefix and suffix. The reason for this is because there are certain
characters that may conflict with characters read from magnetic swipe card readers.

The following characters are what is
recommended for either a prefix or
suffix.

ASCII Code Character Value

126 ~

42 *

35 #

Do NOT use the following characters
for the prefix or suffix of your
barcode scanner (they may conflict
with swiping credit cards):

ASCII Code Character Value

37 %

59 ;

94 ^

63 ?

47 /

36 $

61 =
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19.5.9 Scale

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Scale tab.

Scale

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

Enable Scale
Interface

Check this on if you have a scale hooked up to the station that you
would like to have enabled. 

*Note: Remember, ALL SCALES must use NCI Serial Protocol!

COM Port Specify the COM port that pole display is connected to on the
terminal.

Baud Rate This is the speed of data transfer. 

*Note: To get this information you would have to look at the set-up guide
booklet that came with the scale.

Parity This is typically set to None, but check the set-up guide for the scale
before you set it to none.
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Data Bits This is typically set to 8, but check the set-up guide for the scale
before you set it to 8.

Stop Bits This is typically set to 1, but check the set-up guide for the scale
before you set it to 1.

Scale Timeout
(seconds)

Use the Scale Timeout to set how long the item being weighed can sit
on the scale before it is timed out. Keep in mind this goes by
seconds. 

Scale Wait
(milliseconds)

Use the Scale Wait to set the amount of time the readings from the
scale show up in the POS system before the pop-up box is closed.
Keep in mind this goes by milliseconds.

Read Data Used internally.

19.5.10 TVs Cameras

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the TVS Cameras tab.

TVs Cameras

SoftTouch can export transaction text to TVS security cameras.  The text can then be overlayed on
top of the video at the time of the transaction.  Any TVS camera interface should work as long as it
supports TVS V1.03 specifications. Talon DVR is recommended (www.possmi.com).

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

TVS Settings

http://www.possmi.com
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Enable TVS
Cameras

This allows communications with the TVS
cameras.

Server IP Address This is the address of the TVS server.

Server Port This is the port number open for communication
to the TVS server.

19.5.11 Coin Dispenser

Under the Hardware section click on Stations. Select the Hardware tab, then s
elect the Coin Dispenser tab.

Coin Dispenser

First select the station by highlighting it from the Station list part of the screen. This is the station you
will be making changes to.

If you are using an OPOS Coin Dispenser, enter the OPOS name here.
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19.6 Tax Tab

Under the Hardware section click on Stations. Select the Tax tab.

Tax

Here you specify which tax table will be used at the currently selected station.  If you do not add a tax to
the station, the station will not charge tax, even if the items being ordered on that station have a tax
assigned.

To set up a tax table so it is available from the drop-down list, go to Financial->Tax Table.

*Note: You can add multiple taxes per station if necessary. Use the  button to do so.

*Note: If none of your items are non-taxable, you do not have to create a tax table or assign any to a station.

*Note: If you set up a tax table and do not assign it to ANY workstations, the system
has a fail-safe built in that will assign tax to ALL stations. If you have the tax assigned
to only one workstation, it will only be applied at the one workstation and none of the
others.
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19.7 Price Schedules Tab

Under the Hardware section click on Stations. Select the Price Schedules tab.

Price Schedules

Price schedules assigned to this station

 

1. Select a station from the Station list part of the screen.

2. Click in the white space under ScheduleName for the drop-down arrow to show up. 

3. Click the drop-down arrow and you will see all the Schedules you have created. Choose the desired
price schedule.

2. Click the  button to assign additional price schedules to this station.

You have to add the schedules that are pertinent to this station. If you do not know then add all the
schedules.

If you need to create schedules so that they will show up in the drop-down list, go to 
General->Scheduling->System Schedules.

- Copy Price Schedules - 

When this is finished you may copy these price schedules to other workstations.

1. Press and hold Ctrl key on your keyboard while clicking on the price schedules you wish to copy. The
selected ones will be highlighted now.

2. Click the  button.
3. Select another workstation from the Station list part of the screen and under Price Schedules click

the  button.

You have now copied the selected price schedules to another station.
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19.8 Menus Tab

Under the Hardware section click on Stations. Select the Menus tab.

Menus

Here you assign menus and their schedules to the currently selected station.

- Assign Printers -

Step 1.

Select a station from the Station list part of the screen.

Step 2.

Under the Station Type column click in the white space. Then click the drop-down arrow and choose a
Station Type the menu you are about to assign will be accessible from.

Step 3.

Choose the menu name by clicking in the white space under the Menu Name column and using the
drop-down list. You created menu names under Item Builder->Main Menus.

Step 4.

Under Schedule Name click in the white space and from the drop-down menu you will see all the
schedules you created in Scheduling->System Schedules. Choose a schedule for that menu. This is the
time that this menu is available. See image below:
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Step 5.

You must continue linking menus to all station types that you will be using (example: Take Out, Counter,
Delivery, Bar).

Click the  button and repeat the steps above for all station types and menus needed for this
workstation.

-Copy Menus -

You can copy this to other Stations/Terminals.

1. Press and hold Ctrl key on your keyboard while clicking on all the station types you wish to copy. The
selected ones will be highlighted now.

2. Click the  button.

3. Select another workstation from the Station list and under Menus click the  button.

You have now copied the selected menus to another station.
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19.9 Sharing Tab

Under the Hardware section click on Employees. Select the Sharing tab.

Station Sharing

Station sharing is used when you want to grant certain access from one station to another. 

When this option is used, the staff using the station that is listed in the Station Name field will
have specified access to that station (Cash out only or Full Access) and both of the terminals will
be responsible for the drawer total.

*Note: This is not the same as the option "Pickup all employee checks" under Employee Tab/Security
setup, which allows access to every employee's checks. Station sharing is used more often in a cashier
situation.

 

Example: In the image above, you see that we added Terminal 1 to the selected workstation and gave it
"Cash out only" access. What this does is enable a user from the selected workstation to cash out orders
entered at Terminal 1. If we were to grant Full Access here, then a user from the selected workstation
would be able to edit the checks entered at Terminal 1 as well as cash them out.

- Add Station Sharing -

Click the white spaces under Station Name and Access to activate the drop-down lists and
make your selections.

Use the  button to specify additional station sharing arrangements.

Click the  button when you are finished.

- Delete Station Sharing -

To delete, select a shared Station Name and click the  button. Click "OK" to the
confirmation dialog ("Delete record?").



Version 6.1.16

Part

XX
Self-Pay



Version 6.1.16

354

Part 20 Self-Pay

Under the Hardware section click on Self-Pay. 

Self-Pay

Self-Pay setup:
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Auto timeout to start
screen

Amount of time (in seconds) that will be allowed to pass before a
message pops up to ask the customer if he/she needs more time.  If
they do not reply then it will abort the customer's cashout progress and
go back to the main screen.

Minimum Tip
Suggested #1

You may enter a number to represent a suggested gratuity.  If you wish
to suggest a 20% gratuity, for example, enter 20 here.

Minimum Tip
Suggested #2

You may enter a number to represent a second suggested gratuity.  If
you wish to suggest a second gratuity of 18%, for example, enter 18
here. 

Minimum Tip
Suggested #3

You may enter a number to represent a third suggested gratuity.  If you
wish to suggest a third gratuity of 15%, for example, enter 15 here.

Problem text Enter the text you would like to appear on screen when the user sees a
problem with their order and presses the "I see a problem" button.

Completed text for
dining

This text will appear upon completion of paying for a dining order.

Completed text for
pickup

This text will appear upon completion of paying for a pickup order.

*NOTE: Upon purchasing a Self-Pay machine, complete setup instructions will be included.



Version 6.1.16

Part

XXI
Printers/Coursing



Version 6.1.16

357

Part 21 Printers/Coursing

Under the Hardware section click on Printers/Coursing. 

Printers/Coursing

Printer Setup holds the following settings:

1. Printer Settings

2. Print Codes

 3. Add Printers

4. Create Print Groups, Assign Printer to Print Group

5. Coursing
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21.1 Settings Tab

Under the Hardware section click on Printers/Coursing. Click on the Settings
tab.

Settings 

- Printing Settings -

Enable all printing Enables all kitchen and receipt printing.

Disable printing for remote only Disables all of the kitchen items printing.

Disable printing for
receipt/check printouts only

Disables all receipt printing, but enables kitchen tickets.

Disable printing for all Disables all printing.

- Default Printer -
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You will need to select the default printer that this workstation is using from the drop-down list.  The
printer will need to be set up in Windows before you will see it in the drop-down.  This should be done
from each workstation where you select the printer that will be used for that workstation.

1.  Select the printer from the drop-down list.
2.  Press the Set as Default Printer button.
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21.2 Print Codes Tab

Under the Hardware section click on Printers/Coursing. Select the Print Codes
tab.

Print Codes

Several print codes come predefined with the installation of SoftTouch.  
However, if you have a different printer you must enter its codes here. You will need to find those printer
codes from the manual that came with that printer.

*Note: The Samsung 350 codes will work with the Epson TM88 III and the Samsung 270 codes will work
with the Epson U220.
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 -Add Print Code -

In the Print Code Details part of the screen click the  button and fill out the fields below according
to your printer's manual starting from giving it a description in the top portion of the screen.
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21.3 Printers Tab

Under the Hardware section click on Printers/Coursing. Click on the Printers
tab.

Here you add all of your printers on the network, give them names and enter their details.

Printer List

Printers that you add are displayed on the Printer list part of the screen.

 

Printer Details

On the Printer Details part of the screen, under the General tab, you can add printers and enter their
details.

 

- Add Printer -

To add a printer click the  button in the Printer details part of the screen and fill out the fields:

- General Printer Details -
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Active This printer will not be active unless this box is checked.

Name Enter the name you want to call this particular printer.

Device Type Select from Printer or UDP.

UDP Port Enter the UDP port this printer is attached to.

Print Code Depending on your printer model, a choice of:
· Samsung/Epson Codes
· Citizen Star Codes

However, if you have a different printer you must enter its codes in the 
Print Codes Tab (see Printer Setup->Print Codes tab).

Paper Width If you are using 40 column printers, you will want to enter a number
between 32 and 40, depending on the size of the margins you wish to
have on either side of the printouts.

Paper Cut Enabled If this option is checked, each check/receipt will be cut.

No Cut Line Feed This is the number of carriage returns (blank lines) added to the end of
the print job for no-cut printers (typically set 8).

Cut Line Feed This is the number of carriage returns (blank lines) added to the end of
the print job for cut printers (typically set to 4).

Windows Printer
Name

This is the name of the printer that is set up in Windows (see
instructions on finding the printer name below).

Backup and Rerouting

On the Printer Details part of the screen, under the Backup and Rerouting tab, you have the option to
add additional details to the selected printer.
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- Printer Rerouting -

Printer Schedule Allows a schedule to be assigned to the printer.  The printer will only
work during the schedule you assign to it.  When the schedule is not in
effect then the print jobs will be redirected to the "Backup" printer. 
See "Backup" Printer Name below.

Reroute to printer If you have chosen a printer schedule for this printer, then you also
have the option of choosing a printer to reroute the jobs to when the
schedule is not in effect by choosing a printer from this drop down box. 
Leave this field blank if the "Printer Schedule" field is blank.

- Backup Printer -

The next three options all work together for an "Auto Rerouting" feature.  Only Ethernet
or IP based printers are supported for this function.  

From Printer IP
Address

This is the physical IP address of the network printer.  This field is not
required to get the printer to work, but it is required if you want to use
the "Auto Reroute" feature.  SoftTouch will ping the IP address that is
entered here to see if it gets a response before sending a print job to it.
If it doesn't get a response from the printer, then the print job will be
re-routed using either a "Backup" printer name, OR it can be rerouted
locally. 

Leave this field blank for local receipt printers.
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To "BACKUP"
Printer Name This feature is used to automatically re-route print jobs to another

network printer, when the original printer fails. 

If your network printer is not working, just turn it off and jobs will be
sent to this "Backup" printer until the original printer is fixed. (this
Printer Name will also be the Windows name for the printer) 

Do not use this option if you have checked "Auto Route Locally"
(below). 

Leave this field blank for local receipt printers.

Auto Route Locally
(local default
printer)

Automatically reroutes to the local printer of the station that took the
order if there is no response from the IP address entered above.  If this
box is checked, simply turning off the network printer will trigger jobs
to be re-routed. (in the event your network printer breaks, you can use
your local printer).

Do not use this option if you have selected a "Backup" printer name
(above).

Leave this field unchecked for local receipt printers.

- Finding the Printer Name -

This is the name of the printer under Windows.

To find out what it is:
 

Step 1. Click the Start menu/Settings/Printers and Faxes. See image:

 

Different versions of Windows might call for slightly different paths. For example, you might have to click
the Start menu then go to Devices and Printers. See image:
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A window with available printers on the network will show up.

Step 2. Right click on the printer you would like to use for the one currently being configured and choose
Properties from the menu that shows up. The Printer Properties window will show up, and under General
tab you will find the name of the printer. See image:

 

 

This will be the name you would enter as the Windows Printer Name under Printer Details.
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21.4 Print Groups Tab

Under the Hardware section click on Printers/Coursing. Click on the Print
Groups tab.

Print Groups

Here you have the ability to group printers.  You need to assign each printer to at least 1 print group
because items in your menu are assigned to print groups.

Also, the local receipt printers should have two groups...one for the checks, and another for the receipts.

Create Print Group

On the Print Groups part of the screen click the + sign and in the blank field marked with the * type in

the name for the Group. Then click the  Save button. See image below for help:
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- Assign Printer(s) to Print Group -
Highlight the print group you've just created or the print group to which you wish to assign printers. In

the Assigned Printer List and Details part of the screen click the + sign and click the blank area under

Printer Name for the drop-down arrow to display. Then use the drop-down menu to choose a printer. 

*Note: You can have more than one printer in a group.  You may need to do this when setting up a Label printer so
that you can have Labels print at the same time the regular tickets print.  You would just add the label printer to your
"Hot" group or "Cold" group, whatever the case may be.

Printer Choose a printer from the drop-down menu that you would like to
have assigned to the print group you have selected.

Template Choose a remote template for your kitchen groups and a receipt or
check template for your receipt or check groups.

Copies Number of credit card receipts that will print. This is usually set to
2 for receipt printers and 1 for everything else.

Cash Copies Number of receipts that will print for cash transactions. 

Guest Copies If checked, if there are 3 guests at a table, you will get 3 copies of
the receipt.  This overrides what you have set in Copies and Cash
Copies.
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Item Copies Used for Label printers.  Prints an equal number of labels as there
are items on the check, so you can have a label for each pizza box.

Immediate Remote
Printing

If you would like items in an order to be sent to the kitchen while
you are still placing the order (i.e., before you have hit the "send"
button) enable this option. The items will be sent to the kitchen as
they are rung in.  This works best if using a Kitchen Display system
instead of printers.

Print Modes In this area you can choose the Modes/Functions for which you
would like the printer to work.   

Example: You may only want the labels to print when the order is
taken from the Delivery or Takeout modes, so you would only enable
those options, and leave the other modes unchecked.
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21.5 Coursing

Under the Hardware section click on Printers/Coursing. Click on the Coursing
tab.

Coursing

This is where you set up your courses and firing times. 

There are several things that can be configured in this section: course names, priorities, hold times,
and the families associated with the specific course names.

Create Coursing Groups

In the Coursing Groups part of the screen click the + sign and in the blank field marked with the * type

in the name for the Coursing Group. Click the  Save button after you have entered all details.

Course Name Allows you to create a course name, like Appetizers, Entrees, etc.

Priority Allows you to set a priority for what group you would want to print 1st,
2nd, 3rd, etc.

Hold Mins Sets the number of minutes to hold course before firing order to the
kitchen.
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Family Name You must assign which families are part of each coursing group.

With the correct Coursing Group selected, click the plus sign in the blue
bar to the right of Families assigned to coursing and select the family
name(s) you want to add from the drop-down under Family Name.

For example, you would assign the Appetizers family to the "Appetizers"
coursing group. You would assign the Salad family and Soup family to the
"Pre-Entree" coursing group.

Enable minute course firing allows you to have the master/server computer automatically fire courses
to the kitchen at the specified times.
 

NOTE: You can leave this option unchecked and all courses will print at the same time, with each
course listed separately on the kitchen ticket.

When first checking on Enable minute course firing, you must press the Restart Coursing Service
button. This will restart SoftTouch and the course firing service.

Max mins to hold manually (safety release) enables the master/server computer to automatically fire
all items that have not been sent after the specified amount of time.

Example: In the image above, the maximum time before automatically firing all items is 45 minutes. That means
that if a server orders items, but does not fire them or holds them, they will be fired to the kitchen automatically
after 45 minutes has elapsed.

The same rules apply to adding Courses and Families as in the rest of the program.
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Part 22 Pole Display

Under the Hardware section click on Pole Display. 

Pole Display

Here you add your pole display(s) and configure their settings.
 

- Add Pole Display -

Step 1. In the Pole display configuration part of the screen click the  button and fill out the
fields below.

 

Name Enter a name/title for the pole display that you can easily identify it by.
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Baud Rate Please, refer to your pole display's specifications manual for this value

Line Count Enter the number of lines to display (normally it is 2 lines). Refer to your
pole display's specifications manual.

Char Count Enter the number of characters to display. Refer to your pole display's
specifications manual for that number.

Clear Please refer to your pole display's specifications manual for the special
value number.

Initialize Please refer to your pole display's specifications manual for the special
value number.

Brightness Please refer to your pole display's specifications manual for the special
value number.

Cursor OFF Please refer to your pole display's specifications manual for the special
value number.

Cursor ON Please refer to your pole display's specifications manual for the special
value number.

Step 2. Now you need to assign Pole Display to a station. Go to Stations->Hardware Devices->Pole
Display. Make sure you  highlight from the Station list (at the top of the screen) the station for which the
pole display is physically connected, then check the Enable pole display checkbox and from the
drop-down menus choose the Pole Display Code and the COM port. See image:
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Part 23 Caller ID

Under the Hardware section click on Caller ID. 

Caller ID

In the Caller ID applet you set up your caller ID configuration.

SoftTouch comes pre-defined with configuration for two types of caller ID hardware - Whozz
Calling? and TELComp.
But you can add your own custom Caller ID hardware configurations.

- Caller ID Setup -

Under the Caller ID Setup screen fill out the following:

Caller ID Server IP
Address

The IP of the master/server terminal. (Note: A workstation can be
designated as the Caller ID master terminal, but that machine
must run the software provided at the SoftTouch website in order
to run.)

Caller ID Server Port Caller ID server port. Leave as 2007 in most cases.

Activate Caller ID
Hardware

From the drop-down menu choose the hardware you are using.
If your Caller ID hardware is not on the list, enter it in the 
CallerID Hardware part of the screen using the instructions
below, then come back here to specify it. You can deactivate it
using the Disable button.
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Log Caller ID Data If you want to log the Caller ID data make sure to check this
option.  A lot of useful info can be logged such as when the phone
rang, how long it took before it was answered, hang up time etc.

Name Separator If your caller ID system uses a comma to separate the first and
last name, enter a comma in here.  If a space is used to separate
the first and last name, just put a space in this field.

Name Format Choose whether the first name or the last name comes first.

Identify all uppercase
as "Company Name"

Some Caller ID systems report the company name as all
uppercase.  If this is true with your system, then enable this
option.  If there are other things that have all uppercase besides
the company name, then do not enable this option.

- Add Caller ID Hardware -

Under the CallerID Hardware portion of the screen click the  button and enter the name of
your CallerID Hardware in the Name field. Fill out all the other fields (see image below) by referring
to your Caller ID's technical manual.  

If you're using one of the default Caller ID systems, then the only thing you will need to change in
their setup is the COM port setting to match the COM port that it is plugged into.

*Note: Below are the default settings when SoftTouch is first installed. They might not be the same for your
Caller ID system.
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Part 24 Credit Cards

Under the Hardware section click on Credit Cards. 

Credit Card

Credit Card Setup holds the following settings:

1. Credit Card Settings

2. Unresolved Transactions (Reconciliations)

3. Credit Card Transactions

4. Daily Exception Log
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24.1 Settings Tab

Under the Hardware section click on Credit Cards. Click on the Settings tab. 

Settings Tab

Here you enter credit card settings.

Step 1: Merchant ID's

Click the plus sign to add numerous Merchant IDs, filling out the fields in this area for each.

UID Unique Identifier to help you distinguish between accounts.  This
number will print on customer receipts to help you determine which
account to refund if needed.

Merchant ID Obtain this number from your merchant (company that processes
your credit card transactions).

Description Enter a description for the account.

Step 2: Merchant Settings

Select the proper merchant account to use for each mode. These will show up in the drop-down list after
you added them to the Merchant ID's list on the right side of the screen.

Step 3: Credit Card Connection Settings

- General -
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Interface Datacap NetEPay/DialEPay Interface - Select this option if using
NetEPay or DialEPay software from Datacap.

Mercury Interface - Select this option if connecting to Mercury.

Sterling Store Server Interface - Select this option if connecting to
Sterling

SoftTouch CC Interface - For future use

Configure Defaults Press this button after choosing an Interface.

Server IP/DNS
Address(es)

For NETePay or DIALePay:
Enter the IP address of the terminal where the merchant's credit card
software interface is installed.

For Mercury Payment Systems:
Enter the server IP address that they gave you.  If you selected the
Mercury Interface and hit Configure Defaults, then this should already be
filled in.  Just verify it matches the addresses from Mercury.

*Note: if more than one IP address was provided to you, separate them by a
semicolon with no spacing in between.

Server Port Enter credit card's merchant server port number

Terminal ID Enter the Terminal ID if needed.  Usually only needed for Sterling
interface.
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Merchant Web
Page

You may enter the internet web page address to your credit card
merchant.
For example: Mercury Payment Systems allows their customers to login
and look up their transactions so you can enter the web address here and
access the login page directly from the browser in SoftTouch.

Connect Timeout This is the amount of time (in seconds) that the system will wait when
trying to connect to the merchant to process the credit card.  If it cannot
connect within the allotted time, a timeout error message will be
displayed.

Response Timeout This is the amount of time (in seconds) that the system will wait when
waiting to receive a response from the merchant after sending them the
credit card info.  If it does not receive a response within the allotted time,
a timeout error message will be displayed.

Ask for override
"dupecreditcard"

With this box checked on, if the same credit card is used more than once
on the same operation date, an override will be required. Security item
"dupecreditcard" can be found and assigned to certain groups/jobs under 
Security.

- AVS /CVV Validation -

When a credit card is used as payment, these options allow you to use the address verification system (AVS)
and/or CVV security code for the credit card holder's added security.

AVS is used only for Delivery and Takeout orders.
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Address Entry There are three options:

Prompt but not required - it will ask for an address but not require it
Required on 1st entry - address required
Do not prompt - it will not ask for an address

Zip Code Entry There are three options:

Prompt but not required - it will ask for a zip code but not require it
Required on 1st entry - zip code required
Do not prompt - it will not ask for a zip code

Void any
transactions over
___ if the AVS does
not match

For any transactions over the dollar amount you enter here, the
transaction will not go through if the AVS is not correct.

*Note: Setting this to $0 disables this feature, meaning no transactions
will  be voided if the CVV is wrong. (To void all transactions if the CVV is
wrong, you would set this to $0.01.)

CVV Entry There are three options:

Prompt but not required - it will ask for the CVV but not require it
Required on 1st entry - CVV required
Do not prompt - it will not ask for a CVV

Void any
transactions over
___ if the CVV does
not match

For any transactions over the dollar amount you enter here, the
transaction will not go through if the CVV is not correct.

*Note: Setting this to $0 disables this feature, meaning no transactions
will  be voided if the CVV is wrong. (To void all transactions if the CVV is
wrong, you would set this to $0.01.)

- Dialup Server -

This tab is designed for future use.
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- Signature -
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Min Amount for
Signature

Enter the minimum amount required for a signature.  If you enter $20.00
here, any orders below $20.00 will not require a signature.

In order for this to work properly, you must customize your Tip template
as follows:

· Go to Administration->Template Screen (from the gray toolbar at the
top of BackOffice).

· Select the "Tip" template from the list.
· For each signature line you will see something that looks like this:

<ifcredit>
<cr>
<cr>
X ___________________________________ <cr>
<endif>
<cr>

· Customize it so that it looks like this instead (adding the <ifsignature>
and <endif> tags):

<ifcredit>
<cr>
<cr>
<ifsignature>
X ___________________________________ <cr>
<endif>
<endif>
<cr>

· The signature line may be in three different places within the Tip
template, so you will have to make the change for each line.

- AVS Codes -

If you use AVS/CVV validation, this section lists the codes your providers return when the address, zip
code, and/or CVV is/are correct. Some codes will already be listed here by default, but you should verify
with your provider that these are correct.

Use the Add button to add additional codes. Click in the blank fields under Code and AccountName and
use the drop-down menus to fill in these fields. Click in the blank field under Valid Codes and type in the
code(s). You can also click on fields that have already been filled out if you want to change them.
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Step 4. Enable Credit Cards on each station

Go to Stations->Options (under Hardware) and enable the "Credit Card Interface" option for each station.
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24.2 Unresolved Transactions Tab

Under the Hardware section click on Credit Cards. Click on the Unresolved
Transactions tab. 

Unresolved Transactions

Here is where your credit card transactions and check payments are being tracked. You might never use
this, but it's a good thing to have and in the example below we will explain why.

Every time you process a credit card, the information is sent to your merchant for its authorization. It is
then sent back to you, flagged as authorized or not authorized, so you can complete a transaction by
accepting or declining the card.

But what if in the middle of the credit card authorization process you lose electricity or internet
connectivity before the information is sent back to you?  You don't know whether the transaction went
through or not. SoftTouch will not let you exit the system if you have unreconciled transaction(s). You
can go to this screen, find the transaction which got interrupted and either reconcile the transaction or
delete it.

*Note: This is the area where you would reconcile any Mercury Gift Card transactions that might have
encountered problems during the sale. You will know this when you try to Z out at the end of business. The
message will read "You have x Paid IN/OUT not reconciled." Confirm with your merchant that the transactions did
post and then reconcile them from here. Now you can Z out for the night.
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24.3 Credit Card Transactions Tab

Under the Hardware section click on Credit Cards. Click on the Credit Card
Transactions Tab.

Credit Card Transactions

1. This is for when you want to just view credit card transactions from a particular date. 

2. This will also show you current open transactions if you choose the button Open Transactions.

3. The Show Full Credit Card # button will only show full credit card numbers for transactions rung on
today's Operation date. Once the Z has been run, the credit cards will be purged and only the last four
digits will show.
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24.4 Daily Exception Log

Under the Hardware section click on Credit Cards. Click on the Daily Exception
Log Tab.

Daily Exception Log

This section is designed to display any credit card errors.
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Part 25 Pager/Alerts

Under the Hardware section click on Pagers/Alerts. 

Pager/Alerts

Pager/Alerts holds the following settings:

1. Activations

2. Alert List

3. Table Alert Buttons

4. Pager and Coaster Hardware

5. Table Alert Hardware

 



Version 6.1.16

395



Version 6.1.16

396

25.1 Activations

Under the Hardware section click on Pagers/Alerts. Click on the Activations
tab. 

Activations

The following section is where you activate various Pager/Alert systems.

Activate the SoftTouch
alert system, SoftAlert
©

Enables the SoftTouch alert system.

IP Address of the
server

The IP address of the computer where the pager system is plugged
into.

Activate Pagers This is where you choose the pager hardware you're using (you
must press the Disable button to deactivate).

Activate Coaster Alert This is where you choose the Coaster Alert hardware you're using
(you must press the Disable button to deactivate).
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Activate Table Alert This is where you choose the Table Alert hardware you're using
(you must press the Disable button to deactivate).

Restart Alert/Pager
Server

Pressing this button allows you to reset the pager service (use only
if the alerts do not seem to be working properly or if you have just
made changes to any of the alert settings).

Note: You can only restart the alert/pager server on the server.
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25.2 Alert List Tab

Under the Hardware section click on Pagers/Alerts. Click on the Alert List tab. 

Alerts

This is the area where you set up all of the alert messages and set timers for each alert and its time to
resend.

This is strictly for choosing which alert you want to edit. This is where you can quickly see which
alerts are active.

All changes must be made in the Alert Details section described next. The arrow next to the alert
name will show you which one is selected (which one you are editing).

- Alert Descriptions -

First courtesy
visit

Alerts a server that a new party has been seated and they need
to be greeted.  

Regular
courtesy visit

Alerts the server to perform a regular courtesy visit to a table
after the party has been seated for a specified period of time.

No food
ordered

Alerts a server or manager after a specified period time after a
party has been seated if they have not yet ordered anything.

Is food
served

Alerts the server or manager if the food has not yet been
served after a specified period of time for any particular table.
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Food ready
page runners

Alerts the server and/or food runners that the food is ready to
be delivered to a table.  This alert will automatically display
where to pick up the food and where the food is to be delivered.

Check printed
but not closed

Alerts the server or manager that a check has been printed but
not closed after a specified period of time

Table ready
to be serviced
(Bused)

Alerts the bus boys and/or servers that a table is ready to be
bused and displays the table number.

**Important Note: For the bus boy to be alerted you have to first
check on "enable table bus" located under the hostess section.

Seat/Table
assistance

This alert can be initiated by the party sitting at the seat or
table by pushing a button on a Hoscom wireless table alert
system. 

Check
Request

This alert can also be initiated by the party sitting at a table by
pushing a button at their table when they are ready for the
check.

Drink Refill
Request

This is an alert that can be initiated by the party by pushing a
button at their table.  This alert remembers all the drinks that
were ordered and will display them on the server’s pager so
he/she will know what to bring to the table.

Table target
revenue

This will alert a manager or server that a table is falling below
expected revenue.  This alert is fully customizable.  For
example, you can specify that you may want to have $9.00 per
guest for every 45 min.  If after 45 min the table is below this
target, the alert will fire.

Waiting to be
seated over x
min

This will alert a manager that a party has been waiting for a
specified period of time.

Labor sales
alert

Alerts the manager when their labor costs begin to exceed a
certain preset percentage of sales.  This will allow the manager
to keep control of labor costs and send people home when there
is not enough revenue to justify them being there.

Dineblast Mobile
Verify Alert

Reserved for future use with orders placed through Dineblast Mobile.
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Check Cash Out Alert Designed for the Self Pay unit.

Dineblast Item Order
Alert

Reserved for future use with orders placed through Dineblast Mobile.

- Alert Details -

Under the Alert Details section fill out the information under the General and Destination tabs.

General

Alert Active This box sets the alert to active.
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Alert Message (Full
Format)

This message will appear when the alert is viewed on a full screen and
can be longer than the short format message. It can be the same as
the short format message if it is kept short.

Alert Message (Short
Format)

This message will be sent to pagers. Keep this short to fit on a small
screen. It can be the same as the full format message if it is short
enough.

Check for alert every
___ (seconds)

Set how often you would like the selected alert to be checked for (in
seconds).

Resend alert if not
handled, resend alert
every ___ (seconds)

You must place a check in the Resend box if you want continuous
messages to be sent until the message is cleared in SoftTouch. Set
the time in seconds after which you want the next message to be sent
to the pager.

Last alert interval This is the time in minutes that you want to continue to send
messages. The system will quit sending after this amount of time
expires.

Destination



Version 6.1.16

402

Alert employee via
pager system

If this box is checked, alerts will be sent to employees. If unchecked,
this will allow only managers to receive the alerts.

Send employee alert
to print group

If you would like employee alerts to print, select the print group here.
For information on setting up print groups, see 
Printers/Coursing->Print Groups Tab.

Send to manager
after

Select how many alerts the employee should receive before the
manager is alerted.

Send to manager
HTML console after

Select how many alerts the employee should receive before the master
display is alerted. The master display can be found in SoftTouch by
going to System then Alert View.

Alert manager via
pager system

This box allows you to send the selected alert to a master pager.
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Alert manager via
email (sms supported
via cell provider email
gateway)

This box allows you to send master pages to a mobile phone or PDA via
email or sms.

Send manager alert
to print group

If you would like the manager alerts to print, select the print group
here. For information on setting up print groups, see 
Printers/Coursing->Print Groups Tab.

**Warnings**

Please read these warnings carefully.

Warning:
Any changes or additions to alert settings requires stopping and restarting the SoftTouch alert server on the
master computer.  This can be found in the BackOffice under system or under the alert setup tab.

Warning:
Since SMS messages may cost money to send and receive, it is crucial that wireless operators incorporate some
security measures into the SMS-to-email gateway to prevent spam.  As a result, you cannot send more than 10
messages in a short period of time (typically several minutes) via the gateway.
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25.3 Table Alert Tab

Under the Hardware section click on Pagers/Alerts. Click on the Table Alert
Buttons tab. 

Table Alert Buttons

Step 1: Assign Button Configurations

This is where you will assign a function to each button on the unit.  So if there are 4 buttons, you will
need to assign a function to all four of those buttons.

Under the Button Configuration, use the plus (+) button to add buttons and click the blank space
under each column to fill out the following:

Button Name Give the button a name.

Button # This is the button number that gets sent from the device when pressing
a button.  For a 5 button system the buttons might be numbered
1,2,3,4,5, or they may go in reverse, 5,4,3,2,1.

Button Function This is where you enter the alert the button triggers and the display of
the button.
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25.4 Pager & Coaster Hardware Tab

Under the Hardware section click on Pagers/Alerts. Click on the Pager &
Coaster Hardware tab. 

Pager & Coaster Hardware Setup

Under the Pager & Coaster Hardware section fill out the following:

Under the Pager Hardware Settings fill out the following:

Device Name Enter the manufacturer name and model number of
device

Interface Choose the correct interface.  

Serial: Choose this if your device connects through a
serial (COM) port. 

TCP/IP: Choose this option if your device connects over
the network and has it's own IP address.
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SERIAL SETTINGS - (ignore if you're using a TCP/IP device)

COM Port This is the port that is used for pager communications.

Baud Rate This is the speed required to send the messages.

Pager Format This is the code to ensure that messages are delivered
properly to pagers (do not change defaults unless
instructed to by a SoftTouch technician).

Coaster Format This is the code to ensure that messages are delivered
properly to coasters (do not change defaults unless
instructed to by a SoftTouch technician).
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TCP/IP SETTINGS - (ignore if you're using a Serial device)

IP Address IP address of the device.  For instructions on setting the
IP for the device itself, refer to your manufacturer's
manual.

Port Enter the port on which the device communicates.

Initialize Data This is the code to ensure that messages are delivered
properly (do not change defaults unless instructed to by a
SoftTouch technician).

Pager Format This is the code to ensure that messages are delivered
properly to pagers (do not change defaults unless
instructed to by a SoftTouch technician).

Coaster Format This is the code to ensure that messages are delivered
properly to coasters (do not change defaults unless
instructed to by a SoftTouch technician).
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25.5 Table Alert Hardware Tab

Under the Hardware section click on Pagers/Alerts. Click on the Table Alert
Hardware tab. 

Table Alert Hardware Setup

Under Table Alert Settings section fill out the following:

Device Name This is where you enter the name of the device you are using.  Enter the
manufacturer brand and model number.

Start Test / Stop
Test Buttons

Press the Start Test button and then try pressing some buttons on the
Table Alert Device to see if data can be successfully received.  Once you
are finished testing, press the Stop Test button.

Note: The settings below must be properly configured before attempting
to test.

Interface Choose the correct interface.  

Serial: Choose this if your device connects through a serial (COM) port. 

TCP/IP: Choose this option if your device connects over the network
and has its own IP address.
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Start Char This is the position of the starting character for table alert messages.

End Char This is the position of the ending character for table alert messages.

Table # Start This is the position of the start of the table number in the message.

Table # Length This is the total length of the table number in the message.

Button # Start This is the position of the start of the button number in the message.

Button # Length This is the total length of the button number in the message.

Button Parse The code entered here tells SoftTouch what button on the device was
pressed.

This code ensures that messages are delivered properly (do not change
defaults unless instructed to by a SoftTouch technician).

Table Parse The code entered here tells SoftTouch what table the signal is coming
from.

This code ensures that messages are delivered properly (do not change
defaults unless instructed to by a SoftTouch technician).

SERIAL SETTINGS Tab - (ignore if you're using a TCP/IP device)

COM Port This is the communications port being utilized by the device.

Baud Rate This is the speed setting for communications to take place.

TCP/IP SETTINGS Tab - (ignore if you're using a Serial device)

IP Address IP address of the device.  For instructions on setting the IP for the
device itself, refer to your manufacturer's manual.

Port Enter the port on which the device communicates.
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Initialize Data This is the code to ensure that messages are delivered properly (do not
change defaults unless instructed to by a SoftTouch technician).
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Part 26 Email/SMS

Under the Hardware section click on Email/Sms.

Email/SMS

Email/SMS Server Settings

**WARNING**: Charges and/or Fees may apply for texting by the cellphone company.

The Email/SMS settings can be used to send alerts to managers and/or employees. It can be used to
send any of the alerts in the Pager/Alerts area of BackOffice by enabling the “Alert manager via email
(sms)” option (see Pager/Alerts->Alert List Tab). 

*Note: The Email/SMS option is really designed to be used only by managers, not by individual employees. 

Only the alerts that are available in the system can get sent to the cell phones. 

*Note: You cannot send custom text messages to the cellphones.  You can only send alerts from
the available options in the pager list under Pager/Alerts (see Pager/Alerts->Alert List Tab).

SMTP Server Your Internet provider's SMTP mail server address. 

Example: smtp.YOURPROVIDER.com
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SMTP Port Your Internet provider's SMTP port.

SMTP
Username

Username of your SMTP account.

SMTP
Password

Password for your SMTP account.

SMTP Sender
Email

This is the email address that messages to customers or
employees will appear to be from.

Send test
message

Sends a test message to ensure the SMTP settings are
correct.

1. The SMS Email Provider Settings refer to the proper format to send an SMS message to a
phone.  The "number" portion refers to the phone number that the message will be sent to.  

2. Alerts from the Pager/Alerts section can also be sent to cell phones for employees with master
alerts enabled by entering their phone number in the Employees->Alerts/Email/SMS section.

*Note: This section can be used in conjunction with the Hostess program so people can give their cell phone
number when they put themselves on the waiting list; when their table is ready, a text message would be
sent to them.

*Note: THE MAIL SERVER ADDRESS MAY BE CHANGED AT ANY TIME BY THE CELLULAR PROVIDER.
YOU MAY NEED TO CHECK WITH THE CELLULAR PROVIDER IF A PARTICULAR CARRIER DOES NOT
WORK.
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Part 27 Dineblast Mobile

Under the Hardware section click on Dineblast Mobile.

Dineblast Mobile

This section is reserved for future use.
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27.1 Counter Tab

Under the Hardware section click on Dineblast Mobile. Click on the Counter tab. 

This section is reserved for future use.

Counter

Curb Side
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27.2 Dining Tab

Under the Hardware section click on Dineblast Mobile. Click on the Dining tab. 

This section is reserved for future use.

Dining
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27.3 Welcome Message Tab

Under the Hardware section click on Dineblast Mobile. Click on the Welcome
Message tab. 

This section is reserved for future use.

Welcome Message
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Part 28 Financial Section

The Financial section.

The Financial section contains the following:

1. Banks

2. Revenue Centers

3. Media/Accounts

4. Tax Table

5. Adjustments

6. Sales/Journal View

7. Tip Sharing
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Part 29 Banks

Under the Financial section click on Banks.

Banks

Banks includes the following tabs:

1.  Banks (which covers tills, pockets, and store)

4.  Default Banks



Version 6.1.16

424

29.1 Banks

Under the Financial section click on Banks, then click the Banks tab.

Banks explanation includes the following:

1.  Tills

2.  Pockets

3.  Store

Tills A Till is created for Cash Drawers.  You may use more than 1 till for a Cash
Drawer (Station 1 AM Till, Station 2 PM Till, etc.)

Pockets A Pocket is used for servers that are banking themselves and make change out of
their pocket. 

Store A Store is created for all store safes.
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29.1.1 Tills

Under the Financial section click on Banks, click the Banks tab, and then
click the Filter By/Tills radio button. 

Tills

Press the Add button to add a new till, and fill in the information in the Detail section regarding
that till:

Name Decide on a name that describes this till and enter it in this field.

Active Select this option to make the till active.
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Floating This allows this till to be used in multiple drawers.  This way if an
employee moves from one workstation to another, they can take their till
with them to the new workstation and retain responsibility for the cash
collected in this till.

DO NOT USE AND THE MANUAL SHARED OPTION AT THE SAME TIME.

Enable
Blind
Drops

If this option is not selected, when a till is closed, you will get a dialog
box that tells you what should be in the till and asks you what is actually
in the till when it is counted.  If there is a variance, you can enter an
over/under reason to explain the difference.

If this option is selected, when a till is closed the employee closing the
till will be asked how much money is in the drawer without being shown
the expected amount.

IF YOU HAVE A RECURRING AMOUNT SET FOR THIS TILL, COUNT ALL
THE MONEY IN THE TILL, INCLUDING THE STARTING BANK.

Manual
Shared

Select this option if more than one employee will be using the drawer.

DO NOT USE THIS OPTION AND THE FLOATING OPTION AT THE SAME
TIME.

Manager
Mode

Select this option if the starting amount for this till is different every day
and the manager will transfer the starting amount from the Store Safe to
this till before the till is used each day.  If you use manager mode and
do not enter a starting bank before the shift, the system will think the till
has no money in it and you will not be able to do paid outs or tips paid
until the user of this till collects enough cash to cover the paid out or
tips paid.

Recurring
amount

If the starting amount that this till is opened with is the same amount
every day, you can enter that amount here.  

Auto
commit
drops

This prevents modifications (such as forgotten tips) from being entered
after closeout.
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Auto tip
deduction,
pay out
employee
tips at
closeout
that
worked
the bank

The employee takes cash for charge tips from that till as part of the
closeout process.

If, on the other hand, charge tips are to be withheld and then paid with
the paycheck, this box should not be checked and tips owed from the
house would be given manually.

Ask for
the till
total at
closeout

The employee closing out is required to count the money in the till and
enter that total. This will compare the reported total to the expected
total to determine if the till is over or under and by how much.

Have a
manager
authorize
the drop
at
closeout

The manager must accept the employee's closeout, meaning the
manager sees how much the till is over or under by before the employee
is able to complete closing out.

Pay tips
from this
bank if the
till does
not have
enough
cash to
pay out
tips

Select the bank from the drop-down that tips should be paid from if the
selected till does not have enough cash to pay out tips.

Configure
to use
minimal
closeout
procedure
s

This option will change your settings so that the following option is
checked on:
· Auto tip deduction, pay out employee tips at closeout that worked the

bank

Configure
to use
cash
managem
ent
without
manager
interventi
on

This option will change your settings so that the following options are
checked on:
· Auto tip deduction, pay out employee tips at closeout that worked

the bank
· Ask for the till total at closeout
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Configure
to use
cash
managem
ent with
manager
interventi
on

This option will change your settings so that the following options are
checked on:
· Auto tip deduction, pay out employee tips at closeout that worked

the bank
· Ask for the till total at closeout
· Have a manager authorize the drop at closeout

29.1.2 Pockets

Under the Financial section click on Banks, select the Banks tab, and then
click the Filter By/Pockets radio button. 

Pockets

Press the Add button to add a new pocket, and fill in the information in the Detail section
regarding that pocket:

Name Decide on a name that describes this pocket and enter it in this field. 
You will want to include the name of the employee using this pocket.

Active Select this option to make the pocket active.
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Auto
commit
drop

This prevents modifications (such as forgotten tips) from being entered
after closeout.

Auto tip
deduction,
pay out
employee
tips at
closeout
that
worked
the bank

The employee takes cash for charge tips from that pocket as part of the
closeout process.

If, on the other hand, charge tips are to be withheld and then paid with
the paycheck, this box should not be checked and tips owed from the
house would be given manually.

Ask for
the till
total at
closeout

The employee closing out is required to count the money in the pocket
and enter that total. This will compare the reported total to the expected
total to determine if the till is over or under and by how much.

Have a
manager
authorize
the drop
at
closeout

The manager must accept the employee's closeout, meaning the
manager sees how much the pocket is over or under by before the
employee is able to complete closing out.

Pay tips
from this
bank if the
pocket
does not
have
enough
cash to
pay out
tips

Select the bank from the drop-down that tips should be paid from if the
selected pocket does not have enough cash to pay out tips.

Configure
to use
minimal
closeout
procedure
s

This option will change your settings so that the following option is
checked on:
· Auto tip deduction, pay out employee tips at closeout that worked

the bank
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Configure
to use
cash
managem
ent
without
manager
interventi
on

This option will change your settings so that the following options are
checked on:
· Auto tip deduction, pay out employee tips at closeout that worked

the bank
· Ask for the till total at closeout

Configure
to use
cash
managem
ent with
manager
interventi
on

This option will change your settings so that the following options are
checked on:
· Auto tip deduction, pay out employee tips at closeout that worked

the bank
· Ask for the till total at closeout
· Have a manager authorize the drop at closeout
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29.1.3 Store

Under the Financial section click on Banks, click the Banks tab, and then
click the Filter By/Store radio button. 

Store

Press the Add button to add a new store, and fill in the information in the Detail section
regarding that store:

Name Decide on a name that describes this store and enter it in this field.

Active Select this option to make the store active.

Reset at Z Select this option if you wish to reset this bank (safe) when you Z out.
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29.2 Default Banks

Under the Financial section click on Banks, then click the Default Banks tab. 

Default Banks

Pockets -
Always
bank from

If the store provides the money a server will make change from, select
the bank where these funds will be taken from.

Pockets -
Always
drop to

Select from the drop down the bank where the money that an employee
with a pocket turns in when they close their shift will go.
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Tills -
Always
bank from

If you have a daily recurring amount set as a starting bank, or if a
manager enters in the starting amount for each till daily, select from the
drop down where this money should be taken from.  Although this is the
default for where the starting amount will come from, if a manager is
entering the amount daily, they can change where the money is coming
from as they do the procedure.

Tills -
Always
drop to

Select from the drop down the bank where the money that an employee
with a till turns in when they close their shift and till will go.

Drivers -
Always
bank from

If the store provides the money a driver will make change from, enter
the bank where these funds will be taken from.

Drivers -
Always
drop to

Select from the drop down the bank where the money that a driver turns
in when they close their shift will go.

Tips - Pay
Z tips from

When the amount that an employee earns in charged tips is greater than
the cash they collected, they will need to be paid the difference.  Select
from the drop down where you will pay the additional tips earned from.
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Part 30 Revenue Centers

Under the Financial section click on Revenue Centers.

Revenue Centers

A Revenue Center is a group of stations that are in a unique area.  Restaurant and Bar are the two most
commonly used Revenue Centers.

Here you do nothing more than create groups for your stations. Click the Add button and then click the
newly created space under Name to enter a name for that center.

This will be useful when you run the Revenue Center Reports to see which Revenue Center gave you more
profit.

Example: Terminal 1 and Terminal 2 can be linked to the Bar Revenue Center and Terminal 3
and Terminal 4 can be linked to the Restaurant Revenue Center.

See image below:

Revenue Centers created in the Revenue Center list are assigned to Stations under the Hardware section
in the Stations setup screen (see Hardware->Stations). See the image below as a reminder of how you
assign a revenue center to a station:
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Part 31 Media/Accounts

Under the Financial section click on Media/Accounts.

Media/Accounts Setup holds the following settings:

1. Create Media and Account Groups

2. Create and Manage Member Accounts or Card Accounts
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31.1 Account Groups Tab

Under the Financial section click on Media/Accounts. Click on the Account
Groups tab.

Media/Account List

Here you setup your Media:

· Credit Cards (Visa, AMEX, MasterCard, Discover etc.)
· Cash/checks
· Coupons
· Member Accounts and Gift Cards

- Add Media -

In the Media Details part of the screen click the  button, fill out the fields and check the appropriate
check boxes.  

*Note: when you do a new install of SoftTouch, most media types such as credit cards and cash are
already set up.  Little or no changes should need to be made to these media types.
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- General Info -

Media Name Enter a name/title for the media.
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Account Type Choose what type of media it is.
· for cash - Cash
· for checks - Cash
· for credit/debit card - Credit Card
· for check comp - House Charge
· for house account - Member Account
· for gift card - Card Account
· for coupon - Coupon
· for Bitcoin - Bitcoin

Explanation: House Account holds account members in it and therefore it's
account type is called Member Account.

Sort Order Allows to set the display order of payment types in the SoftTouch cash
out screen.

Active If checked, the media becomes active.

Charge Tax If checked, tax will be charged (provided the items on the check are
taxable and the station has the tax assigned to it).

Do not open drawer This option prevents the cash drawer from opening on this type of
tender.

Example: You may not need to open the drawer on a credit card
tender. Preventing it from opening enables greater security.

Media Requires a Tip If checked, a tip will be required to be entered when this media type is
used in the Dining, Bar, or Delivery modes.  This is usually turned on
for credit cards.  You also have the option to turn this on for gift cards
and member accounts.

Note: Multi-store gift cards do not support tips.

Close Order for
iKiosk

If checked, you will be able to close a check from an iKiosk station
using the selected tender.

Disable for selfpay If checked, disables the option for the media selected from the list to
be used with the Selfpay machine.
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Disable for online Prevents people from using the selected media online. 

Example: If the restaurant does not want cash as a payment type for online,
they would put a check mark in this box.

Disable for iKiosk Prevents people from using the selected media at the iKiosk.

Example: If the restaurant does not want cash as a payment type at their
iKiosk, they would put a check mark in this box.

Secure If checked, only a manager can perform the operation as long as the
manager's security group in the BackOffice under Security settings
(see Security) has a MediaSecure or MediaSecureCash security
item keyword in it.

- Credit Card Info -

Transaction % The credit card company deducts a percentage off of a check called a
transaction fee. This fee is calculated from the whole check including
the server's tips. Specify the transaction charge percentage required
by the credit card company here. 

*Note:  This setting has no bearing on the program. It is merely a reference
point.

Tip Deduction % Some restaurants want the server to pay the transaction fee when
they receive tips on credit cards. If that's the case, specify the
percentage here (usually it is the same as Transaction %). If this is set
then in the Server Report the transaction fee will be deducted from the
server's charge tips.

Interface Name Choose an appropriate interface name for the credit card (Visa to Visa,
American Express to AMEX etc.).  This may already be set up for you
on a new install.

- Member/Card Accounts -
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Card Digits This can be used to set up gift cards that all start with the same first
two or three digits.

When you get gift cards made, it is best to have the manufacturer
make the first two or three digits on each account number the same.

Such as this: 774033, 774034, 774035

In the example above, "77" is the first two digits of every account
number, so you can put 77 into the Card Digits field.

Now when you go to cash out an order, you can simply swipe the gift
card as soon as you enter the cash out screen and the system will
automatically recognize that you're swiping a gift card.

*Note: If you do not set up the Card Digits field, you would have to
select the gift card media in the SoftTouch Cashout screen, hit enter,
and then swipe the card.

Expiration Days The default number of days after which a card account expires starting
from the day it was issued.

Explanation: When you create a card account in SoftTouch this default
number is used to set the expiration date for the card. If you wish to extend
the expiration date of the card account, do that from the actual account details
screen under the Account List tab (see Media/Accounts->Account List Tab).

Decode all to Track 2 This button will decode all accounts in the chosen media type so that
the beginning and end codes get stripped off.

This only needs to be used when older versions of SoftTouch did not
have support for track 2, so the account number would end up having
the full track data as the account number, such as this, ;7765481=0?

The Decode all to Track 2 button will strip out everything but the actual
account number, so all that's left is 7765481.

If you have your gift cards encoded with Track 2 format (ex:
;7765481=0?) and you are using SoftTouch version 4.4 or higher, then
you will never need to touch this button.

Deposit Account (Pre
Pay)

If the restaurant gets money in advance for the account then check
this option.

Example:  A Gift Card would be a deposit (pre-paid) account.

Prompt For Account
Name

If selected, you will be asked to select an account name when using
this tender.
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Multi Store
(GiftEPay/Mercury)

This option allows gift cards to be used at multiple locations that use
the same merchant.

Merchant ID This is used in conjunction with the above item. It is your merchant ID.

Server IP This is the merchant's server IP. Obtain this from your gift card
merchant.

Server Port This is the server port. It is the same as in the credit card configuration
(see Hardware->Credit Cards->Settings Tab).

Terminal ID This is the merchant's Terminal ID (might only be required if setting up
gift cards through Sterling).

Account Decode Internal use.
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31.2 Account List Tab

Under the Financial section click on Media/Accounts. Click on the Account List
tab.

Account List

Here you set up Member Accounts and assign members to them, enter member addresses, view account
history, create invoices etc. You can also create Gift Cards here in the BackOffice, but you would normally
do it in the SoftTouch front end.

1. Account

2. Account History

3. Member Addresses

4. Account Members

5. Notes

6. Invoicing
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31.2.1 Account Tab

Under the Financial section click on Media/Accounts. Click on the Account List
tab. Select the Account tab.

Account

Add A Member Account:

Step 1. First click on the Account Groups tab and under Media/Accounts then select the member
account media into which you'll be adding this Member account.

Step 2. Now select the Account List tab.

Step 3. Click the  button.

Step 4. In the fields in the Account section enter the Member Account details:

Account Name Usually an account is tied to a business name which then has account
members tied underneath it. Here you would put the Business's
name.

Account Card # For Member Accounts, you do not need to enter anything here.
Card numbers can be entered on the actual members of the account
instead so each member of the account can have their own card. 
Card numbers for members are entered from the Customers area in
BackOffice (see Customers->Customer List Tab).

For Card Accounts, this is where the card number goes.  Usually
Card Accounts (Gift Cards) are created from the front end, so this
field will get filled in for you when they are created.
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Credit Limit This is the amount the Account will be able to spend before you send
them an invoice. Each time a member of the account makes a
purchase on the account, the number will be subtracted from this
number until it reaches $0. Once it reaches $0 the Account can no
longer be used until the account is reconciled or you add monetary
value to the card.

Expiration Date Optional to have a date the Account will expire.

Tax Exempt Check this on if the Account is Tax-Exempt, but make sure to also fill
out the Tax ID section for tax purposes.  A tax exempt certificate
should be kept on file for all tax exempt accounts.

Tax ID If a company is tax exempt you would need the company or person's
Tax ID number placed within this section.

Date Issued The date the new account has been created. 

Invoice Custom
Message

A personalized message that would go on the invoice that is sent to
the customer.

31.2.2 Account History Tab

Under the Financial section click on Media/Accounts. Click on the Account List
tab. Select the Account History tab.

Account History

In the lower part of the screen select the Account History tab.

Here you can view the transaction history of the Member Account or a Gift Card.

Customer The customer or member of the account that performed the
transaction.
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Date Time The date and time on which the check was closed out.

Amount Total amount of the check (including tax).

Check # Tells you what the check number is for the customer. This is helpful
to find the check if necessary.

Payment Type Lets you know what type of transaction it was.

Refresh History If you just charged a check to an account and you would like to
make sure it was received, you can click the "refresh history" option
and anything that has been recently added to the account, such as
a check that was just cashed out, will appear.

31.2.3 Member Addresses Tab

Under the Financial section click on Media/Accounts. Click on the Account List
tab. Select the Member Addresses tab.

Member Addresses

Here you can enter multiple addresses for the account holder and specify which address is the Bill To
address by checking the Bill to option.

Push the Add button then enter the Description (a name to distinguish it from other addresses) and
other needed information in the fields on the left.
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Clicking on / highlighting different address lines in the scrolling box on the right allows you to switch
between the selected member's different addresses.

31.2.4 Account Members Tab

Under the Financial section click on Media/Accounts. Click on the Account List
tab. Select the Account Members tab.

Account Members

Here you add people known as the Account Members to a Member Account.

In the Account List box higher on the screen, select/highlight the account you want to add members
to. Then, in the lower portion of the screen, click the Add button and use the drop-down to select the
customer you want to add to the highlighted account.

Account Members are derived from your customer database. If you don't see the person that you
want to add in the drop-down list, enter that person as a customer first, then come back here and
add them to the account. For additional information on how to add customers, see Customers.

Remember: You are adding members to whichever account is selected/highlighted in the Account
List box higher on the screen.

31.2.5 Notes Tab

Under the Financial section click on Media/Accounts. Click on the Account List
tab. Select the Notes tab.

Notes
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Here you can enter notes specific to the account. This is for your personal use. Notes are viewable in
the BackOffice only; they do not show up or get printed anywhere.

31.2.6 Invoicing Tab

Under the Financial section click on Media/Accounts. Click on the Account List
tab. Select the Invoicing tab.

Invoicing

Here you can print account invoices.

- Print Invoice(s) -

1. First click on the Account Groups tab and under Media/Accounts list part of the screen select the
account media that you need.

2. Now click on the Account List tab.

3. Select the account name for which you want to print the invoice.

4. Print an invoice using the options shown below.

Invoice Account
Only 

Prints the invoice only for the account name that you have selected (on
the top portion of the screen, the one that has a pointing arrow on the
left side).

Print All Invoices Prints all the invoices for the Account Media that you currently have
selected under the Account Groups tab.

Print Check Details Checking this box allows you to print out all details for all checks,
including table number, items ordered, etc.
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Part 32 Tax Table

Under the Financial section click on Tax Table.

***BE SURE TO CHECK THE CURRENT TAX RATE FOR YOUR STATE AND COUNTY.
BELOW ARE EXAMPLES AND ARE NOT A SUBSTITUTE FOR OBTAINING AND USING THE
LATEST TAX RATES THAT SHOULD BE CHARGED IN YOUR AREA.

Tax Definitions

Here you add a tax table and specify a Fixed amount or Fixed percentage for it.

Note that you can add as many tax tables as is necessary for your locale.

After clicking the Add button or selecting an existing tax you wish to edit, fields can be filled in either here
or in the Tax Definition Detail section.

In the Fixed % column, percent signs are added automatically after you finish.

 

Above is an example set for a variable percentage of 6%. It has breakpoints that need to be entered in
order for tax to be calculated correctly. Florida is one such state that employs this type of sales tax.

Tax Definition Detail

In addition to taxes definitions being added/edited in the Tax Definitions section, they can be
added/edited here. Click the Add button or select from Tax Definitions the Tax you wish to edit before
filling in the fields.

This section has the added feature of disabling this specific tax for certain kinds of orders, such as dine in,
takeout, delivery, etc.
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Tax Table

Here you add breakpoints for your tax table.

First, make sure that under Tax Definitions the tax you want to add breakpoints to is selected. Next, click
the Add button in the Tax table section and then click in the boxes under Breakpoint and Amount to
type the appropriate amounts. The dollar sign will be added automatically when you finish.

The following image is an example of exactly how the Florida tax rate breaks down.

 

Above is an example of a Florida tax table, $0.09 being the first breakpoint where tax is charged and
$1.09 being the breakpoint where the tax table is repeated. Some counties have different tax tables in
Florida and other states.

*Note: Be aware of these tables if a flat rate tax is NOT used in your county.

IT IS THE DEALER'S RESPONSIBILITY TO CHECK THE CURRENT TAX RATE FOR
YOUR STATE.

VAT Tax

Some counties and/or states also incorporate a VAT (Value Added Tax). This can be set to a fixed
percentage rate and then check on the VAT checkbox for that rate. The box must be checked on for it to
take effect. 
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*Note: VAT tax is primarily used for liquor sales and is backed out of certain sales reports to make reporting and
paying taxes very easy.

- To Set Up Value Added Tax -

Step 1. 

Use the information above to create a new definition / tax table for Value Added Tax. Check the VAT field
on.

Step 2. 

Apply the VAT sales tax to all the items you would like to. To do this, go to Item Builder (under General)
, click the Menu & Rule Builder tab, click the red Items button, click on an item, click the Tax tab on
the bottom right, and use the drop down under Tax Table to attach the VAT tax. For the price of these
items, enter what the price would be including the tax. This is done via the Pricing tab on the bottom
right when an item is selected. (See Item Builder->Items->Assign Family, Attach Price...and Tax.)

Step 3. 

You can put a check in the box next to the "Apply VAT on bar orders only" if you want the VAT only to
apply for the Bar. 

*Note:  If you order the same items while in Dining or any other mode with the “Apply VAT on bar orders
only” checked on, the tax will act as a regular tax instead of VAT. This also holds true if an order is taken in
the Bar mode and then moved from a seat in the bar to a table in dining. Once you go to the Dining mode
and pick up this check that was moved, you will see that the tax is being applied as a regular tax instead of
VAT.

2. Go to System->Rounding. In the Round to Nearest field, you can enter a sufficient amount to
ensure you will not have to deal with unwanted change. Choose Round to nearest +/- in the Round
Calculation field. 

*Note: Rounding needs to be enabled because when you order multiple items that have VAT, the tax is
calculated on the subtotal of all these items together, not each one individually. Therefore, the final price
may need to be rounded by a few pennies from time to time so that the final price comes out to an even
dollar amount when there are multiple VAT items on a check.

Step 4. 

You can Disable VAT when food items are present. Go to Item Builder (under General) and click on the
Departments tab. Under the Families section choose "Disable VAT" for the food families. (See Item
Builder->Departments.)

*Note: If you check this box for any particular family, any time something from that family is added to a check,
the entire check will change to normal tax. All items that have VAT will be disabled and those items will be charged
with regular or 'add-on' tax instead.

Step 5. 

Go to Stations (under Hardware), go to the Tax tab and add the VAT tax to all stations that need it.  If
you do not add the tax here it will not be charged.

See Hardware->Stations if you need assistance creating stations or adding taxes to them.

Example of How Value Added Tax will Look on your check:
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Value Added Tax is calculated on an item by item basis. The whole tax applied to a check is calculated on
the subtotal of the whole check, not on the individual items. This means when you set an item's price to
be $1.00 (including tax) and the price of the item without VAT would be $0.94, the system is calculating
the total of the check, not the price of the one item.

Example: Place an item in the system with a price of $1.00 with VAT checked on for the tax. Turn system
rounding off if you have it on. The $1.00 is including the .06 cents of tax. Now go to the POS (front end) and ring
in that item with the price of $1.00. The first item's total would be $1.00. Now add the same item a second time.
Now the check is $1.99 instead of $2.00. This is because the system is calculating what the tax would be on the
real price of the item (0.94 cents) rather than the price of the item with the VAT. Therefore the total price of two
items at 0.94 cents would be $1.88, not $2.00. This means the tax that is calculated would end up being 11 cents
instead of 12 cents on the item, therefore bringing the total to $1.99 instead of to $2.00.  So this is why rounding
usually needs to be enabled.
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Part 33 Adjustments

Under the Financial section click on Adjustments.

Adjustments

Adjustments Setup holds the following settings:

1. Maximum Adjustments Allowed
 
2. Create Adjustments

3. Adjustment Reasons

4. Void Reasons



Version 6.1.16

458

33.1 General Tab

Under the Financial section click on Adjustments. Select the General tab.

General

Here you specify the maximum number of adjustments allowed per check.

*Note: -1 value allows unlimited adjustments.

*Note: This setting does not include Item Adjustments.
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33.2 Adjustments Tab

Under the Financial section click on Adjustments. Select the Adjustments tab.

Adjustment List

Here you define your adjustments.

Adjustments that you add show up under the Adjustment list.
 

- Add Adjustment -

In the Adjustment details part of the screen click the  button, fill out the fields and check the
appropriate check boxes below.

Name Enter name for the adjustment.

Button Name Text that shows on the button in SoftTouch.
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Check Descr. Text for adjustment to be explained on the printed check.

Adjustment Type Choose what kind of adjustment it will be.

 Choice of:
· Discount
· Surcharge
· Comp
· (X) for 1  (eg. 2 for 1)

___ for 1 Used with (X) for 1 adjustments to specify value for (X).

Amount $ The adjustment will subtract the dollar amount you plug in. 

Use either this OR a percentage, not both.

Fixed Amount The adjustment will change the price to the dollar amount
you enter here.

This is particularly useful for items with multiple price
schedules. If a pizza is $7 for lunch but $8 for dinner and you
want to have an adjustment to make the pizza $6, you could
enter $6 here and check on the Fixed amount option.
Whatever you apply this adjustment to will then become $6.

This also enables you to have an adjustment like this: "Buy
one Pizza, get the second for $4.99." You would enter $4.99
here and check on the Fixed amount option. Then you can
apply this adjustment to the second pizza when it's ordered.

Percentage % The adjustment will subtract the percentage amount you plug
in.

Use either this OR an Amount $, not both.
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Adjustment Group Choose the group an adjustment will be applied to.
 

Check/Seat/Super Adjustment - Adjustment can be
applied to the whole check, to a single seat on the check, or
to a single super department on the check (allows you to
discount food but not liquor, for example). (See Item
Builder->Departments to learn how to set up
departments.)

Item Adjustment - Adjustment only works on items that
have this adjustment specifically assigned to them in
BackOffice. (See Item Builder->Items->Assign Family...
to learn how to add an adjustment to an item.)

Global Item Adjustment - Adjustment can be applied to
any item on a check without having to specifically assign it to
an item in BackOffice beforehand.

Visit Requirement Number of loyalty visits required for this adjustment to take
effect.  When this adjustment is used, the number of visits
specified here will be deducted from the loyalty account that
is assigned to the check. (See Loyalty to learn how to view
and use a customer's loyalty information.)

Point Requirement Number of loyalty points required for this adjustment to take
effect.  When this adjustment is used, the number of points
specified here will be deducted from the loyalty account that
is assigned to the check.

Schedule Enter the schedule that this adjustment should apply to (only
if it is for special schedules, otherwise leave blank).

Schedules must be created before they appear on this
drop-down. See Scheduling->Add Schedule to learn how to
do this.

Active Checked by default; uncheck to deactivate the adjustment.

Show On Check If checked, the adjustment will be shown on the check.

Charge Tax If checked, the tax will be calculated on the price before the
discount is applied.

If unchecked, the tax will be calculated on the price after the
discount is applied. 
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Secure (Requires
Manager Approval)

If checked, manager's verification will be required.

(X) for 1 applies to
multiple items

You can use an (X) for 1 (e.g., 2 for 1) on different items, not
just the same item (e.g., You can have a 2 for 1 on any
entree: buy a steak dinner, get a chicken dinner free. The
lower priced item will be free.)

In order for the (X) for one adjustment to work, you would
assign it under the Adjustments tab for all the items it would
affect.

Example: You may create a discount that says buy one appetizer
and get one appetizer free, or even program it to get the second
at 50% off by entering 50% in the percentage field instead of
100%. 

Disable automatic (X) for
1

If you have a 2 for 1 discount, or any buy x number and get 1 free
discount, if you do not want the discount to automatically be
applied during the time specified in the schedule, select this box. 
The 2 for 1 or other discount can still be used, but an employee
would have to tell the system to apply the discount to the check.  
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33.3 Reasons Tab

Under the Financial section click on Adjustments. Select the Reasons tab.

Reasons

Here you may enter reasons for your adjustments.

 

- Add Adjustment Reason -

First select an adjustment you want to add reason(s) to by going to the Adjustment list under the
Adjustments tab and selecting one. Now click the Reasons Tab. In the Reason detail for this

adjustment part of the screen click the  button and type in the adjustment reason.
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33.4 Void Reasons Tab

Under the Financial section click on Adjustments. Select the Void Reasons tab.

Void Reasons

Here you define reasons for the orders that get voided in the POS system.
 

- Add Void Reason -

In the Void reason details part of the screen click the  button and type in the void reason.  When
you void an item in SoftTouch, this list will be displayed so a reason can be selected.
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Part 34 Sales/Journal View

Under the Financial section click on Sales/Journal View.

Sales can be accessed in Sales or Journal view:

1. Sales
 
2. Journal
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34.1 Sales

Under the Financial section click on Sales/Journal View.

Sales View

The sales view portion of BackOffice gives you information about the transactions rung up
throughout a day.  You can select a date(s) to view transactions for and narrow your search even
further with the View by and Group by options.

Operation Start Select the starting date that you wish to view transactions
for.

End Select the ending date that you wish to view transactions for.

View by
You have the option to view transactions by Check
View, Super Department View, Department View or
Family View.  The system will default to Check View.

Group by

You have the option to sort transactions by
Adjustments, Cashed out by, Check #, Check Print
Time, Closed, Date/Time, Delivery, Gratuity, Guest #,
Op Date, Owner, Payment, Payment $, Payment
Count, Payment Tip, Seating, Status, Subtotal, Tax,
Tax Exempt, Tip, Total, Type, Void, and Void Reason.  



Version 6.1.16

468

The system will fill in today's date by default.  You get a lot of information about each
transaction. In addition to the information shown below, if you scroll to the right you will also see
Payment Tip, Owner, Cashout by, Date/Time, Closed, Guest #, Check Print Time, Seating, Tax
Exempt, Void, and Void Reason.

At the bottom of the screen you will get totals for number of checks, a subtotal amount, any
delivery charges, tips, gratuities, adjustments, tax and total collected information.
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34.2 Journal

Under the Financial section click on Sales/Journal View.  Click on the
Journal tab.

Journal View

The journal view portion of BackOffice gives you information about the transactions rung up
throughout a day.  You will see 2 entries for each transaction.  The first shows the amount of the
sale and the second shows what bank the money collected was deposited to.

Enter the Operation Start and End dates and click Search to see transaction information falling
between those dates.
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Part 35 Tip Sharing

Under the Financial section click on Tip Sharing.

1. Tip Dispersions
 
2. Tip Pools
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35.1 Tip Dispersions

Under the Financial section click on Tip Sharing. Then click the Tip
Dispersions tab.

Tip Dispersions

The tip dispersions area is where you can set up dispersions from one employee's sales or tips to
be paid to another employee group.  Examples are bartenders who may be paying out a
percentage of liquor sales to a bar back who brings ice and restocks bottles when the bar is low
on liquor.  A server may pay a percentage of her tips to a busboy or food runner for helping with
their tables.

Name Select a name for this tip dispersion.

Active Check this box if the tip dispersion should be active.
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Fund Source From the drop-down list, select the job that is giving a
portion of their tips or sales to other employees that help
them.

Example: If a bartender is tipping out to the bar back a
percentage of their sales, enter the bartender job in this
field.

Schedule If you only want tip dispersions to calculate during a certain
period (e.g., if the bartenders only use bar backs during
Happy Hour), select the schedule time from the drop-down.

If this tip dispersion is to calculate at all times, make sure
you select the all day schedule.

To set up a schedule, go to the Scheduling section of the
manual.

Enable auto
tip deduction

If this box is checked, tips owed for tip dispersion will
automatically be deducted from this employee's charge tip
payout.

If this box is not checked, tip dispersion will be recorded
and reported but the employee will be responsible for
manually distributing tips to those who are owed.

Share Name You can create more than one group to be tipped. For
example, the bartender may tip out a percentage of liquor
sales to bar backs and a percentage of food sales to food
runners.  Enter a name to describe the group of employees
receiving the tips.

Active Check this box if the tip share should be active.

Participation For Participation, you can select auto-participating or
elective.  
•If you select auto-participating, when an employee clocks
in and works as the job type you specified in Job(s) to pay
out (last item on this chart), they will automatically be
joined to this tip dispersion and the tip dispersions earned
will calculate on their employee report.
•If you select elective, when an employee clocks in and
works as the job type specified in Job(s) to pay out, they
will need to go to the Employee Screen on SoftTouch and
manually join this tip dispersion group.
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Distribution Source For distribution source, you can select From sales, From
super departments, From departments and From tips.
•If you select From sales, you will not have a field asking
for additional information about the distribution source.
•If you select From super department, a field asking which
super department will appear and require a selection.
•If you select From department, a field asking which
department will appear and require a selection. The super
departments in this drop-down are what you created under 
Item Builder->Departments.

Source Type •Net Sales - sales after adjustments
•Gross Sales - all sales before adjustments are subtracted

Percentage What percentage should be paid out.

Fund Calculation •All Sales - The amount to be tipped out will be calculated
on all sales the employee clocking in with this job group
rings up.
•Weighted -The amount being tipped will be calculated on
sales rung while recipients of this dispersion are clocked in. 

Distribution Calculation •Equal Distribution - All funds accumulated for this
dispersion group will be equally distributed among all
employees clocked in under the job group specified.
•Weighted Distribution - Funds will be distributed
depending on number of hours worked by each employee.

For example, if there is $60 in this fund and Busboy A
worked 4 hours and Busboy B worked 2 hours, Busboy A
worked 66% of total hours worked and will receive $40
(66% of the total) while Busboy B worked 33% of the total
hours and will receive $20 (33% of the total).

Can breakout before the
shift is terminated

Check this is employees of this group can end their
participation in the pool before they close their shift.

Job(s) to pay out Select the job group that is to participate in this dispersion
and receive tip dispersions.

If an employee group is going to pay out more than one job group, press the +Add button in the lower
half of he screen to enter a second job to be paid out. The second job can be paid out a different percent
and have different criteria.

For example: A bartender pays out a percentage of liquor sales to bar backs who get ice and restock for
them.  They also pay out a percentage of food sales to food runners.
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35.2 Tip Pools

Under the Financial section click on Tip Sharing.  Click on the Tip Pools
tab.

Tip Pools

The tip pools area is where you can set up pools, where a group of employees all contribute their
tips into one pool and divide the tips when the pool is over and is committed.

You may set the pool up to be divided among one group of employees.  For example, all
bartenders contribute to this pool and they divide the tips when the pool has ended and is
committed.

You may also set the pool so one group of employees is tipped out and the balance of the pool is
divided among a second group of employees.  For example, you may want to have a bar pool that
tips out bar backs 3% of liquor sales and the balance in the pool is divided among the bartenders
that worked the pool.
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Name Select a name for this tip dispersion.

Active Check this box if the tip dispersion should be active.

Pool Source From the drop-down list, select the job that is giving a
portion of their tips or sales to other employees that help
them.

For example, if a bartender is tipping out to the bar back a
percentage of their sales, enter the bartender job in this
field.

Schedule If you only want tip dispersions to calculate during a certain
period (e.g., if the bartenders only use bar backs during
Happy Hour), select the schedule time from the drop-down. 
If this tip dispersion is to calculate at all times, make sure
you select the all day schedule.

To set up a schedule, go to the Scheduling section of the
manual.

Participation For Participation, you can select auto-participating or
elective.  
•If you select auto-participating, when an employee clocks
in and works as the job type specified in Job(s) to pay
out (the last item on this chart), he or she will
automatically be joined to this tip dispersion and the tip
dispersions earned will calculate on their employee report.
•If you select elective, when an employee clocks in and
works as the job type specified in Job(s) to pay out, they
will need to go to the Employee Screen on SoftTouch and
manually join this tip dispersion group.

Force checks
and tips to be
closed before
committing a
pool

Check this box if you want to make sure all checks are
closed and tips added before a tip pool can be committed. 
If a check is closed and a tip is added after a pool is
committed, it will not be added to the pool.

Share Name You can create more than one group to be tipped.  For
example, the bartender may tip out a percentage of liquor
sales to bar backs and a percentage of food sales to food
runners.  Enter a name to describe the group of employees
receiving the tips.
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Active Check this box if the tip dispersion for this group should be
active.

Participation For Participation, you can select auto-participating or
elective.  
•If you select auto-participating, when an employee clocks
in and works as the job type specified in Job(s) to pay
out (the last item on this chart), he or she will
automatically be joined to this tip dispersion and the tip
dispersions earned will calculate on their employee report.
•If you select elective, when an employee clocks in and
works as the job type specified in Job(s) to pay out, he or
she will need to go to the Employee Screen and join this tip
dispersion group.

Distribution Source For distribution source, you can select From sales, From
super departments, From departments and From fund/tips.
•If you select From sales, you will not have a field asking
for additional information about the distribution source.
•If you select From super department, a field asking which
super department will appear and need to be filled out. The
super departments in this drop-down are what you created
under Item Builder->Departments.
•If you select From department, a field asking which
department will appear and need to be filled out. The
departments in this drop-down are what you created under 
Item Builder->Departments.
•If you select From fund/tips, you will not have a field
asking for additional information about the distribution
source.

Source Type •Net Sales - sales after adjustments 
•Gross Sales - all sales before adjustments are subtracted

Percentage The percentage of the tip dispersion that should be paid out
to this group.

If you only have one group to be paid, you will enter
100 as the percentage.

If you pay out a bar back group (or any other group of
employees) and the bartenders (or any other group of
employees) are paid afterward, you would enter 100
as the percentage for the last group.  This is because
the last group will split 100 percent of what is left in
the pool.
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Distribution Calculation •Equal Distribution - All funds accumulated for this
dispersion group will be equally distributed among all
employees clocked in under the job group specified to
receive this tip dispersion.
•Weighted Distribution - Funds will be distributed
depending on number of hours worked by each employee. 
For example, if there is $60 in this fund and Busboy A
worked 4 hours and Busboy B worked 2 hours, Busboy A
worked 66% of total hours worked and will receive $40
(66% of the total) while Busboy B worked 33% of the total
hours and will receive $20 (33% of the total).

Early Break
Out
Calculation

•Equal Distribution - If an employee breaks out of the
pool early, they still get an equal share of the pool at
the time it is committed.
•Weighted Average - If an employee breaks out of the
pool early, they get a percentage of their share based
on the total hours they have worked versus the total
hours worked by all employees in this job group.  
•None - Employees will not break out early.

Priority Set what priority this payout has.  If set to 1, this
group will be paid first.

Job(s) to pay out Select the job group that is to be paid the portion of the
pool you just set up.
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Part 36 Miscellaneous

The Miscellaneous section.

The Miscellaneous section contains the following:

1. Activations

2. Surveys

3. Receipt Template

4. Chalkboard/Specials

5. $ Paid/Quick Messages/Shifts

6. Jobs

7. Security

8. Reports

9. Database Maintenance

10. Monitor Stations

11. Import/Export
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Part 37 Activations

Under the Miscellaneous Section click on the Activations.

CANNOT CHECK WHILE ON THE VIRTUAL MACHINE

Activations

Note: The Activations area can only be accessed on the server by an employee with the proper security clearance for
this area.

The License Information area shows dongle, dealer, and customer information as well
as licensed products and product updates.

The Activate Products screen is where you enter activation keys to register SoftTouch
products.
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The Online Ordering Services are is strictly used by SoftTouch as part of setting up
Online Ordering for the Restaurant.



Version 6.1.16

Part

XXXVIII
Surveys



Version 6.1.16

485

Part 38 Surveys

Under the Miscellaneous Section click on the Activations.

Surveys

This section is reserved for future use.
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Part 39 Receipt Template

Under the Miscellaneous Section click on Receipt Template.

Receipt Template

Here you customize how your receipt header and footer are going to look. (If you need to alter other parts
of the receipt, refer to Administration->Template Screen., noting that what you have entered here will
appear simply as the <receiptheader> and <receiptfooter> tags there.)

You can type on the large white space and refer to the instructions on yellow. Further explanation follows
on the chart below.
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<logo> Logo Prints your logo. Refer to your printer's manual
regarding how to load your logo. You may also need to
enter that printer's codes, including the Logo code (see 
Hardware->Printers/Coursing->Print Codes).

<cr> Carriage Return Starts new line (equivalent to hitting Enter key on your
keyboard).

<w> Start Wide Print Enter immediately before the start of text you want to be
bold.

</w> End Wide Print Enter immediately after the end of text you want to be
bold.

<r> Start Red Print Enter immediately before the start of text you want to be
red.
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</r> End Red Print Enter immediately after the end of text you want to be
red.

<c> Start Center Alignment Enter immediately before the start of text you want to
have middle alignment.

</c> End Center Alignment Enter immediately after the end of text you want to have
middle alignment.
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Part 40 Chalkboard/Specials

Under the Miscellaneous section click on Chalkboard/Specials to open
Chalkboard and Specials messages setup screens.

Chalkboard

When you click the Chalkboard tab, you may enter any information you wish to communicate to all
employees as they clock in.

When you click the Specials tab, you may enter your daily specials (with their prices if you wish) as a
reminder for employees to offer them to guests.
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Click the  button when you're finished.
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Part 41 $ Paid/Quick Msg

Under the Miscellaneous section click on $ Paid/Quick Msg.

$ Paid/Quick Msg

Here you can predefine messages that you quickly want to access to modify an item you are ringing up. 
You can also list reasons for Paid Ins/Paid Outs as well as list reasons that a drawer, pocket or any bank of
money is over or under when counted at the end of the shift.

Quick message list

Access this section by clicking the Quick Message List tab.

Click the Add button and click in the new white space under Quick message to start typing a message that can be
used when ringing up orders in SoftTouch.

Example: A customer wants his steak well done and a drink with no ice. So if you predefine those two messages
here an employee can simply choose the message with a press of a button in SoftTouch instead of entering it
manually.

See images:
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Over/Under Reasons

Access this section by clicking the Over/Under Reasons tab.

To create a list of reasons a drawer, pocket or any bank of money may be over or short when the money is
counted at the end of a shift, click Add, type the name under reason and press the save button when
done.

 

Cash Paid

Access this section by clicking the Cash Paid tab.

For Paid In/Paid Out, press Add and first select if this will be a Paid In or a Paid Out under type.  Next type
in the name of this Paid In or Paid Out under description.  Save the information when complete.
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Shift Descriptions

Access this section by clicking the Shift Descriptions tab.

Press the Add button, click the blank space under Shifts, and type in a shift name. Save when complete.

BackOffice lists All Day Shift, AM Shift, and PM Shift by default, but you can delete these or change the
names as needed.

You can add these shifts to an employee's job (see Employees->Job).
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Part 42 Jobs

Under the Miscellaneous section click on Jobs.

Jobs

Here you create jobs and define what the system will require of employees when they are clocked in to this
job group.

- Create a Job -

In the Job Description part of the screen click the + sign to add a job. See image:

In the Job Description field under the Job Detail tab, type in the name of the job. Click the Save
button.

You have just created a job. To learn how to assign jobs to an employee, see Employees->Jobs tab
(under General). To learn how to configure security depending on the job type, see Security (under
Miscellaneous).
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But we'll continue in this section by talking about some of the options you have to define this job.

1. Job Detail

2. Closeout Options

2. Check Transfers



Version 6.1.16

500



Version 6.1.16

501

42.1 Job Detail Tab

Under the Miscellaneous section click on Job/Tip Dispersion. Click on the
Job Detail tab.

Job Detail

- Job Details -

Here you define the setup for payroll specific items for each separate job. Remember that you are editing
the details for whichever job description above has an arrow next to it.

Job Description You can name the job description whatever you would like. Normally
people name it after the job they are defining for the other sections
(ie. tip dispersion and check transfers).

Job Type Select a job type for each job.
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Show on all
employee list

This checkbox allows these jobs to be viewed under the Change
Employee button in the Employee area in SoftTouch and the Change
Server button inside an order, when moving a check to a different
employee. It is recommended that Managers and Owners not be
checked to display in the list.

Disable job from
labor sales alert

If checked, the job will not be factored in the calculation for the labor
sales alert.

Collect tips daily If checked, employees with this job will be able to collect tips
daily when they close out rather than waiting to get paid
with their paycheck.

Enable tip deduction If checked, the system will handle tips for the selected job.

If, on the other hand, tips should be withheld and given as
part of the paycheck manually, disable this feature.

Auto join hostess
zone

Checking this option will automatically assign servers to
seating zones rather than zones needing to be assigned
manually.
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42.2 Closeout Options

Under the Miscellaneous section click on Job/Tip Dispersion. Click on the
Closeout Options tab.

Closeout Options

Enable quick
closeout

This will move through the steps of closeout automatically, meaning
that once a step is finished it will go right to the next step.

Have the manager
review tips before
the bank drop

The employee can closeout but the bank will not drop until the
manager has reviewed tips. This feature can help prevent employee
theft and mistakes (and increase customer trust) as an employee
may have entered a higher charge tip than a customer wished to
give.

If this option is checked on, it can also be useful to enable the Print
charge tips report on closeout option so that the server can bring
that report to the manager to review the tips.

Always auto deduct
tips from this bank

You can select a bank from the drop-down that all employees must
go to at closeout to retrieve cash for their charge tips. This feature
can help prevent employee theft and mistakes.

Example: If you select the cashier's till, an employee closing out
would receive a chit printed with the tip amount, bring it to the
cashier, and then the cashier would give the server that cash
amount.

Print the employee
report on closeout

If checked, the employee report will automatically be printed when
an  employee with the selected job description closes out.



Version 6.1.16

504

Print the charge tips
report on closeout

If checked, the charge tips report will automatically be printed when
an employee with the selected job description closes out. This can be
particularly useful if a manager must review tips before the bank
drop (the server can bring the report to the manager to review tips).

Print driver detail
report on closeout

The driver detail report can automatically be printed when an
employee with the selected job description closes out. It can be
printed at 40 columns or 80 columns; or select "Disable" not to use
this feature.

Configure to use
minimal closeout
procedures

This will change your settings to the following:
· Enable quick closeout checked on
· Print driver detail report on closeout set to Disable
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42.3 Check Transfers Tab

Under the Miscellaneous section click on Job/Tip Dispersion. Click on the Check
Transfer tab.

Check Transfers

Scenario 1 (Servers): Many restaurants allow servers to ring up sales in Delivery or Take-out mode, but
they do not want these types of orders to count against their sales. Also, they may not want these sales to
count when calculating the Tip Sales %. In addition, the servers must have no open checks in order to
clock out and go home. So they used to have to get a manager to transfer the checks manually to another
employee before they could go home. After a check has been transferred, it can be cashed out by either a
manager or a cashier who has access to pick up other employees' checks.  You can create a "Virtual"
employee and have the checks automatically transferred to this employee as soon as the server sends
them.  Then they no longer belong to the server and a cashier or manager can cash those checks out.

Scenario 2 (Cashiers): You may also want to set up check transfers for cashiers as well. One possible
reason for this is that the cashier will be able to go home if checks they rang up have not been cashed out
yet. Cashiers will typically have all check types transferred to a "Virtual" employee.

To do this:

· First you will need to create a "Virtual" employee. Do this by just creating a new employee with the
name of "Virtual." See Employees (under General) for instructions on creating an employee.

· Return to this Jobs area and the Check Transfers tab.
· From the upper list under Job descriptions, select the job you would like to set up a check transfer

for.
· In the Check Type field, select a type from the drop down list.
· In the Transfer Check To... field, select the "Virtual" employee you created in the first step.
· Press Add if you want to repeat this process for other types of checks. You cannot set up two check

transfers of the same check type under one employee's Check Transfers screen.
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*Note: This method will actually transfer the check to the virtual employee you specified when the check is sent.
This 'virtual employee' does not have to be clocked in and does not have to have a drawer assigned. In a typical
situation, a manager or cashier will cashout the checks assigned to this "virtual" employee.

Also, please note that the person who rang up the check is still accounted for on the kitchen printers. So if
a chef has a question about an order, they will still know who took the order.
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Part 43 Security

Under the Miscellaneous section click on Security.

Security

Security explanation includes the following:

1. About Security

2. Add Security Group

3. Add Security Items to Security Group

4. Move Security Items

5. Delete Security Group/Item

6. Security Log
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43.1 About Security

Under the Miscellaneous section click on Security. Click on the Security Setup
tab.

Security Setup

Here you define security groups (normally by the job type). These security items let you specify which
employee groups will have access to which actions. There are two areas of security items: BackOffice
and SoftTouch.

In the upper left side of the screen you create Security Groups and in the lower left you see Group
Items assigned to the highlighted group. On the right side of the screen you can see All security items
that you will add to the security groups on the left.
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You will also notice that there are two columns just to the right of the Group items: Log and Perform
Override. These are self-customizable for each action for that security group.

- Log -

The Log column is used to track activity for the selected security action. Simply check the items you want
to log and view them on the Security Log tab. This is great for logging and viewing suspicious activity.
You can view this log by clicking on the Security Log tab.  

- Override -

The Override column is used to grant override abilities for the security action selected. This means that
an employee can use their login for override popups to let other employees into secure areas in the
system.

Example: A new server might have very limited security to control their activity. S/he will probably work with a
more experienced, trusted employee who has greater liberties with security. When the new server needs to do a
discount or take cash or some other security-related activity, the training server can use his/her login to override
the activity.

This was implemented to reduce, if not eliminate, the abuse some servers or bartenders attempt to do to
"cheat" the system. Let's say a less than reputable server gains access to a busser's login. The busser(s)
have extremely limited security, but the server can use the busser's login to start a check and then use
his/her login to override through the rest of the check process and cashout. Now s/he has effectively
created a check and pocketed the cash, and the owner of the check is virtually untraceable.

Now, with this security feature, you can reduce or remove all override ability to eradicate that type of
activity. At the very least, you can log and view that activity and catch the thief.
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43.2 Adding Security Group

Under the Miscellaneous section click on Security. Click on the Security Setup
tab.

Add Security Group

In the upper left side of the screen click the  button. A blank space with a cursor line will appear. Type
in the name for this security group.
 

Then click the  button to save it.

Change Name

A Security Group's name can be changed at any time. Highlight the Security Group name you would like to
change and click on it. Once you have done this, just type in the new name for the Security Group, then
save it.
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43.3 Adding Security Item(s) to a Security Group

Under the Miscellaneous section click on Security. Click on the Security Setup
tab.

Add Security Item(s) to a Security Group

On the right side of the screen select the Security Item(s) you wish to add to the selected Security Group.
To select more than one item, press and hold the Ctrl key on your keyboard and click on every item you
wish to add.

After you have selected the Security Item(s) you wish to add to the Security Group, highlight the Security
Group name in the upper left.

Next, click the  button in the Security group items toolbar in the middle left of the screen. Click "Yes"
to the confirmation dialog that pops up ("Add all items from the right?). See image below:

 

The Security Item(s) will now be listed in the Security Group you had selected. Remember to check Log
and/or Perform Override where desired.

 



Version 6.1.16

514

Determine Security Item(s) Name

If an employee is trying to perform an action that they are not authorized to do, you will see a message
like the one below appear on the screen.  The box in the top left will disappear after a few seconds, but the
override keypad will remain.  The name of the security item that would need to be added to the security
group this employee belongs to is listed below the word Override on the top right button on the keypad.
In this case, this employees security group does not have the timeeditor function tied to it.  
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You can type in the security item name shown above in the Keyword Search field as shown below.
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Then, making sure you have the right Security Group highlighted, press the +Add button to add it to the
existing privileges this employee security group has.
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43.4 Copying Security Item(s)

Under the Miscellaneous section click on Security. Click on the Security Setup
tab.

You can copy Security Items from one Security Group into another.  This is very useful if you want to
make a new security group that is very similar to an existing security group.

Copy Security Item(s)

To copy an item highlight it first by clicking on it. To copy more than one item press and hold Ctrl key on

your keyboard and highlight all  necessary items. Then click the  button.  

If you wish to copy all items from a group, you can press and hold the Shift key on your keyboard then
select the first item in the list and, with the Shift button still depressed, select the last item in the list.  All
items in between the first and last item will be highlighted.

 

*Note: Copy command always copies items from one location to another.

Next, highlight the Security Group you want to copy this item (or these items) to by clicking on its name.

Then click the  button.
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43.5 Deleting Security Group/Item

Under the Miscellaneous section click on Security. Click on the Security Setup
tab.

Delete A Security Group

Highlight the security group you want to delete by clicking on it, and then click the  button. Click "OK"
to the confirmation dialog that pops up ("Delete record?"). This will delete the group and all the security
items in it.

 

Delete A Security Item

Highlight a security item you wish to delete by clicking on it. If you wish to delete multiple items press and

hold the Ctrl key on your keyboard and highlight the necessary items. Then click the  button and click
"OK" to the confirmation dialog that pops up ("Delete all selected items?"). See image below:
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43.6 Security Log

Under the Miscellaneous section click on Security. Click on the Security  Log tab.

Security Log

The security log shows the information for any security item that has been checked on for the "log" option
under the security group items, beginning from when it was first checked on.

Example: The security log is checked on for the Server security group for every time they clock in our out. This
means the information will then be recorded and posted into the Security Log every time an employee that has the
security group "server" clocks in or out.

*Note: There are internal logs in the system that will always show.

Scroll the screen over to see the rest of the categories and information.

The Security log can be exported out of BackOffice as either an HTML, Excel, or Text document.

The Security Log can be sorted by a start to end date and can be grouped by various options.

- Log Grid View -

The Log Grid View is set up much like an excel document. You can expand the areas for which you
want to be able to view all of the text (such as the "Description" if it is cut off) or shrink the areas
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you don't need to see or that have extra space so you can see more categories at once. Use the scroll
bar at the bottom of the screen to view categories that are not currently visible.

- Log Detail View -

The Log Detail View gives you a vertical detailed view of an item you have selected from the Log Grid
View. Sometimes the Detail area at the bottom gives more information depending on the action
having been logged.
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Part 44 Reports

Under the Miscellaneous section click on Reports.

Reports

This section explains the following:

1. View, Configure, and Print Reports

2. Edit Reports
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44.1 View, Configure, and Print Reports

Under the Miscellaneous section click on Reports. Click the Report Runner tab.

This section explains how to run, configure, and print reports.

- Run a Report -

All reports are smartly grouped into separate sections. Click the plus sign of the desired group to show the
reports in that group (or the minus sign to hide them again), and then click on the report you wish to
view. On the right side of the screen, select its parameters. Then click the View report button.

 

- Report Configuration -

Certain reports may benefit by setting up Day Parts. Do this by going to the Report Configuration tab.

Use the Add button and click in the blank field under Description to type in any name for a day part.
Then click in the space under Start Time and begin typing the time at which that day part begins. You will
notice that it will automatically fill in the time once you begin typing and you can click on each component
(hours, minutes, and am/pm) to edit it.
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This can be used with the Family Sales Report and Department Sales Report. In order for the day
parts you've entered to show on your report, change the Day Parts field to Yes.
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- Print a Report -

After you run a report, you may print it or view the next page or zoom in or out by clicking on the
appropriate button.

To print, use the Print... button at the top left of the screen.  If you use the Print button at the top right
of the screen, you will print a screen shot rather than just the report.
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The report can also be exported (and saved to the hard disk) by choosing the format and then clicking the 
Export... button.
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44.2 Edit Reports

Under the Miscellaneous section click on Reports. Click the Report Editor tab.

You can use BackOffice to edit reports, including information they show you and where and how that
information is displayed.

This section begins with the basics of editing reports, including selecting a report to modify, moving and
resizing items on the grid, changing report settings, and understanding basic item properties.

- Select Report to Modify -

Use the Report to modify drop-down menu to select the report you would like to edit. See the image
below:

The reports currently available for modification are the reports most regularly used.

- Moving/Resizing Items on the Grid -

When you select a report to modify, that report will appear on a grid. One text character can appear per
one square on the grid.

Click on a string of text to select that item. When it is selected, black dots will appear around the edges of
that item. In the image below, "***********TIP DETAIL***********" has been selected.
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To change the size of the selected item, click and drag on any of the dots. When you move your cursor
over one of the dots you will notice that it changes to a double-sided arrow indicating the directions
clicking and dragging that dot will allow you to move the border of that item. The text may be cut off if the
item's size is too small. If the item brings up a number or something other than what is shown, you just
need to be sure there is enough space for whatever is actually going to show up on the report.

To move the selected item, click anywhere inside of the item (but not the dots) and drag to the desired
location.

You can delete an item by selecting it and hitting Delete on your keyboard. You can also delete multiple
items at once if you have clicked and dragged to create a dashed-line box around multiple items.

You can select multiple items at once. Click anywhere on the report and drag; this will form a box with
a dashed line. Every item that passes into that dashed-line box will be selected. All selected items will
have gray dots around the edges. You can then click anywhere in the middle and drag to move all of
these items. Or you can press Delete on your keyboard to delete all of these items.

- Report Settings -

On the right side of the screen, the Report Settings tab allows you to make some basic format changes
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to the whole report.

Report Height This will change the number of squares that appear vertically
(rows) on the report grid.

*Note: You cannot change report width; it is set up for a
40-column printer.

Margins When you increase the margins from 0, you will notice gray
lines move inward from the outer edge of the report. Nothing
will print outside of the margins, even if items appear there.

Left - The first field will change the number of
squares/columns on the left margin. The second field will
change the number of squares/columns on the right margin.

*Note: Some printers require left/right margins.

Top - The first field will change the number of squares/rows
on the top margin. The second field will change the number of
squares/rows on the bottom margin.
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Negative Format This changes how negative numbers appear on the report -
either with a negative sign or in parentheses.

- Item Properties -

When you select an item, its properties will display in the bottom right corner of the screen. In the
following example, "TIPS OWED FROM HOUSE" is selected, so you can see (and change) its properties.

Different items will have different and additional types of properties (see Add Report Data), but here are
the ones that are common to most:

Alignment Select an alignment from the drop-down. This will affect
where in the item the text is placed.

taCenter - This will center the text.

taLeft - This will make the text start on the left-most edge of
the item.

taRight - This will make the text end on the right-most edge
of the item.

Group This shows what group this item is part of. You cannot change
the group. The five groups - Totals, Details, Data Items,
Parameters, and Report Items (includes Calculation,
Date/Time, Label/Text, and Separator Line)  - are discussed
next (see Report Data).
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Description This is the name of the item that shows up on the item on the
report grid to let you know what it is but will not appear on
the actual report (because the item retrieves changeable data
and displays that data when you run the report).

TextLeft This is the column number where this item begins. Changing
this number will move the position of the entire item, not just
the text.

TextTop This is the row number where this item begins. Changing this
number will move the position of the entire item, not just the
text.

TextWidth This is the number of columns this item occupies. Changing
this number will change the width of the item by increasing or
decreasing columns on the right-hand side of the item.
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44.2.1 Add Report Data
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- Add Report Data -

On the right-hand side of the screen, click the Report Data tab. This is where you can pick items to add
to your report.

To add an item to the report, simply click on one of the items listed to select it and then click on the
report grid where you would like to add it.

The Filter drop-down allows you to narrow down the list to show only the items in a particular group. All
Items shows all items in all groups. The groups are explained below. In each group, different items are
available depending on which report you are editing.

When you select an item it will be highlighted blue and provide a basic description in the box on the
bottom.
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Let's look at each group. Remember, the items in each group have different properties, which can be
viewed and changed in the bottom right corner of the screen when an item is selected. Basic properties
common to most groups were discussed previously (see Edit Reports).

- Totals -

A total is generally going to be one number that is a total of data in your system.

Keep in mind that although these items have a description and show text on the report grid, all that will
show on the actual report is a number. Depending on your needs, you may want to create a text label
(discussed later in this section) on the report to say what that number is.
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TotalType This option will determine whether the number displays as
positive (select ttPositive) or negative (select ttNegative).

- Details -

Details are series of data pulled from your system. These often include both textual and numeric data. The
item Gross_Sales_by_Department, for example, is going to use department names you created in
BackOffice (under Item Builder->Departments) and numeric sales data.

HeaderLine1 Enter the text you want to display above the details.

*Note: The advantage to a header line rather than a
label/text item here is that these headers will only show if
there is data and it shows up on the report.
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HeaderLine2 Use this if you need a second header line of text to display
above the details.

ShowHeader True - The header will show up on the report.

False - The header will not show up on the report.

ShowTotals True - The total(s) of the details will be displayed.

False - The total(s) of the details will not be displayed.

SuppressTotal Reserved for future use.

TotalText Enter the text you want to use as a label for the totals. This
will only display if you have elected to show totals.

- Data Items -

These are pieces of information such as address and name that pull information entered into your system.

Data Items do not have any unique properties.

- Parameters -

Parameters are based on the information you select when running a report. For example, before you run
the Employee Shift Report, you are prompted to select an operation date, report size, employee name,
employee job, and shift, so the items available in the Parameters group when editing the Employee Shift
Report will show information you plugged in to these fields.



Version 6.1.16

540

ParamName This is like the Description for other groups (discussed
under Edit Reports); it is the name of the parameter item
and will not display on the actual report.

TextCase Use this to change how the case of letters will appear

csLowerCase - text will appear in lower case.

csNone - Text will appear as entered in your system.

csUpperCase - TEXT WILL APPEAR IN ALL CAPS.

- Report Items -

The same four report items are available for every report: Calculation, Date/Time, Label/Text, and
Separator Line. Each of these is explained here.

Calculation

Use this feature to create your own calculation based on a formula you construct using items present in
the report.
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Format ffCurrency - Use this if the result of the calculation is a
currency; this will display a dollar sign.

ffNone - Select this option if there should not be a dollar
sign.

Formula Click on the field here and a button with three dots will
appear on the right. Click this button to open a dialog box
where you will enter your formula.

This formula can include any item that appears on the report
grid. For the formula to work, you must type the item exactly
as it appears on the report grid, including capital letters and
underscores.

*Note: Make sure the item name you enter is the name of an
item that shows a number on the report rather than a text
label you created to accompany that number.

You can use parentheses as needed. Keep in mind that most
keyboards use an asterisk * for multiplication.

Example: (Cash + Credit_Cards) - Adjustment

Press Ok when you are finished.

On the report, the result calculation will be displayed. Create
a text label (discussed later in this section) if needed.

FormulaV This shows the formula you entered.

Date/Time



Version 6.1.16

542

This item adds the date and/or time at which the report is run.

DateType dtDate - This will show the date only.

dtDateTime - This will show both the date and time.

dtTime - This will show the time only.

Label/Text

This item adds exactly what you type in; it does not pull any data from your system but always shows
exactly what you have typed on the report.
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Text This is where you enter exactly what you want to appear on
the report.

Separator Line

This item adds a line if you want a line separating data.

When you click on the report to add it, it will automatically fit from the left margin to the right. If you
adjust the report size after adding the line, you may then need to manually adjust the size of the line.

LineType You can choose between a double line (ltDouble) or a single
line (ltSingle).

*Note: If you want to create some other sort of line, like a
line of asterisks, you can create a Text Label and type out a
line of asterisks.

44.2.2 Save, Load, Undo and Revert

Under the Miscellaneous section click on Reports. Click the Report Editor tab.

- Saving, Loading, Undoing, and Reverting Report Edits -

To save or load an edited report, revert back to other versions of a report, or undo changes to a report,
select the Report Editor option from the gray toolbar at the top of the screen. (Other functions of this
toolbar are discussed under BackOffice Toolbar.) 
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Save report changes Select this option to save the changes you made to this
report.

*Note: If you close BackOffice in the middle of editing a
report, changes will be saved.

Undo changes you
modified since the last
save

Select this option to undo all of the changes you made to this
report since the last time you saved.

Revert report back
from previous backup
copy

If you saved changes to a report (perhaps you just saved it
and didn't mean to), you can select this option to go back to
the last version of the report you saved before these most
recently saved changes.

Load report from
SoftTouch original
copy

Select this option to erase all of the changes you've ever
made or saved to this report and revert back to the way the
report originally was.

Load report file from
disk

If a version of a report has been saved and you would like to
access it, select this option to load that report file. This will
open up a dialog box that allows you to browse for the file on
your computer.

Save report file from
disk

This allows you to save this version of the report as its own
file. This will open up a dialog box that allows you to navigate
to a location and create a name for this report file.
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Part 45 DB Maintenance

Under the Miscellaneous section click on DB Maintenance.

The DB Maintenance screen contains the following features:

1. Clear Old Data Tab

2. Backup Settings Tab

3. Activate Data Redundancy Tab

4. Restore Redundancy Tab
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45.1 Clear Old Data Tab

Under the Miscellaneous section click on DB Maintenance.  Select the Clear Old
Data tab.

You can schedule automatic cleanup (removal) for your journal entries and system history or you can
manually clear the journal and history. Typically this is set to 13 months or 396 days. By default it is set to 0
and no data is ever deleted, but this does present the possibility of creating a very large database over the
course of a few years at a busy establishment.

- Automatic Data Cleanup Settings -

 

Keep history data for
(x) days

Keeps the system history for the specified number of days.
Everything prior to that is deleted. To disable enter 0.

REMEMBER: If you enable automatic data cleanup, manually back up your data if you didn't Z
out.

Manual History Cleanup

1. First back up your data before clearing the system history.

2. Specify the number of days you wish to keep in the system history (all sales data prior to the entered
number of days gets deleted).

3. Click on the Clear history data button.

- Archives -
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In versions 6.0 and later, you can create archives of historical data that can be retrieved in the future. 
This gives you a snap shot of what happened years ago without the need to use as much storage space
and processing resources.

When you press the Create Archive button you will be asked "Are you are sure you want to archive your
data?".  Press "Yes" to continue.  A dialog box saying "Archive Created" will appear letting you know when
the archive process is complete. Press "OK."

If you have archived data, you can delete it by selecting the archive with the appropriate date and time
stamp and then pressing the Delete Archive button. 
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45.2 Backup Settings Tab

Under the Miscellaneous section click on DB Maintenance.  Select the Backup
Settings tab.

Specify the location where you want the automatic backup to save the files (if you have the
automatic backup enabled).

Under External Backup Location, use the open folder (browse) button to locate the drive and
directory you want your database to backup to. (Most likely, it will be to the root of the external hard
drive or compact flash drive.)

You may also select the number of daily backups you wish to keep.
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45.3 Activate Data Redundancy Tab

Under the Miscellaneous section click on DB Maintenance.  Select the Activate
Data Redundancy tab.

Activate Data Redundancy

Simply follow the steps laid out on the screen as shown.

For Step 2, when you drop down the arrow, only your external drive will appear, so choose it.

In Step 3, click the "Activate" button.

*Note: You must use a USB 2.0 external hard drive. (USB 1.1 will create unnecessary slowness on the
server, since all data is being replicated to the external drive constantly.)

**IMPORTANT: Once you activate the data redundancy, make sure to always have the redundancy external
hard drive turned ON and connected to the server station at all times.
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45.4 Restore Redundancy Tab

Under the Miscellaneous section click on DB Maintenance.  Select the Restore
Redundancy tab.

Here is where you restore the data redundancy after server repair or replacement.
Simply follow the directions on the screen as shown.
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Part 46 Monitor Stations

Under the Miscellaneous section click on Monitor Stations.

Here you can either monitor the activity (without performing any actions) on any of your stations in the
restaurant or have full control over the chosen station from a remote location. You can monitor several
stations simultaneously. You can even take a Screen Capture of the station you are monitoring, which is
almost the same as if you were standing there at the station and taking a picture of the screen with your
camera.

First you must physically go to the station you wish to monitor and press the Remote Session
button from the General section of the Manager screen.

Monitor Station
 

Select the station you wish to monitor from the drop-down menu. Then click the Monitor Station button.

If the View Only check box is checked, you will only be able to watch (not control) the activity on the
selected station, so any of the mouse movements on your own screen will not be reflected on the station's
screen which is being monitored. However, if you wish to have control over the station as if you were
actually there in person ringing up the orders etc., you must uncheck the View Only check box.

If, while monitoring, you see something happening on the screen that you would like to have a picture of,
just click the Screen Capture button. A small dialog will be displayed confirming that the screen has been
captured and that the file name is such-and-such.bmp  Click "OK." The screen capture will be
automatically saved in the SoftTouch installation directory.

If you wish to stop monitoring a station, simply click the Close Monitor button.



Version 6.1.16

Part

XXXXVII
Import/Export



Version 6.1.16

556

Part 47 Import/Export

Under the Miscellaneous section click on Import/Export.

Import/Export Screen contains the following features:

1. Import Tab

2. Export & Data Services Tab
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47.1 Import tab

Under the Miscellaneous section click on Import/Export. Select the Import tab.

 - Select the Import Tab -

NOTE: In order for the customer database to be imported properly into SoftTouch, it
must meet the following conditions:

· It must be a CSV delimited file.
· The fields must be in the following order with no extra or missing fields; FirstName,

LastName, Address1, Address2, City, State, ZipCode, Phone.

For example, a customer database would look similar to this if you were to open the file in
Notepad:

John,Smith,100 Some Road,,Some City,FL,12345,123-456-7890
Jane,Doe,150 Other Road,Apt. 5,Other City,CA,54321,987-654-3210

As you can see, John Smith has no Address2 field, but there is still a space there for it (notice
the two commas between "Road" and "Some").

If your file doesn't have the fields in the correct places, you should be able to open the .csv file
in Microsoft Excel and rearrange the columns into the correct order.

- To Rearrange the Columns in a .csv file (if needed) -

· Open your .csv file in Excel 
· If your file is in this format - FirstName, LastName, Phone, Address1, Address2, City, State, ZipCode

- you can see that the phone number is in the wrong place. We need to put it at the end.
· Once you have the file opened in Excel, click on the letter above the column that you need to move.

In this case it would be the column, "C." This should highlight the entire column.
· Now all you need to do is move your mouse right over the border of where it's highlighted. Your

mouse will turn into crossing arrows when you are in the right place. Then hold Shift and drag the
whole column to the right until you're at then end where the phone number is supposed to be and let
go.

· Now just save the file and make sure it's still in the .csv format.

- To Import a Customer File into SoftTouch -
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· Click on the "Open File to import..." button
· Browse for your file, highlight it and click the "Open" button.
· You will see a preview of the first customer in the file.
· Click the Next button repeatedly to ensure that the customers will be imported properly and all of the

fields are in the right places.  If you see any fields out of place, do not import the file.  You will need to
rearrange the fields in your file before importing.  See above for instructions.

· Once you are sure everything looks good, click the "Import Customers into SoftTouch" button.

· Click OK on the confirmation dialog. You will get another confirmation when the import has completed.
Click OK for that as well.

· Close and re-open BackOffice and then go to Customers (under General) to ensure that the customers
were imported. (See Customers if you need help navigating and using that area.)

The Delete customers imported on... button will delete customers that were imported on the date you
specify using the drop-down next to it.
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47.2 Export & Data Services tab

Under the Miscellaneous section click on Import/Export. Select the Export &
Data Services tab.

1. Export and Data Service List - List of pre-configured exports.

2. Export Builder - Utility for creating your own custom exports.

3. Manual Export - Manual export feature from earlier versions of SoftTouch.

47.2.1 Export & Data Service List

Under the Miscellaneous section click on Import/Export. Select the Export &
Data Services tab. Select the Export & Data Service List tab.

- Export & Data Services List Description -

Exports are grouped by categories.  Expand the category by clicking the Plus (+) sign next to it, or use the
minus (-) sign to collapse it.  Select any export.

Click on the Edit tab. The Edit tab contains the export information for each individual export.  This
information can be set differently for each export.
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Description Description of the selected export.

Export Format There are 5 different formats for exports; Acsii delimited,
Dbase, XML, Access, or Excel.  Choose the format you wish to
export to.

Program Windows path to the program you would like to use to open
the export file with. Use the "Select Program" button to
browse for the program.  This field is optional.  The "Run
External Program" button on the Execute Export/Data
Service tab will launch the program you enter here.

Export File To Windows path to the export location.  Use the "Select To..."
button to browse for an appropriate directory.  

Append date to
filename on export

Adds the current date to the filename.  For example,
employee.xls will become employee11202006.xls if this
option is checked.

Export/Execute on Z The export will automatically run during the Z process if this
option is checked.

Export documentation Creates an html file with a description of each column in the
exported data.  This will be exported to the location specified
in the "Export File To" field.

Once you are finished editing the settings for the export, click the save  button. 

Now, click on the Execute Export/Data Service tab.
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Ex
po
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Exports or executes the selected export or data service.

Ex
po
rt
Wi
za
rd

The wizard consists of 8 steps quick steps where you can specify details of how exactly you
want your data exported. Just follow the steps.

Ru
n
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Opens the external program that is specified in the Program field of the Edit tab.
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Allows you to preview the data before exporting.  This button will bring you to the Results tab.

Ex
po
rt
All
Da
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Sa
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s

Select a Date for which you would like to export all Daily Sales, then click on the "Export
All Daily Sales" button.

This will automatically run all exports in the Sales and System Data categories. 

The data in these exports is configured to work with Aspect Software.

*Note: You must have each individual export set up properly before exporting (i.e., Most
important part of setting up the exports- if you want a report to export you must have the "Export
Documentation" checked on).

47.2.2 Export Builder

Under the Miscellaneous section click on Import/Export. Select the Export &
Data Service tab.  Select the Export Builder tab.

The Export Builder is designed for advanced users only with advanced knowledge of SQL
databases. It is a very powerful tool that allows you to link data from different tables in the
database. Because of the advanced nature of the Export Builder we cannot provide support for
this feature.  

47.2.3 Manual Export tab

Under the Miscellaneous section click on Import/Export. Select the Export &
Data Services tab. Select the Manual Export tab.

All the data in SoftTouch is exportable (like Customers, Employees, Printers, Schedule Days and Times,
Adjustments etc.). You have the ability to export different data into a variety of electronic formats or into a
format used by SoftTouch.

If you want, you can even filter data that's being exported using the Filter Data button.

For instance: You are exporting the Customers table and you wish to export only particular customers from
that table.
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- Export Data -
 

Step 1. First, select from the list the table/data you wish to export, and then click the Open Table
button.
 

Step 2. If you don't want to filter the data, skip to Step 3. But if you wish to filter the data being
exported click the Filter Data button and in the screen that shows up enter your filter values then click
Add to list. For example: we want to export the customer whose last name is equal to Smith so we select
and enter the appropriate filter settings. See image below:

Step 3. Next choose the export method. Click the Export Wizard button.  The wizard consists of 8 quick
steps where you can specify details of how exactly you want your data exported. Just follow the steps.
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Part 48 BackOffice Toolbar

The Toolbar is located at the very top of the BackOffice within the gray
area.

*Note: This Section is for Dealers and any Owner/Managers set up to use
the area.

This is the regular screen that is shown for the Back Office Toolbar.

BackOffice Toolbar when you are in the Employees section

The only difference between this section and above is that the Employee drop-down shows up, allowing
you to unlock a particular employee if they have locked themselves out of BackOffice.

Example: A manager has typed in the wrong BackOffice password five times and is now locked out. He cannot
remember his password after he has been locked out, so he has to call SoftTouch's main office to unlock the
account. Once the account has been unlocked, the Employee must be highlighted then the Unlock Account option
from the Employee drop-down must be selected. Once unlocked, the employee can change their BackOffice
password to one they will be able to remember.

*Note: Charges may apply for getting the account unlocked.

BackOffice Toolbar when you are in the Item Builder section
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Everything in the Items list a dealer would use are the same things that are listed in Item
Builder->Command Bar. 

*Note: Currently the "Deactivate orphan items not in menu" and the "Delete orphan items not in menu" are not to
be used.

*Note:  The "Lock Menu" and "Merge Menu" are for online purpose only as of right now.
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48.1 Administration

 Under the Back Office Toolbar located at the Top of the Back Office
System in gray, Select the Administration Option.

The following BackOffice Toolbar settings and features in the Administration drop-down are explained in
this section:

1. Template Screen

2. System Reset

3. Database Maintenance
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The System Expressions, Run a SQL script, Configuration Editor, and Unlock Menu options are for internal
use only.

Refer to the Soft Touch knowledge base for instructions on how to use the Create ODBC User option. 

48.1.1 Template Screen

 Under the Back Office Toolbar located at the Top of the Back Office
System in gray, click on Administration then Template screen.

 

Here is where you design your print templates. Be sure to remain inside of the 40 character ruler to ensure
that all data prints on the receipt. You will notice that some tagged items go beyond the rule, but that is
ok because the actual item being printed is much shorter.

Under the Template part of the screen you have all the available tags for quick reference.
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- All the Tags Explained -
 

<cr> Insert carriage return.

<w></w> Wide print start and wide print end.

<r></r> Red print start and red print end.

<b></b> Thick print start and bold print end.
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<u></u> Underline start and underline end.

<c></c> Center text start and center text end.

<partial cut> Cuts the check, but not all the way so it is still slightly
attached to the ribbon of other checks.

<fullcut> Cuts the check completely.

<receiptheader> Print header. Remember, you've set up your header under 
Hardware section->Receipt Template.

<receiptfooter> Print footer. Remember, you've set up your footer under 
Hardware section->Receipt Template.

<date> Print date.

<time> Print time.

<operationdate> Print operation date.

<ordernumber> Print order number.

<ordertype> Print order type (COUNTER, DINING, BAR, DELIVERY,
TAKEOUT, DRIVETHRU).

<customername> Print customer name.

<customerphone> Print customer phone (usually used for deliveries).

<customeraddress> Print customer address (usually used for deliveries).

<customercity> Print customer city (usually used for deliveries).
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<customerstate> Print customer state (usually used for deliveries).

<customerzipcode> Print customer zip code (usually used for deliveries).

<zonecode> Print customer zone code (usually used for deliveries).

<complex> Print customer complex (usually used for deliveries).

<directions> Print directions (usually used for deliveries).

<gatecode> Print customer gate code (usually used for deliveries).

<customernotes> Print customer notes.

<customercard> Print either the customer card # or the RFID # assigned to
the customer.

<creditaccountinfo> Prints account number and name from accounts.

<taxid> Prints tax ID for non-taxable checks.

<taxdetail> Print tax table details on receipt to break down the tax info.

<printername> Prints printer name that printed the check.



Version 6.1.16

573

<items> Items can have the following properties and their values:

itemprice=yes or no (print item price or not)

modifiers=yes, no or priced (print all modifiers or none, or
print priced only)

modifierformat=red or black (print modifiers in red or black)

group=items or no (group items or not)

Example: 

A customer ordered two glasses of pepsi. 
Instead of printing on the receipt:

1 Pepsi
1 Pepsi

it would print:

2 Pepsi

voids=yes, no or items (print all voids or not, or print voided
items only)

otheritems=yes or no (print other items that went to
another printer or not)

disablechanges=yes or no (disables the message that
changes were made to the order)

barcode=yes or no (print barcode for items. Used with server
paging system)

bspacing=x (x can be integers from 1 to 9...this changes the
spacing between the server scan barcode and the chef scan
barcode to help prevent the wrong code from being scanned
accidentally.)

<labelitems> Use this for label printers.

modifiers=yes or no (print modifiers for label items)

messages=yes or no (print messages for label items)

<subtotal> Prints subtotal amount.

<orderpaid> For use with kitchen monitors, sends a "paid" or "not paid"
status.
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<loyalty> Prints loyalty details.

<companyname> Prints the name of the company associated with this customer
if this field is filled out.

<tax> Prints tax.

<gratuity> Prints gratuity.

<deliverycharge> Prints delivery charge.

<rounding> Prints rounding total.

<totalnotip> Prints total amount without tip.

<tiptotal> Prints total for all tips.

<total> Prints total amount.

*NOTE: every time there's an if statement in a tag it usually means "if something is so and so, then do
this."  Most of the time, whenever you see an "if" statement, there will also be a corresponding "endif"
statement placed after the information you want to display if that condition is met.

<iftiphandled> If tip has been entered before printing.

<iftipnothandled> If tip has not been entered before printing.

<ifnotip> If no tip.

<ifcredit> If payment type is credit.

<ifdebit> If payment type is debit.
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<ifcash> If payment type is cash.

<iftakeout> If the current mode is Take Out.

<ifcounter> If the current mode is Counter.

<ifdining> If the current mode is Dining.

<ifbar> If the current mode is Bar.

<ifdelivery> If the current mode is Delivery.

<ifdrivethru> if the current mode is Drive Thru.

<ifsignature> <endif> If signature is required by using "Min amount required for
signature" in the Credit Cards section.

<ifconveniencetipguestco
unt+> <endif>

If the guest count entered for "Convenience tip guest count"
in System->Tips is met or exceeded.

<conveniencetipamount1
>

Prints the tip calculated from the percentage you entered for
"Convenience tip percentage 1." Remember you've set it up
under System->Tips.

<conveniencetipamount2
>

Prints the tip calculated from the percentage you entered for
"Convenience tip percentage 2." Remember you've set it up
under System->Tips.

<conveniencetipamount3
>

Prints the tip calculated from the percentage you entered for
"Convenience tip percentage 3." Remember you've set it up
under System->Tips.

<conveniencetippercent1
>

Prints the percentage you entered for "Convenience tip
percentage 1." Remember you've set it up under 
System->Tips.
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<conveniencetippercent2
>

Prints the percentage you entered for "Convenience tip
percentage 2." Remember you've set it up under 
System->Tips.

<conveniencetippercent3
>

Prints the percentage you entered for "Convenience tip
percentage 3." Remember you've set it up under 
System->Tips.

<conveniencetiptotal1> Prints the total after the tip from the percentage you entered
for "Convenience tip percentage 1" has been added.
Remember you've set it up under System->Tips.

<conveniencetiptotal2> Prints the total after the tip from the percentage you entered
for "Convenience tip percentage 2" has been added.
Remember you've set it up under System->Tips.

<conveniencetiptotal3> Prints the total after the tip from the percentage you entered
for "Convenience tip percentage 3" has been added.
Remember you've set it up under System->Tips.

<gratuitycalc1> Prints gratuity amount calculated from Minimum Percentage
(example: $1.50). Remember you've set it up under Order
Functions->Bar/Dining.

<gratuitycalc2> Prints gratuity amount calculated from Suggested #1
(example: $1.60). Remember you've set it up under Order
Functions->Bar/Dining.

<gratuitycalc3> Prints gratuity amount calculated from Suggested #2
(example: $1.80). Remember you've set it up under Order
Functions->Bar/Dining.

<gratuitypercentage> Prints Minimum Percentage (example: 15%).

<gratuitysuggested1> Prints Suggested #1 percentage (example: 18%).

<gratuitysuggested2> Prints Suggested #2 percentage (example: 20%).
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<multitenders> Prints "Multi Tender" text to let you know there is more than
1 payment.

<tendername> Prints the payment type name (visa, amex, mastercard, cash,
etc).

<tenderamount> Prints the payment amount.

<tendertip> Prints the payment tip amount.

<paymenttype> Prints the payment type.

<authcode> Prints authorization code from the credit card company.

<refno> Prints reference number from the credit card company.

<paymentnumber> Prints unique number of payment (a Server uses that number
later on to add a tip amount specified by the guest to the
payment).

<creditcardnumber> Prints the last 4 digits of the credit card number.

<creditcardexp> Prints the expiration date of the credit card.

<creditcardname> Prints the name of the customer from the credit card.

<tendertotal> Prints the total of all payments given.

<guest> Prints guest count.

<change> Prints the change amount.

<checkdatetime> Prints when the check was started.
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<closedatetime> Prints when the check was finished.

<scheduledatetime> Prints when the order has been scheduled for.

<linebreak> Prints dashed horizontal line. You can specify number of
dashes if needed.

Example: <linebreak count=50>

<server> Prints Server's user ID.

<operationdate> Prints current operation date.

<employee> Prints user ID.

<stationnumber> Prints the station number.

<drawernumber> Prints the drawer number.

<drawername> Prints the drawer name.

<seatingnumber> Prints table/seat number.

<tablenumber> Prints table number.

<guestcount> Prints guest count.

<eatineatout> Will print Eat In or Eat Out (Counter mode ONLY).

<template> You can include another template inside your current
template.

Example: <template name=name>

*Note: template inserts are case sensitive.
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<amount> General amount for refunds or paid in, paid out.

<reason> Reason for refunds or paid in, paid out.

<title> Prints the title.

<clockin> Prints clock in time of the employee.

<clockout> Prints clock out time of the employee.

<timeclocks> Prints all the time clocks for the day.

<clocktotal> Prints total hours of being clocked in.

<zones> Prints employee zone detail.

<ordernumberbarcode> Prints a unique barcode for each order on customer's check.

<employeenumberbarcode
>

Barcode used to page the server who took the order.  The
server paging system must be installed.

<taxdetail> Prints a detailed description of all taxes charged on the check
(for use on the bottom of customer receipt).

*Note: Do not use in place of <tax> tag.

<station> The station location defined in BackOffice.

<coasternumber> Used in conjunction with coasters for counter mode. This will
print the number of the coaster given to the customer. 

*Note: This is used for counter orders only.

Under Template Definition part of the screen you create a template name and with the help of special
tags, design how it will look. Use the 40 character ruler to help with aligning the text on the printer.
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Under the Template Details part of the screen you can save a template to a file or open one from a file,
and you can specify the number of copies to print and the number of cash copies to print.
 

48.1.1.1Create a Check Template

 Template Tags

In the example below we will design a check template. Click the  button and on the left side in the

blank field marked with * type in the name for your template. Click the  button. You are now
ready to design with tags.

Check template tags:
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<receiptheader> print the header you have set up under Hardware
section/Receipt Template.

<cr> insert carriage return.

Date: <date>   Time: <time><cr> print date and time.

<w>Order #:
<ordernumber></w><cr>

start wide print, print Order number, end wide print
and insert carriage return.

<customername><cr> print customer name and insert carriage return.

<ifdining name=DiningHeader> if statement - if the mode is dining, include template
called DiningHeader.

<ifbar name=DiningHeader> if statement - if the mode is bar, include template
called DiningHeader.

<ifcounter name=CounterHeader> if statement - if the mode is counter, include template
called CounterHeader.

<ordertype><cr> print order type (COUNTER, DINING, BAR etc) and
insert carriage return.

<cr> insert carriage return.

<items itemprice=yes
modifiers=priced group=items
voids=items>

print item price, print modifier price, group items,
print voided items.

<linebreak><cr> print dashed horizontal line and insert carriage return.

<w>Sub-total: <subtotal><cr>
start wide print, print sub-total amount and insert
carriage return
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<gratuity text="Gratuity : " cr=1> this is kind of an invisible way to handle tags. In this
case it's the gratuity. Meaning, if there is no gratuity,
nothing will be printed, this tag will be ignored.
However, if there is a Gratuity it will be printed and
one carriage return will be inserted.

Tax      : <tax><cr> print tax and insert carriage return.

Total    : <total></w><cr> print total amount, end wide print and insert carriage
return.

<cr> insert carriage return.

<receiptfooter> print the footer you have set up under Hardware
section/Receipt Template.

<cr> insert carriage return.

<ordernumberbarcode> print a unique barcode for the order.

 - Check template result -
 

According to the design tags above, here is how our check will look.
 



Version 6.1.16

583

48.1.1.2Remote Ticket Template

Remote Ticket Template

- Remote Ticket with Items from Other Printers -

Some restaurants assign different items to go to different remote printers (Example: items that need to be
cooked in the kitchen are assigned to the Hot Printer, pizza items are assigned to Pizza Printer, subs are assigned to

Cold Printer etc.) and when a server sends the customer's order from SoftTouch, each item from that order
is printed at the remote printer it was assigned to go to and a cook knows what to make.

But what if the customer orders both, a hot item and a pizza? The hot item goes to the Hot Printer and
pizza goes to the Pizza Printer. The cook that receives the hot item is not aware that a customer also
ordered a pizza. And the pizza man is not aware that a customer also ordered a hot item.

You can customize the remote ticket template to show all items a customer ordered on each remote
printer.

All you have to do is customize the items tag a little. And to make it easier for chefs/cooks to read the

ticket, have the main item print in Bigger and Bolder characters using the wide print tags (

<w><items...></w>), separate it from all other items by a line (<linebreak><cr>) then list all other
items in smaller characters at the bottom (<items otheritems=yes...>)

Example: 

On the Pizza Printer the pizza item will print in Bigger and Bolder characters and the hot item will print at
the bottom in smaller characters. 

On the Hot Printer the hot item will print in Bigger and Bolder characters and the pizza, sub or soda that a
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customer might have also ordered along with the hot item will print at the bottom of the ticket in smaller
characters.

Here is how the ticket from the Hot Printer would look:

Notice that the hot items are listed at the top with like items grouped and modifiers printed in red, while the
salads (Cold Printer items) are listed at the bottom below the break line.

- Remote ticket's template tags -

And the template tags according to the ticket above would be:

<w>Order #: <ordernumber> 
<ordertype><cr></w>

start wide print, print Order number, print Order type
(COUNTER, DINING, BAR, DELIVERY, TAKEOUT,

DRIVETHRU), end wide print.

<customername><cr> print customer name and insert carriage return.

<ifcounter name=CounterHeader> if statement - if the mode is counter, include template
called CounterHeader.

<ifdining name=DiningHeader> if statement - if the mode is dining, include template
called DiningHeader.

<iftakeout name=TicketTakeOut> if statement - if the mode is takeout, include template
called TicketTakeOut.
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<date format=dddd>
<date format=mm/dd/yy>
<time
format=hh:mmAM/PM><cr>

print day of the week, print date, print time and insert
carriage return.

<scheduledatetime text="" cr=1> print when the order has been scheduled for (if it has
been).

<linebreak><cr> print dashed horizontal line and insert a carriage return.

<w><items price=no
modifiers=noprice
modifierformat=red group=items
voids=yes seating=no coursing=no
disablechanges=yes></w>

start wide print, don't print item price/don't print modifier
price/print modifiers in red/group items/print all
voids/don't print seating, don't print courses, don't print
CHANGES TO ORDER #, end wide print.

<linebreak><cr> print horizontal line and insert a carriage return

<items otheritems=yes price=no
modifiers=noprice group=all
voids=yes seating=no>

print other items that went to another printer/don't print
item price/don't print modifier price/group items/printall
voids/don't print seating.

There are several reasons you would want the remote ticket template to show all items a customer ordered on
each printer.

1. It shows that there is other food being made for this customer at different stations. And if the Pizza man
sees that there is a hot item that takes 20 minutes to cook and a pizza only takes 10 minutes to cook,
then he can wait approximately 10 minutes before putting his pizza in the oven. This way all the food is
ready at the same time.

2. If you look at any ticket from any of the printers and add the Larger and Bolder items with the

smaller items, then you know everything a customer has ordered and someone else can assemble the
order from all stations and present the entire order to the customer.

- Remote ticket and Super Departments -
 

A customer may order liquor as well as food. The cook at the remote printer in the kitchen, pizza station and
cold station has no need to be confused with seeing liquor or a merchandise item printed on the ticket.
Since only  items under Super Departments categorized as Food print on the remote printer's ticket
and any items under Super Department that's categorized as Beverage or Merchandise do not print
you have a way to eliminate liquor and/or merchandise from being printed at the bottom of the ticket. That is
where the categories of Super Departments (Food, Beverage, Merchandise) come into play. Read about Super
Department categorization under Item Builder->Departments.

Some restaurants do not want to use this bottom portion of the ticket at all. Therefore you can have 2
templates: one with the other printer's items at the bottom portion of the ticket and one without. And then tie
either one of those templates to the remote printers. For a more detailed explanation on printers read 
Hardware->Printers/Coursing.



Version 6.1.16

586

48.1.1.3Expeditor Template and Seat Positions

 On the Toolbar click on Administration then the Template Screen.

- Expediter and Kitchen Printers -

Restaurants may have a separate printer solely for expediter purposes.

Situation 1:

In some restaurants Servers take the order from the customers and Food Runners bring the order to the
customers. In this situation, a Food Runner brings the food to the table and has no idea which person at the
table ordered what food. But if a Food Runner looks at the expediter ticket, they know exactly what was
ordered from which seat.

Situation 2:

Virtually any employee can assemble the order from the expediter ticket and present the entire order to the
customer.

If each of the menu items in a restaurant is assigned to go to the expediter printer as well as the remote
printer, do the following to set up this configuration:

1. Set up an expediter template to print seat numbers.

2. Set up an expediter printer. Refer to Hardware->Printers/Coursing.

3. Assign an expediter printer to each menu item that you want to print on the expediter ticket. Read about
menu items settings under Item Builder->Items.

- Expediter template tags -

<w><r>Expedite
Ticket<cr>

Start wide print, start red print, print Expediter Ticket,
end red print, insert carriage return.

Order #:
<ordernumber></w><cr>

Print order number, end wide print, insert carriage return

<ordertype></r><cr> Print order type (COUNTER, DINING, BAR, DELIVERY,
TAKEOUT, DRIVETHRU), insert carriage return.

<cr> Insert carriage return.
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<items itemprice=no
modifiers=noprice
modifierformat=red
voids=yes seating=yes
coursing=no>

Don't print item price/don't print modifier price/print
modifiers in red/group items/print voids/print seat
numbers/don't print courses.

Expediter template result:
 

According to the design tags above, here is how our expediter ticket will look.
 

48.1.2 System Reset

 Under the Back Office Toolbar located at the Top of the Back Office System in
gray, click on System Reset. 

System Reset

This is where you can clear either all your sales history on your checks or only the sales history on one
day.
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Reset All Keeps all the settings in BackOffice, but deletes all the checks (sales you
entered). 

**Warning**: Do NOT use if the customer wants to keep all check and sales

history.

Reset the day Deletes only the checks for the current operation date.

**Warning**: If you have the incorrect operation date, it will clear the checks
on that day. Example: If you wanted to clear the checks on today's date but had
the SoftTouch operation date as yesterday's date, you would clear all the checks
from yesterday.

48.1.3 Data Maintenance

 Under the Back Office Toolbar located at the Top of the Back Office System in
gray, click on Administration then Data Maintenance. 
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*Caution*: The features in this section should generally be used with assistance from Tech
Support.

Make a database
backup to external
drive

Creates pos.pgbk on an external drive connected to the computer.
Drive specified by user.
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Make a database
backup to local C drive

Creates pos.pgbk in the C:\SoftTouch folder on the server.

Create an offsite
database Backup...

Use this option for creating backups that will be offsite. Credit card
numbers are removed from the backup.

**Warning**: This is what Dealers and/or Restaurant
should be using when they take a database offsite.

Copy POS.PGDB
Database to...

Copies the pos.pgdb to a location specified by the user.

Copy POS.PGDB
Database to external
drive

Copies the pos.pgdb to an external drive connected to the
computer. Drive specified by user.

Restore a database
Backup...

Can be used to restore a pos.pgbk or pos.pgbk.bzip file.  You will
be prompted to close and re-open BackOffice after restoring a
backup.

*Caution*: This will overwrite the database that is currently
loaded.

Restore a PGDB
database file

Can be used to restore a pos.pgbd database file. You will be
prompted to close and re-open BackOffice after restoring a
database file.

*Caution*: This will overwrite the database that is currently
loaded.

Restore license file Can be used to restore a license file. You will be prompted to close
and re-open BackOffice after restoring a backup.

*Caution*: This will overwrite the database that is currently
loaded.

Check database Pages Runs a scan on the Database Pages to check for errors.

Rebuild database
pages

Rebuilds the Database Pages (good for when an error is found in
the Database Pages).  Also can reduce database file size.  

*Caution*: ALWAYS make a backup before using this feature.

Run Locally - 1 Client Use this setting when you need to run SoftTouch on a computer
that is NOT plugged into a network.  

*Note: Restart computer after making this change.
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Run Network - X Client Use this setting when you need SoftTouch to run on a network
(live install). 
 
*Note: Restart computer after making this change.
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